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| ntroduction

Welcome  Welcometo IBM® Sterling Gentran: Server® for Microsoft Windows, the IBM
Electronic Commerce (EC) software for the Microsoft Windows operating
system.

Sterling Gentran: Server provides the easy-to-use tools you need to electronically
exchange data with your trading partners, including the following functions:

» datatranglation
» process control
» communications system

We believe you will find this software and the supporting materials easy to use
and directly beneficial to your business.
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What’sin this M anual

Introduction

Intended
audience

Prerequisite
knowledge

Description of

User Guide

contents

Thismanual isintended to support the online Help by assisting you in performing
various tasks in Sterling Gentran: Server. This task-oriented approach is intended
to answer any questions you may have about Sterling Gentran: Server with step-
by-step instructions.

This manual isintended for the staff responsible for the following:
» Implementing EDI

»  Setting up trading partner relationships

» Creating and using EDI documents

» Sending and receiving documents

» Acknowledging documents

» Tracking document flow

» Configuring and using unattended processing

This manual assumes that you are familiar with using a PC and with M icrosoft®
Windows or Microsoft Windows 2000 functions.

This Guide contains the following chapters:

» Chapter 1, Getting Sarted, explains the content, organization, and
conventions in this guide. This chapter also describes how to get technical
support introduces Sterling Gentran: Server for Microsoft Windows.

» Chapter 2, Using Translation Objects, explains how to register (install),
delete, and view trand ation objects.

» Chapter 3, Using Partners, explains how to set up a complete partner profile.
This chapter describes how to import and export a partner profile and partner
tables, and describes how to copy a partner profile.

» Chapter 4, Using Documents, explains al facets of managing your
documents.

» Chapter 5, Using Communications, explains how to send, receive, and resend
documents, and how to view the Send Queue.

» Chapter 6, Using Interchanges, explains how to view interchanges and the
documents within interchanges, how to filter the display of interchanges, how
to attach (link) an interchange to a partner, and how to resend interchanges.

» Chapter 7, Using External Data, explains how to view and print external data
files.
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Descriptionof »  Chapter 8, Using Acknowledgements, explains how to manually set a
contents document, group, or interchange to acknowledged, how to define inbound and
(contd) outbound acknowledgement criteria for document reconciliation, and how to
check for overdue acknowledgements.

» Chapter 9, Using Tracking, explains how to view and print tracking
information.

» Chapter 10, Using Archive and Restore, explains how to archive data and
restore archived data to the system.

» Chapter 11, Using Process Control, explains how to create, edit, delete,
activate, and suspend automatic process control events. This chapter also
describes how to use sessions and calendars.

» The Glossary contains definitions of EDI and Sterling Gentran: Server terms
and concepts.

OnlineHelp  The mgjority of the documentation for Sterling Gentran: Server is contained in the
Online Help system. Thisincludes all dialog box element definitions, detailed
processing information, and the “how to” information that is contained in this
manual .

Sterling Gentran:Server — May 2011 User Guide



Getting Support

How To Get Help

User Guide

IBM® Sterling Customer Center provides awealth of online resourcesthat are
available around the clock to enrich your business experiencewith IBM® Sterling
Gentran®. By using Sterling Customer Center, you gain access to many self-
support tools, including a Knowledge-Base, Documentation, Education, and Case
Management. Access this site at: Sterling Customer Center. (http://
customer.sterlingcommerce.com)

Oncelogged in, select Support Center from the top navigation menu, and then
locate Sterling Gentran product-specific support information from the left
navigation menu.

Additionally, our Customer Support Reference Guide outlines our support hours,
contact information, and key information that will enhance your support
experience with us. For detailed information about Customer Support, pleaserefer
to the Customer Support Reference Guide accessible from the login page. (http://
customer.sterlingcommerce.com)

Sterling Gentran:Server — May 2011
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Introducing Sterling Gentran:Server for Microsoft Windows Getting Started

Introducing Serling Gentran: Server for Microsoft Windows

Overview  Sterling Gentran:Server for Microsoft Windows is a combined data translation,
process control, and communication system that operates within the Microsoft
Windows environment. This product is primarily designed for the translation and
communication of EDI and other similar types of data.

Through the process control system, you can integrate Sterling Gentran: Server
with awide variety of business applications in a manner that makesit a
complementary extension of the applications, rather than a cumbersome add-on.

System  The Sterling Gentran:Server system consists of several logical components.
components  Sterling Gentran:Server can be deployed in many ways in this environment
through a combination of a database, system data store, process controllers,

communication controllers, and user interface clients.

Mandatory components
Each system must have a primary Serling Gentran: Server system controller,
system data store, and a database.

Database Thedatabaseisthe relational database that Sterling Gentran:Server uses to store
system data. This database enables multiple users to access the same data. The
other components of the product interact with this database using ODBC™ (Open
Database Connectivity), which allows for many different database management
systems on the database controller.

Reference
See the Getting Support card to determine which database management systems
have been certified for use with Sterling Gentran: Server.

System datastore  The system data store serves as the repository of all shared Sterling
Gentran:Server data. The system data store may reside on any machine that isa
file server to the machinesin the Sterling Gentran: Server system. Thereis only
one system data store in the Sterling Gentran: Server system, but the associated
folders and files may be distributed across multiple machines, if necessary.

Note
The machines where the system data store resides must be accessible by all
machines in the Sterling Gentran: Server system.

Sterling Gentran:Server — May 2011 User Guide



Getting Started

Process

Controllers

Primary system
controller

Secondary
controllers

User interface

User Guide

clients

Introducing Sterling Gentran: Server for Microsoft Windows

There are two types of controllersin the Sterling Gentran:Server system:
» A single primary system controller
» One or more secondary controllers (if required)

The primary system controller controls the management and dispatching of
processing requests within the system, manages the audit functionality, and
controls al other system components.

If you purchased a distributed license, you can deploy additional controllers
(secondary controllers) across the Windows network to alow the processing load
to bedistributed for fast and efficient throughput. The secondary controller can be
either or both of the following:

Process controller

The process controllers provide similar functionsto the primary system controller.
They are controlled by the primary system controller and are used to distribute
processes across multiple machinesin a Windows network.

Communication controller

The communication controllers regulate communication between Sterling
Gentran; Server and the organizations (val ue-added networks (VANS) or trading
partners) with whom data is exchanged. The communication controllers can
support leased or dialed connections, as well as interaction with third-party
communication packages using the file interface capability.

A communication controller isinstalled via a communications gateway.

The user interface clients provide the functions that are necessary to monitor and
control the system. The main data management component provides a graphical
user interface to the following:

» Document locations

» Partner profiles

» Communication setup and logs

» System Audit Log

» Process control setup and management

Sterling Gentran: Server — May 2011



Introducing Sterling Gentran:Server for Microsoft Windows Getting Started

User interface  Thefive main components of the Sterling Gentran: Server user interface client are
client  thefollowing:

components ,  The Electronic Commerce (EC) Manager window is a data management

component that serves as a high-level navigation tool, as well as a document
management tool. The EC Manager also provides accessto the Partner Editor,
the Document Editor, Application Integration, and Forms Integration.

» Partner Editor allowsyou to define, edit, and delete all partner information
for your company and for al of your trading partners.

» Document Editor isyour dataentry tool. It allows you to create, modify, and
view documents.

» Application Integration is asubsystem that enables you to generate import,
export, and document turnaround translation objects.

» Formsintegration isasubsystem that enables you to generate screen entry
and print translation objects.

Logical  Theuser interface client and controller components are the logical components of
components  the Sterling Gentran:Server system. These components can be deployed on a
single machine or over anumber of machines, depending on your needs.

Typical system

Typically, your system initially consists of a small number of machines operating
as Sterling Gentran: Server user interface clients, and alarger, more powerful
machine operating as a combined primary system controller/communication
controller/process controller.

After you complete the necessary translation objects for your installation (using
Application Integration), you can add other process controllers and
communication controllers as required, to distribute the processing workload.

Sterling Gentran:Server — May 2011 User Guide



Getting Started Introducing Sterling Gentran: Server for Microsoft Windows

Logical  System component interaction diagram

components  Thefollowing diagram illustrated the interaction of the logical components of the
(contd)  Sterling Gentran:Server system:

Multiple Controllers .
Multiple Controllers Installed Components:

B Process Controller (default)
m Client Access Components
M Integration Components

Primary Gentran System Controller

System F Sterling
Data Database Gentran:Server
Store

Windows 2003, Enterprise Edition

Secondary Controller 1 Secondary Controller 2

User Interface User Interface
Client Client
. Sterling Sterling .
> Sterling Gentran: Gentran: Sterling |
Gentran:Server Seerr:lé?n. Sgrr:lé?n. Gentran:Server <
Win 2 ndar ’ )
Ecliitidoor:Ns 003, Standard Wmdow_s 2000 Windows XP Windows 2000 Server
Professional Professional

L9

Installed Components:

m Client Access Components
m Integration Components

Installed Components:
W Process Controller
H Client Access Components

Installed Components:

B Process Controller (default)
m Client Access Components
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Navigating in Sterling Gentran: Server Getting Started

1-6

Navigating in Sterling Gentran: Server

Overview  The Sterling Gentran:Server Electronic Commerce (EC) Manager window allows
you to access its functionality in the following ways:

Select the menu option from the Main Menu Bar.

Click the appropriate button on the Main Tool bar.

Click the appropriate button on the Browser Toolbar.

Click the appropriate part of The Desk.

Click the appropriate button within a chosen browser window.

Note
The Electronic Commerce Manager display is refreshed when you press F5 or
click Refresh (available on most browsers).

Electronic  Thefollowing illustrates the Sterling Gentran: Server EC Manager window:

Commerce
Manager window

Control Menu Title Bar Minimize/Maximize Buttons

‘ G entran:Server Windows on system GENSYS1 ol =l
[ ”

g Edit View Document Commands Tools Options Window Hi

&la@ ml@u & rﬁl-»lll g 2 !I Gt

In ¥

Waorkspace
Transmit
Process Control

External Data

Partners

In Drawer

. The Desk
—— Main Menu Bar Slatus Bal

Main Toolbar

Browser Toolbar
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Getting Started

Components

Navigating in Sterling Gentran: Server

The following are the components of the main Sterling Gentran: Server window:

Control menu
The Control Menu contains the following commands. Restore, Move, Size,
Minimize, Maximize, and Close.

Title Bar

The Title Bar contains the name of the application and, on the Sterling

Gentran; Server desktop, it displays the name of the system you are logged in to.
You can use this to move the position of the Sterling Gentran: Server EC Manager
window on your desktop.

Minimize/M aximize buttons
The Minimize button reduces the window to an icon. The Maximize button
enlarges the window to its maximum size.

Main menu bar

The Main Menu Bar contains the drop-down menus. Detailed descriptions of each
of the commands on these menus are found in the Online Help. Unavailable items
are dimmed.

Main toolbar

The Main Toolbar gives you access to some of the most common browsers and
functions in Sterling Gentran: Server. Unavailable items are dimmed. The Main
Toolbar is a dockable toolbar, so you can affix it to any edge of the EC Manager
window. The following illustrates the Main Tool bar.

‘\‘ |L‘

S|5(E) alalE| ol ) ©lsl) TR EEL)

User Guide
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Navigating in Sterling Gentran: Server Getting Started

Browser toolbar

The Browser Toolbar gives you access to the functions that are available from
browsersin Sterling Gentran: Server. Unavailable items are dimmed. The Browser
Toolbar is a dockable toolbar, so you can affix it to any edge of the EC Manager
window. The following illustrates the Browser Toolbar:

The Desk

The Desk is a graphic representation of the Sterling Gentran: Server components
and document locations. It provides a quick and easy way to access some of the
most commonly used browsers, functions, and subsystems of Sterling
Gentran:Server. You can click the appropriate part of The Desk any time you need
to access a browser, function, or subsystem represented on The Desk.

Some of the browser icons display a graphic representation of paper if the
document location contains documents. The Desk also alows you to access the
Partner Editor subsystem, the Help system, the Process Control function (clock
icon), and the Send/Receive functions (phone icon), and alows you to quit
Sterling Gentran: Server (Exit/door icon).

Status bar

The Satus Bar displays status information about a selection, command, or
process, defines menu items as you highlight each item in the menu, and indicates
any current keyboard-initiated modes for typing (e.g., CAP for the “ Caps Lock”
key, NUM for the “Num Lock” key).

Sterling Gentran:Server — May 2011 User Guide



Getting Started Sterling Gentran: Server Data Translation Process

Serling Gentran: Server Data Trandation Process

Trandlating  Thefollowing illustrates the inbound translation process:
inbound data
diagram

i

Communicator

Y

P
( Temporary (
Storage
-

> /
[ Temporary |
= . Storage \

[ Temporary |

< \  Storage \

Translator

?In Documents

In Documents

¢ i

/ /

/’?Out Documents ‘{ |Out Documents

N A\
y

Workspace In Drawer

\
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Sterling Gentran:Server Data Transl ation Process Getting Started

Tranglating  The system uses the following process to translate inbound data:.

inbound data

process Stage

Description

1

The Communicator receives interchanges from your trading partners
viaanetwork.

The Communicator passes the interchanges to the translator.

The translator uses a system interchange break trand ation object to
unwrap the interchange envel opes and separate each group into
temporary storage.

The translator uses a system group break translation object to
unwrap the group envelopes and separate each transaction set into
temporary storage.

The translator uses a system transaction break translation object to:
» Unwrap the transaction envelopes.

» Separate each document into a separate file on the system data
store.

» Writearecord to the database with reference information about
the document.

Does the trangdlator locate a trading relationship for each document?

» If yes(atrading relationship islocated), the trandlator attempts
to identify the export, document turnaround, or print translation
object associated with that relationship. If the translator does
locate atrading relationship and trandation object, it uses that
translation object to compliance check the document.

» If no (thetrandator does not locate the trading relationship or
tranglation object), the document is marked as not compliant and
ismoved in the ?In Documents.

I's the document is compliant with the EDI standard?

» If yes, thetrandlator changes the document status to compliant
and moves the document in the In Documents.

» If no, the document remainsin the 2in Documents. The
translator writes a detailed error report to help you to determine
the problem that was encountered.

Sterling Gentran:Server — May 2011
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Getting Started Sterling Gentran: Server Data Translation Process

Sage Description

8 In the trading relationship, if you specify that the system needs to
generate a functional acknowledgement for a document, the
translator uses the system acknowledgement trandlation object to
generate the acknowledgement.

» Compliant acknowledgements are moved to the Out Documents
to be sent.

» Non-compliant acknowledgements are moved to the ?0ut
Documents. If an error occurred with the acknowledgement
translation object, the acknowledgement is also moved to the
?0ut Documents.

The trandator also reconciles acknowledgements if you receive an
acknowledgement-type transaction (such as 997 or CONTRL).

9 If you specified either automatic export or automatic turnaround in
the trading relationship, the translator uses the specified export or
document turnaround translation object to either export or generate
the appropriate response document.

User Guide Sterling Gentran: Server — May 2011



Sterling Gentran:Server Data Transl ation Process Getting Started

Tranglating  Thefollowing illustrates the outbound translation process:
outbound data

diagram
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Trandlating
outbound data
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process

Sterling Gentran: Server Data Translation Process

The system uses the following process to trand ate outbound data:

Sage

Description

1

Use one of the following processes to initiate outbound trandlation:

» Import afilethrough the process control system using atimed or
polled session. Thiswrites all valid documents to the database
with a compliant status and locates the documentsin the Out
Documents. Invalid documents are marked with a
non-compliant status and located in the ?0ut Documents.

» Import an application file. Documents that you import manually
are located in the Workspace.

» Usethe Document Editor to enter documents (if thereisan
appropriate data entry trandlation object registered with Sterling
Gentran: Server). These documents are located in the Workspace.

If you import afile, the trandator checks the import definitions from
the system configuration to match the file name with a system
import translation object.

Thetranslator uses the system import translation object to determine
which trading relationship (established in Partner Editor)
corresponds to each document in the application file, so the system
knows which import map to use to process the document.

After the translator determines which trading relationship
corresponds with a document in the file, it ascertains which import
translation object is specified in that relationship.

Thetranglator uses theimport translation object to compliance check
the document. If the document is compliant (valid), it is marked
“OK.” If the document is not compliant (invalid), it is marked
“NotOK.”

If there is another document remaining in the import file, the
tranglator repeats steps 3 - 5 until all documents are processed.

If you manually import afile through the EC Manager or use the
Document Editor, you need to post the compliant document to the
Out Documents.

Note

Once documents are located in the Out Documents, they can be sent
using the process control system or by using the EC Manager
transmit option.
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Getting Started

Changing your Password

Introduction  Your Sterling Gentran: Server password is stored in your User Access profile.

Notes

» You must know your old password to change it. If you have forgotten your
password, please contact your system administrator.

» If you are using Integrated security, you may also need to change your
Sterling Gentran: Server and database passwordsif you change your Windows
password.

Reference

See your system administrator if you have any questions about which security
mode you use.

Procedure  Usethis procedure to change your password.

Sep

Action

1

From the Options menu, select Preferences.

System response
The Preferences dialog box is displayed.

Select the Change Passwor d tab to access that option.

In the Old Password box, type your old password.

In the New Password box, type your new password.

In the Confirm New Password box, type your new password again.

Note
If the Confirm New Password does not match the New Password,
you will be prompted to typeit again.

Once complete, click OK to save the changes.

System response
The system is updated and the next time you log on to the system
you will need to enter the new password.
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Overview

Inthischapter  This chapter describes how to use translation objects with Sterling
Gentran:Server.

Trandation A trandation object isaset of definitions, links, and rules that combine to provide
object definition  thetrandator with all the information necessary to convert data from one format
to another. Trandlation objects are used in Sterling Gentran: Server to control the
processing of the translator subsystem.

Creating  Trandation objects are created by compiling an application map or aform
trandation  definition using the Application or Forms Integration subsystem in Sterling
objects  Gentran:Server.

Reference

See the IBM® Serling Gentran: Server® for Microsoft Windows Application
Integration User Guide and IBM® Serling Gentran: Server® for Microsoft
Windows Forms Integration User Guide more information about those
subsystems.

Typesof  Thereare two types of translation objects:
trandation

. stem translation objects
objects Sy )

System tranglation objects control the creation and separation of interchanges,
functional groups, and transaction sets. They are also used to generate and
reconcile functional acknowledgements.

User translation objects

User trandglation objects control screen entry, importing, exporting, and creating
printed reports. All required system translation objects are automatically installed
with the Sterling Gentran:Server system.
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EDI Tranglation Object Browser

Introduction  Thefollowing lists the system components that comprise the EDI Translation

Object feature.
Browser or
Dialog box Function
EDI Trandation | Allowsyou to view, print, delete, or register translation
Object objects.
Register Allows you to select trand ation objects to be registered with
Trandation the system.
Object

EDI Trandation  Thefollowing illustrates the EDI Translation Object browser.

Object browser - -
* EDI Translation Object - 443 M= E3

diagram
Type | Diezcription | Uzed
FZEwvild G5 Build Templa...  5YS ;
FGELld GS Buid Templa... 55 Pl
FGEwild G5 Build Templa... 5SS Delete
FGEwild ACD_Grp Bl S5 _ |
FGBRuild G5 Buld Templa...  SYS Mew. ..
|mpaort PETE 211NV, “es —
|mpaort PET T ANADDT ... “Yes
|mpaort 310junk2 Mo
|mpaort PET_&10 Mo
|mpaort PET = 3030 810... “Yes
|mpaort Flat_File_To_*C... Mo
|mpaort PET = 3030 810... “es
|mpaort PETE 921 IMNYV... “es
|mpaort PET T AMADDT ... Mo
|mpaort Flat_File_To ®C... “Yes - Refresh
“| |
Cloze
443 Translation = 1 selected
- Help

Partsand  Thefollowing lists the parts of the EDI Translation Object browser and their
functions  functions.

Part Function

Type Describes the type of trandation object defined, such as export,
import, or system import.

Description | Displays a description that further identifies the translation object.
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Part

Function

Used

Indicates whether the tranglation object is currently associated
with an Inbound or Outbound Partner Relationship. Valid values
are:

» Yes—Indicatesthe translation object isin use.

» No—Indicatesthe trandation object is not in use.

» SYS*—Indicates a system tranglation object that isin use.

» SYS—Indicates a system translation object that isnot in use

Note

If atrandation object is currently used (associated with an
Inbound or Outbound Partner Relationship), you cannot deleteit.
Also, the system prevents you from deleting trandlation objects
that are designated as system tranglation objects (SYS* or SYS).

System Trandlation Objects are all translation objects except
Import, Export, Data Entry, Screen Entry, Turn Around, and Print.
Also, any tranglation object with “system” in the descriptionisa
system translation object.

View

Displays awindow containing descriptive information for the
selected tranglation object, including the following:
Description of the trandlation object

Type of trandation object (for example, Export)

Input and output agency (for example, X for ANSI X12)
Input and output version (for example, 003030)

Input and output transaction ID (for example, 850)

Input and output release (for TRADACOMS only)

File name of the translation object (for example, 3030.tpl)

Print

Displays the Print Choice dialog box, which allows you to specify
whether you want to print the sel ected translation objects or print a
summary list of the selected trandlation objects.

Note
The Formatted option is unavailable because a formatted version
is aways printed when for atranslation object.

Use this table to determine your next step.

Delete

Removes the selected translation object or abjects.

Displays the Register Translation Object Dialog Box, which
allows you to identify atrangation object to the system.

Refresh

Refreshes the browser display.
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EDI Trandation Object Browser

Part Function
Close Exits the EDI Tranglation Object browser.
Help Accesses Online Help.
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Register Trandation Object Dialog Box

Introduction  The Register Translation Object dialog box enables you to register a selected
tranglation object file with Sterling Gentran: Server (identify the translation object
to the system).

Diagram  Thefollowing illustrates the Register Translation Object dialog box:

Heqister Translation Object EHE
Lockin: | iz Translbj | | ﬁ‘l |
Fle nare: | o
Files of tpe: ITransIatiu:un Obijects [*.tpl] j Cancel |

Help |

Partsand  Thefollowing lists the parts of the Register Transation Object dialog box and
functions their functions:

Part Function
Look in Specify the drive and folder where the file is located.
File name Specify the name of the file that you want to register.
Files of type Specify the type of file that you want to access.
Note
Thefile extension for translation objectsis . TPL.
Open Selects the chosen file and exits the Open dialog box.
Cancel Exits the Open dialog box without selecting afile.
Help Accesses Online Help.
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Registering New Transglation Objects

Introduction  The Register Transation Object function enables you to register your translation
object file with Sterling Gentran: Server so the system can identify the trandlation
object.

Automatic  You can set the auto-register feature to automatically register translation objects
registration  whenthey are compiled. See How to Set the Auto-register option in chapter 2 of
the IBM® Serling Gentran: Server® for Microsoft Windows Application
Integration User Guide.

Procedure  Usethis procedure to register atranslation object.

Sep Action

1 From the View menu, select Translation Objects.

System response
The system displays the EDI Trandation Object browser.

2 Click New.

System response
The system displays the Register Trand ation Object dialog box.

3 Select the trand ation object file that you want to register with the
system from the list or type it in the File name box.

Note

To highlight a group of translation objects, click on the first
tranglation object and then pressthe SHIFT key and then click on the
last tranglation object in the group. To highlight several trandation
objects that are not adjacent to each other, pressthe CTRL key and
click on the trandlation objects.
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Sep Action

4 Click Open.

System response
The system registers the trandlation object files exits the Register
Trandation Object dialog box.

Note
If the selected fileisinvalid, you receive a warning message. Only
valid Sterling Gentran: Server trand ation object files can be installed.

If the tranglation object is a duplicate, you are prompted with a
message asking whether or not you want to overwrite the existing
tranglation object.
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Deleting Translation Objects

Deleting Trandation Objects

Introduction

Procedure

User Guide

You can delete old or unused trandlation objects from the system only if they are
not currently associated with an Inbound or Outbound Partner Relationship (“No”
in the Used column on the EDI Translation Object browser).

The system prevents you from deleting trandlation objects that are designated as
“system tranglation objects’ (SYS’ or SYS).

Use this procedure to delete a transl ation object.

Sep Action
1 From the View menu, select Translation Objects.
System response
The EDI Translation Object browser is displayed.
2 Select the tranglation object or objects you want to delete.
3 Click Delete.
System response
The Delete confirmation dialog box is displayed.
4 Do you want to delete these translation objects?

» If yes, click Yesto confirm the delete.
» If no, click No to cancel the delete request.
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| ntroduction

Inthischapter  Thischapter explains how to use the Sterling Gentran:Server Partner Editor,
including:

» Using partner profiles

» Routing partner profiles
» Using partner tables

» Using partner locations

Partner Editor  The Partner Editor allows you to define, edit, and delete all partner relationship
information for your company and al of your trading partners. Partner
relationships allow you to send and receive datato and from your trading partners.

The Partner Editor also allows you to use an internal system partner (Internal
System User) to define your company to the system.

Serling  See“Using Partner Editor with Sterling Gentran:Server for RosettaNet” in the
Gentran: Server IBM® Sterling Gentran: Server® for RosettaNet User Guide for moreinformation
for RosettaNet  about defining partners for use with RosettaNet®.

User Guide Sterling Gentran: Server — May 2011



Overview Using Partners

Using Partner Profiles

Overview

Introduction  You can set up your partner profiles using any of three methods: importing,
copying, and creating them yourself. The method you use depends on whether you
have a partner profile to use as a starting point, as shown in the following table:

Partner profile

creation method When to use
Import existing Use this method if you receive partner profiles from
profile IBM or if you have an existing profile from which you

can import partner details. The profile can be exported
from another copy of the Sterling Gentran: Server
system.

Reference
See Importing Partner Profiles on page 3 - 85 for more
information.

Copy existing profile | Use this method when you have an existing profile that
you can copy and then enter a unique partner definition
and key enveloping information for the copied partner.

Reference
See Copying Partner Profiles on page 3 - 88 for more
information.

Create anew profile | Usethis method when you do not have a profileto
import or copy.

Reference
See Process of defining a partner profileon page 3- 5
for more information.

Partner A partner profile begins with a partner definition. The partner definition contains
definition  the basic information about that partner that the system needs before you define
the rest of the partner profile. You need to create a partner definition for each
partner with whom you are going to exchange data.
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Partner profile

Process of
defining a
partner profile

User Guide

Overview

To complete the partner profile, you need to define an inbound or outbound
relationship or both:

» If you arereceiving and processing information from this trading partner, you
need to define an appropriate inbound relationship.

» If you are sending information to this trading partner, you need to define an
outbound relationship.

You need to create a partner profile for each partner with whom you are going to
exchange data.

The following describes the partner profile creation process:

Stage Description

1 Create the partner definition.

Reference
See Creating a Partner Definition on page 3 - 56.

2 If necessary, create the inbound relationship.

Reference
See Creating an Inbound Relationship on page 3 - 58.

3 If necessary, create the outbound relationship.

Reference
See Creating an Outbound Relationship on page 3 - 66.

4 Do you need to use a cross-reference or lookup table with the partner
relationship to supplement or convert data you enter or receive?

» If yes, see Creating Partner Tables on page 3 - 102.
» If no, continue with stage 5.

5 Do you need to use locations to contain address- and contact-rel ated
information about the partner?

» If yes, see Creating Partner Locations on page 3 - 116.
» If no, you have completed the partner profile definition process.
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Partner Editor Dialog Box

Using Partners

The Partner Editor enables you to define, edit, and delete all partner information

for your company and all of your trading partners.

The following illustrates the Partner Editor dialog box:

HE 3

Edit..

=
T
3

Delete

Inbound. ..

Outbound...

Tahbles...

Locations...

Befresh

[ =

Mew... |
[ o
EEE
Do |
=
_Locatio.. |
_ Bofen_|

Help |

Import Export |

Introduction
Diagram
w- Partner Editor
Select a Partner:
Internal System L ser
FETZOMET
FETZ0OMEZ
FETZOME
— Proceszes
Copy...
Partsand
functions

The following lists the parts of the Partner Editor dialog box and their functions:

Part

Function

Select a Partner

Displaysthelist of partner profiles to select from.

Copy

Displays the Partner Copy Dialog Box, which allows you
to copy a partner profile.

Import

Displaysthe Import File Select Dialog Box, which allows
you to import a partner profile.

Export

Displays the Export File Build Dialog Box, which alows
you to export a partner profile.
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Partner Editor Dialog Box

Part Function

Exit Exits the Partner Editor dialog box.

Edit Displays the Partner Definition (New/Edit) Dialog Box,
which alows you to change information about the selected
partner.

New Displays the Partner Definition (New/Edit) Dialog Box,
which allows you to create a partner definition.

Delete Removes the selected partner profile from the system.

Inbound Displays the Inbound Relationship Dialog Box for the
selected partner.

Outbound Displays the Outbound Relationship Dialog Box for the
selected partner.

Tables Displays the Partner Tables Dialog Box for the selected
partner.

Locations Displays the Location Select Dialog Box for the selected
partner.

Refresh Refreshes the dialog box display.

Help Accesses Online Help.
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Partner Definition (New/Edit) Dialog Box

Introduction  The Partner Definition dialog box enables you to create a new partner definition
or, if you select a previoudy defined partner definition, it allows you to edit it.

Diagram  Thefollowing illustrates the Partner Definition - New dialog box:

Partner Definition - Hew x|
Profile 1D I
M ame: I E xit |
EDI Code: | Help

Application Code; |

Default Malbox | GENTRAN Appiication ] MewMaibos |
D efalt S |
E-mail &ddrezs I E dit M ailbox

Partsand  Thefollowing lists the parts of the Partner Definition dialog box and their
functions  functions:

Part Function
Profile ID Specify a unique identifier for the selected partner.
Name Specify a unique name for the partner.
Note

Make this name as descriptive as possible, because thisis
the name displayed in the partner selection list.

EDI Code Specify the EDI identifier for this partner. The system uses
this value during inbound processing to select the correct
trading partner definition.

Application Code | Specify an application code used to identify this partner.
The system uses this value during outbound import
processing to select the correct trading partner definition.
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Part Function

Default Mailbox | Select adefault mailbox to use to identify this partner for
non-RosettaNet EDI relationships.

Reference
See the IBM® Serling Gentran: Server® for Microsoft
Windows Communications User Guide for more

information.
Default E-mail Specify adefault e-mail address to use to identify this
Address partner for non-RosettaNet EDI relationships.
Reference

See the IBM® Serling Gentran: Server® for Microsoft
Windows Communications User Guide for more

information.
Save Saves the modified information.
Exit Exits the Partner Definition dialog box.
Help Displays Online Help.
New Mailbox Displays the Create New Mailbox wizard, which allows

you to create a new mailbox.

Reference

See the IBM® Serling Gentran: Server® for Microsoft
Windows Communications User Guide for more
information.

Edit Mailbox Displays the Mailbox Properties dialog box, which alows
you to edit the mailbox.

Reference

See the IBM® Serling Gentran: Server® for Microsoft
Windows Communications User Guide for more
information.
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Inbound Relationsnip Dialog Box

Introduction  Inbound relationships define the parameters the system needs to receive an EDI
document from atrading partner. The Inbound Relationship dialog box controls
other subordinate dialogs that allow you to define everything that is necessary to
establish the relationship.

You are required to specify exactly which document is to be received. You aso
define which translation abjects are used to define the turnaround documents,
export rules, or printing requirements.

Diagram  Thefollowing illustrates the Inbound Relationship dialog box with the Advanced

options displayed:

Inbound Relationship - PETZ0ME
Relationship Description: il
[Inbound Purchase Order ANS1 3030 =] Exit |
Standand: 12 =l Mew...

Wersion: IDD3D3D "'I Delete |
Transaction Set; IESD j Tranzlation. . |
Helease; IEI "'I

Help

[™ Tranzaction iz an Acknowledgemer

Groups | [ Inbound %3030 PO Gip |
Interchanges | [ Inbaund 3030 PO Int |

Seguence Checking Last Used Confrol Mumber | Generate Acknowledgments
+ None IDUDEI = MNa

"~ Duplicate
™ Incremental
" Chronclogical | [T Skip Compliance Check

[ Duplicate Documents " Yes - No Enar Detail
‘ez - With Error Detail

Acknowledgement Processing

T ezt Indicatar: " Test & Production " Deferred & Immediate
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Inbound Relationship Dialog Box

Partsand  Thefollowing lists the parts of the Inbound Relationship dialog box and their
functions  functions:
Part Function

Relationship Select the existing inbound relationship.

Description

Standard Specifies the EDI standard to be used in this
relationship.
Note
Only standards for which you have existing translation
objects are displayed. Thisbox cannot be changed for an
existing relationship. Selection of this box is mandatory.
Valid values
» A-TRADACOMS
» C-Cll
» D-NCPDP
» E-EDIFACT
» O-ODETTE
» P-OTHER
» R-ROSETTANET
» T-TDCC
» U-UCS
» V-VDA
» X-X12

Version Select the EDI standard version to be used in this
relationship.
Note
Only versions of the selected standard for which you
have existing trandlation abjects are displayed. If this
box is changed for an existing relationship, al of the
information defined below it is cleared and must be
reselected. Selection of this box is mandatory.

Transaction Set Select the transaction set to be used in this relationship.
Note
Only transaction sets for the selected version for which
you have existing trand ation objects are displayed. If
thisbox ischanged for an existing relationship, all of the
information defined below it is cleared and must be
reselected. Selection of this box is mandatory.
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Part

Function

Release

Select the release number to be used in this relationship.

Note

Only releases for the selected transaction set for which
you have existing trand ation objects are displayed. This
box is currently only used for messages defined in the
TRADACOMS standard. Selection of thisbox is
mandatory for all TRADACOM S messages.

Transaction is an
Acknowledgement

Specify if the transaction defined in this partner
relationship is an acknowledgement.

Groups

Accesses the Inbound Group Select Dialog Box.

I nterchanges

Accesses the Inbound I nterchange Select Dialog Box.

Sequence Checking

Specify if the system will use sequence checking and
whether sequence checking will be incremental or
chronological. You can aso indicate that the system
must check for duplicate control numbers.

» None Do not use sequence checking.
» Duplicate Check for duplicate control
numbers.

» Incrementd The control number must be one
greater than the last number.

» Chronological The control number must be greater
than the last number.

Note

If the system detects duplicate control numbers or
detects incremental or chronological control numbers
that are out of sequence, those documents will be put in
the ?2Iln Documents.

Last Used Control
Number

Specify avalue that is used to sequence check the next
transaction set control number or message reference.
Thisvalue is replaced with the sequence number of the
last transaction set or message received. Thisbox is
initially set to zero.

Note
This box isdisabled if Sequence Checking is None.
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Inbound Relationship Dialog Box

Part

Function

Duplicate
Documents

Specify if the system will check for duplicate document
names.

Notes
» I the system detects duplicate document name it
will locate those documents in ?Iln Documents.

» I duplicate document checking is activated for a
relationship the translation object used in this
relationship must update the document name viaa
standard or extended rule.

Reference

See the IBM® Serling Gentran: Server® for Microsoft
Windows Application Integration User Guide for more
information about using standard and extended rules.

Skip Compliance
Check

Specify if you want the system to compliance check the
documents for this relationship.

Generate
Acknowledgements

Instructs the system to generate a functional
acknowledgement to this trading partner when you
receive the transaction set (message) defined in this
relationship. The default value for this box is No. Valid
values:

» No
Do not generate acknowledgements.
» Yes- No Error Detail
Generate acknowledgements without error detail.

» Yes- With Error Detail
Generate acknowledgements with error detail.

Note

This entire box isinactive (dimmed) if the document
(transaction set) in thisrelationshipisan
acknowledgement.

Test Indicator

Specify if thisrelationship definitionisin test or
production mode. The default value is Production.

Acknowledgement

Specify if acknowledgement reconciliation will occur

Processing during the inbound break session (Immediate) or during
its scheduled interval (Deferred). The default is
Immediate.

Save Saves the modified information.

Exit Exits the Inbound Relationship dialog box.
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Part Function

New Accesses the New Inbound Relationship dialog box,
which allows you to create a new relationship.

Delete Removes the specified inbound relationship from the
system.

Trandation Accesses the Inbound Tranglation Object Dialog Box.

Advanced Toggles the display of the advanced options.

Help Displays Online Help.
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Inbound Translation Object Dialog Box

Inbound Trandation Object Dialog Box

Introduction  The Inbound Translation Objects dialog box is used to specify which translation
objects will be used to process the data defined by this relationship.

Thefollowing lists the inbound trandlation levels (from the lowest level up):

Tranglation Level

Description

Document

Validate the document against the specified translation
object to verify if the document is compliant with the
standard and translate from EDI to print or application
format.

Transaction

Remove the EDI-specific enveloping around a single
document.

Group

Remove the EDI-specific enveloping around a set of
related transactions (the transactions do not have to be
the same type).

Interchange

Remove the EDI-specific envel oping around groups
destined for the same trading partner.

User Guide
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Diagram  Thefollowing illustrates the Inbound Translation Object dialog box with the
Advanced options displayed:

Inbound Translation Objects - PETZONE

Select Tranzlation Objects

Turn Around | j - $
ExpoitFile  |PET x 3030 850 F sport | T Autg $

Print | ﬂ

Expart File Mame

| Delete Emphy Ezport Files?

Help

Export to b ailbox

[v Export bo Mailbios
[ Usze Partner Default Mailbox and E-mail Address

Recipient Mailbox | ﬂ Mesw b ailbo:
Recipient E-mail Address | E dit M ailbo:

Cantent TypesSubType |

Application [D: |

Application Aliaz Y alue: |85IZI
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Inbound Translation Object Dialog Box

Thefollowing lists the parts of the Inbound Translation Object dialog box and

their functions:

Part

Function

Turn Around/
Auto

Displaysall turnaround document options. When adocument
isreceived, the turnaround document created is the natural
response document that contains as many el ements from the
received document as possible.

Note

Select the Auto check box if you want the defined turnaround
process to be automatic. If the Auto box is not selected, the
received document will remain in the In Documentsuntil itis
selected for processing.

Export File/
Auto

Displays all registered Export trand ation objects relative to
the Standard, Version, Transaction Set and Release defined
by this relationship. This allows you to specify that when an
EDI document is received, it will be exported into an output
file.

Notes

» Select the Auto check box if you want the export file
created automatically upon receipt of the document. If
the Auto box is not selected, the received document will
remain in the In Documents until it is selected for
processing.

» If the Export File Name is defined for this relationship,
each document can be exported individually to aunique
file. If you use formatting charactersin the file name, the
document key changes for each document that is
exported, the Process ID stays the same (for all
documents exported from the same interchange), and the
unigue ID changes. Therefore, using the “ document key”
and “unique ID” special characters (defined below), a
unique file name can be derived.

Reference
See Export File Name on page 3 - 18 for more
information about these values.

Print

Displays all print trandlation objects on the system for the
Standard, Version, Transaction Set, and Release defined by
the relationship. The selected translation object will be used
to print documents received from this partner.
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Part

Function

Export File
Name

Specify the name of thefile to be created or appended to asa
result of performing an export operation. This file name can
contain amix of aphanumeric characters and formatting
characters, which are replaced by the translator with the
runtime value they represent.

Formatting characters supported

%y (two-digit year)

%Y (four-digit year)

%m (abbreviated month name)

%M (month as a decimal number)

%(d (abbreviated weekday name)

%D (day of the month as a decimal number)

%H (hour in 24-hour format)

%N (minutes)

%S (seconds)

%K (document key)

%P (process identifier)

%U (unique number derived using the current time, export
filename, process identifier, and the rand() function)

Note
The runtime file name is generated once per export.

Example
The following is an example of aruntime file name using
formatting characters:

d: \ GENSRVNT\ export s\ dockey%pr oci d%Puni quei d%J. dat

Delete Empty
Export Files?

If the result of the export operation is an empty export file,
the file will be deleted when this option is checked. If left
unchecked, the empty file will not be deleted.
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Part

Function

Export to
Mailbox

Invokesthe "Export to Mailbox" function, which deliversthe
output of an inbound tranglation to the Mailbox Server
Manager. Thisallowsthe Mailbox Server Manager to act asa
message broker responsible for delivering the datato its final
destination.

Note

If you specified the Export File Name, it is till valid and will
become the Attachment Filename. Formatting characters are
still valid for the filename and could cause multiple
attachments to be created if document key is used. For
example, if the following filename is used:

d: \ gensrvnt\ export s\ dockey%pr oci d%uni quei d%J. dat

anew attachment is created for each document because the
document key creates a unique name for each document
processed.

To set up an export to amailbox, you must complete the

following components on the Inbound Translation Objects

dialog box:

» IntheExport File Name box, type the file name.

» Select the Export to Mailbox checkbox.

» Fromthe Recipient Mailbox list, select the mailbox (the
Recipient E-mail Addressis optional).

» Inthe Content Type/SubType box, type a content type
(content subtype is optional).

Use Partner
Default
Mailbox and
E-mail Address

Specify if the output of the inbound trandation is exported to
the default mailbox and e-mail address configured for this
partner.

Recipient
Mailbox/
New Mailbox

Select the mailbox to which the output of an inbound
trandation is delivered.

Or, click New Mailbox to display the Create New Mailbox
wizard, which allows you to create a new mailbox.

Reference

See the IBM® Serling Gentran: Server® for Microsoft
Windows Communications User Guide for more information.
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Part Function
Recipient Specify the e-mail address to which the output of an inbound
E-mail trandation is delivered.
Address/

Edit Mailbox O_r, click E(_jit Mailbox to displa_ly the Cr_eate New Mailbox
wizard, which allows you to edit the mailbox.

Reference
See the IBM® Serling Gentran: Server® for Microsoft
Windows Communications User Guide for more information.

Content Type/ | Specify the content type/sub type of the message containing
SubType the output of the inbound trandlation.

Reference
See the IBM® Serling Gentran: Server® for Microsoft
Windows Communications User Guide for more information.

Application ID | Specify the application identifier that indicates the
destination of the documents.

Application Specify criteriafor this relationship definition that is used
Alias Value during the application import function.

Example

The application contains data that can generate either an
invoice or a credit memo. Use one relationship definition for
invoices and another for credit memos.

There is abox in the application that defines whether thisis
aninvoiceor acredit memo. The box will display CREDIT if
acredit memo is created and INVOICE if aninvoiceis
created. Type CREDIT inthe Application Alias Value for the
relationship defining the credit memo and type INV OI CE for
the invoice.

Note
This box isonly used if you receive translation objects that
are defined to use the Application Alias Value.
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Part Function

Import Select other translation objects associated with the
relationship, which gives you the capability to change the
system behavior at the transaction and document translation
level. This allows you to use trandlation objects that are as
partner-specific as required and/or perform as many
functions as required.

Note

You must select atrandlation object from the Import list if
you have created a specific import trand ation object for this
relationship and if you want to change the way the system
behaves for this partner relationship. Import trandation
objects may not be appropriate for an Inbound Relationship.

Data Entry Select other translation objects associated with the
relationship, which gives you the capability to change the
system behavior at the transaction and document translation
level. This allows you to use trandation objects that are as
partner-specific as required and/or perform as many
functions as required.

Note

You must select atrandlation object from the DataEntry list if
you have created a specific data entry translation object for
this relationship and if you want to change the way the
system behaves for this partner relationship (e.g., if you want
to change the formatted view of Inbound data).

Transaction Select other trand ation objects associated with the
relationship, which gives you the capability to change the
system behavior at the transaction and document translation
level. This allows you to use trandation objects that are as
partner-specific as required and/or perform as many
functions as required.

Note

You must select atranglation object from the Transaction list
if you have created a specific Transaction Break transation
object for this relationship and if you want to change the way
the system behaves for this partner relationship.
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Part

Function

Acknowledge

Select other trand ation objects associated with the
relationship, which gives you the capability to change the
system behavior at the transaction and document translation
level. This allows you to use trandlation objects that are as
partner-specific as required and/or perform as many
functions as required.

Note

You must select atrandation object from the Acknowledge
list if you have created a specific translation object for this
relationship and if you want to change the way the system
behaves for this partner relationship.

When the system reconciles an acknowledgement, it maps
the acknowledgement to an internal file and then processesit.
If you need the system to process acknowledgements
differently, you should select an additional translation object
from the Acknowledge list.

If the transaction set is an acknowledgement and you choose
an Acknowledge additional trandlation object, the system will
use the additional trandation object in place of the export
tranglation object for acknowledgement reconciliation.

Save

Saves the modified information.

Exit

Exits the Inbound Trand ation Object dialog box.

Advanced

Toggles the display of the advanced options.

Help

Displays Online Help.
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Inbound Group Select Dialog Box

Introduction  The Inbound Group Select dialog box is used to select an existing functional
group definition to be associated with this relationship. It can also be used to
initiate the definition of anew functional group or to modify or delete an existing
definition. The groups available to you are determined by the version you selected
on the Inbound Relationship dialog.

Note

Functional groups are required for ANSI X12, TDCC, and UCS standards,
optional for EDIFACT and ODETTE, and not specified for TRADACOMS.

Diagram  Thefollowing illustrates the Inbound Group Select dialog box:

Inbound Group Select - PETZ0NE |

Groups:

Select |

< N0Nes
Inbound #3030 PO Gip

Exit |
Hew... |

Delete |
Help |

Partsand  Thefollowing lists the parts of the Inbound Group Select dialog box and their

functions functions:

Part

Function

Groups

Displays all functional group definitions established for
this trading partner.

Select

Selects the indicated functional group to be used with this
relationship.

Note
Select <none> if the standard you are using does not
require groups and you do not want to use one.

Exit

Exits the Inbound Group Select dialog box.

New

Displays the Inbound Group Entry Dialog Box, which
alows you to create a new group.

User Guide
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Part

Function

Edit

Displays the Inbound Group Entry Dialog Box, which

allows you to edit the selected group.

Delete

Removes the selected group from the system.

Help

Displays Online Help.
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Inbound Group Entry Dialog Box

Introduction  The Inbound Group Entry dialog box is used to specify a functiona group

definition.

Diagram  Thefollowing illustrates the Inbound Group Entry dialog box with the Advanced

options displayed:

Inbound Group Entry -

PETZOMNE1

Dezcription: I
Standard:
Wersion:

Functional Group 1D

E-EDIFACT
0320

—

Ewit

Help |

Seguence Checking Last eed Group Control Humber: ¥ Acknowledge Group
&+ Nong ID .
) Ack Transaction Set [D:
" Duplicate
" Incremental I j
" Chronological
Group Transl. Obj: I j
Acknowledge Transl. Ob; | ACKBUILD_CONTRL =]

Partsand  Thefollowing lists the parts of the Inbound Group Entry dialog box and their

functions  functions:

Part

Function

Description

Specify the name of the functional group description.

Standard

Displays the EDI standard the system is using for this
relationship definition.

Version

Displaysthe version of the EDI standard the system is
using for this relationship.

User Guide

Sterling Gentran: Server — May 2011



Inbound Group Entry Dialog Box Using Partners

Part Function

Functional Group | Specify the functional group. These identification boxes
ID are defined by each appropriate standards group to group
like documents. The standard defines which functional
group ID should be used with each document type. Thisis
amandatory box.

Examples

IN 810 X12 Invoice

PO 850 X 12 Purchase Order
IG 830 UCS Invoice

oG 875 UCSP. O.

INVOIC EDIFACT INVOIC

ORDERS EDIFACT ORDERS
INVOIC TradacomsINVOIC
ORDERS Tradacoms ORDERS

This element islocated in:

ANSI X12: GS01
EDIFACT: UNGO01

TRADACOMS.BAT
Sequence Specify if inbound sequence checking will be used and
Checking whether the type of sequence checking will be incremental

or chronological. You can also indicate that the system
must check for duplicate control numbers.

» None Do not use sequence checking.

» Duplicate Check for duplicate control numbers.

» Incremental The control number must be one
greater than the last number.

» Chronological The control number must be greater
than the last number.

Note

If the system detects duplicate control numbers or detects
incremental or chronological control numbers that are out
of sequence, those documents will be put in the ?2In
Documents.

Last Used Group | Specifies avalue that the system will use to sequence
Control Number | check the group control number. The number will be
replaced by the group control number that the system
receives. Thisbox will initialy be set to zero.
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Inbound Group Entry Dialog Box

Part

Function

Acknowledge
Group

Instructs the system to send afunctional acknowledgement
to this trading partner when you receive the group defined
in thisrelationship. The default value for this box is not
checked (do not expect an acknowledgement).

Note
This check box is dimmed (inactive) if the transaction set
is an acknowledgement.

Ack Trandlation
Set ID

Select the acknowledgement you want generated for this
group.

Example
ANSI X12

UCSEDIA
EDIFACT

997 Functional Acknowledgement
999 Acceptance/Rejection Advice
CNTRL

Group Trandl.
Obj.

Select a partner-specific Group Break Map translation
object if thistrading partner group deviates from the
normal system behavior. You must select atrandation
object from thislist if you want the system to perform
partner-specific grouping.

Warning

We strongly recommend that you do not change the
trandation objects in the Group Trangl. Obj. and
Acknowledge Trangl. Obj. lists, unless you have a specific
reason for doing so.

Acknowledge
Trangl. Obj.

Select an Acknowledgement Break Map if one exists on
the system.

Note

You must select atranslation object from the Acknowledge
Trangl. Obj. list if you have created a specific translation
object for thisrelationship and if you want to change the
way the system behaves for this partner group. When the
system reconciles an acknowledgement, it maps the
acknowledgement to an internal file and then processesiit.
If you need the system to process acknowledgements
differently, you should select an additional translation
object from the Acknowledge list.

Warning

We strongly recommend that you do not change the
trangdlation objects in the Group Trand. Obj. and
Acknowledge Trandl. lists, unless you have a specific
reason for doing so.
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Part

Function

Save

Saves the modified information.

Exit

Exits the Inbound Group Entry dialog box.

Advanced

Toggles the display of the advanced options.

Help

Displays Online Help.
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|nbound I nterchange Select Dialog Box

Introduction  The Inbound Interchanges Select dialog box is used to select an existing
interchange definition to be associated with this relationship. You can also use it
to initiate the definition of a new interchange or to modify or delete an existing
definition. The interchanges available to you are determined by the version you
selected on the Inbound Rel ationships dialog. Interchanges are required for
EDIFACT, ODETTE, TRADACOMS, and UCS, and optional for ANSI X12 and
TDCC.

Diagram  Thefollowing illustrates the Inbound Interchange Select dialog box:

Inbound Interchange 5Select - PETZ0ME |
Interchanges: Calect |

<honer

Inbound #3040 PO Int

Partsand  Thefollowing lists the parts of the Inbound Interchange Select dialog box and
functions their functions:

Part Function
Interchanges Displays all Interchange definitions established for this
trading partner.
Select Selects the indicated interchange to be used with this
relationship.
Note

Select <none> if the standard you are using does not
require interchanges and you do not want to use one.

Exit Exits the Inbound Interchange Select dialog box.

New Displays the Inbound Interchange Entry Dialog Box,
which allows you to create a new interchange.

Edit Displays the Inbound Interchange Entry Dialog Box,
which allows you to edit the selected interchange.
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Part

Function

Delete

Removes the selected interchange from the system.

Help

Displays Online Help.
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Introduction
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Diagram

Inbound Interchange Entry Dialog Box

The Inbound Interchange Entry dialog box is used to specify a new interchange

definition.
Note

EDIFACT version 4 defines the infrastructure necessary to support the creation
(and processing) of interchanges that have been encoded using a character set
other than 8-bit ASCII. Sterling Gentran:Server for Microsoft Windows supports
the processing of an encoded interchange as long as the encoding of the
interchange matches the default code page of the operating system where Sterling

Gentran; Server is running.

The following illustrates the Inbound Interchange Entry dialog box with the

Advanced options displayed:

Inbound Interchange Entiy - PETZ0NME

%]

Descrigtion: [Inbiound 3030 PO Int
Standard: b Exit |
Wersion; 003020 <¢ Advanced |
Interchange 10 154 - Help |
S{?urj!:: ek I:Da;;é-l;neudugmtml BEIESE [T Acknawledge Interchange

i~ Duplicate Bt et actio St [

-

O Chronoges | =
Interchange Transl Obj. I j
Acknowledge Transl Obj. | j
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Partsand  Thefollowing liststhe parts of the Inbound Interchange Entry dialog box and their

functions  functions:

Part

Function

Description

Contains the name of the interchange description.

Standard

Displays the EDI standard the system is using for this
relationship definition.

Version

Displays the version of the EDI standard the system is
using for this relationship.

Interchange ID

Select the type of interchange. The standard defines which
interchange I D should be used with each standard. Thisisa
mandatory box.

Example

ANSI X12 -ISA
-ICS

ucCs -BG

EDIFACT - UNB
Tradacoms - STX

Sequence
Checking

Specify if the system will use sequence checking and
whether the sequence checking will be incremental or
chronological. You can aso indicate that the system must
check for duplicate control numbers.

» None Do not use sequence checking.

» Duplicate Check for duplicate control numbers.

» Incremental The control number must be one
greater than the last number.

» Chronological The control number must be greater
than the last number.

Note

If the system detects duplicate control numbers or detects
incremental or chronological control numbers that are out
of sequence, those documents will be put in the 2In
Documents.

Last Used
Control Number

Specifies avalue that will be used to sequence check the
next interchange control number. The number will be
replaced by the control number on the last interchange
received. This box will initially be set to zero.

Note
This box isdisabled if Sequence Checking is None.
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Part Function
Acknowledge Instructs the system to send afunctional acknowledgement
Interchange to thistrading partner when you receive the interchange set

defined in this relationship. The default value for this box
is not checked (do not expect an acknowledgement).

Ack Trandlation | Select the acknowledgement you want generated for this
Set ID interchange.

Example
ANSI X12 = 997 Functional Acknowledgement

UCS/EDIA = 999 Acceptance/Rejection Advice
EDIFACT = CNTRL

Interchange Select a partner-specific Interchange Break Map

Trandl. Obj. tranglation object if this trading partner interchange
deviates from the normal system behavior. You must select
atranslation object from thislist if you want the system to
perform partner-specific interchanging.

Warning

We strongly recommend that you do not change the
trangdlation objects in the Interchange Trangl. Obj. and
Acknowledge Trangl. Obj. lists, unless you have a specific
reason for doing so.

Acknowledge Select an Acknowledgement Break Map if one exists on
Trand. Obj. the system.

You must select atranslation object from the Acknowledge
Trangl. Obj. list if you have created a specific translation
object for thisrelationship and if you want to change the
way the system behaves for this partner interchange. When
the system reconciles an acknowledgement, it maps the
acknowledgement to an internal file and then processesiit.
If you need the system to process acknowledgements
differently, you should select an additional translation
object from the Acknowledge list.

Warning

We strongly recommend that you do not change the
tranglation objects in the Interchange Trangl. Obj. and
Acknowledge Trangl. Obj. lists, unless you have a specific
reason for doing so.

Save Saves the modified information.
Exit Exits the Inbound Interchange Entry dialog box.
Advanced Toggles the display of the advanced options.
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Part

Function

Help

Displays Online Help.
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Outbound Relationship Dialog Box

Introduction

User Guide

Diagram

Outbound rel ationshi ps define the parameters needed to send an EDI document to
atrading partner. The Outbound Relationship dialog box controls other
subordinate dialogs that allow you to define everything that is necessary to
establish the relationship.

You are required to specify exactly which document the system sends. You must
also specify which trandation objectswill be used to define the data entry dialogs,
import rules, or printing requirements. In addition, you need to define the specific
EDI-envel oping requirements that you agreed on with your trading partner.

Thefollowing illustrates the Outbound Relationship dialog box with the

Advanced options displayed:

Relationship Description:
| Outbound Acknowledgment ANS 3030 7 ]

Standard: iz [
Wersion: I 002020 - |

Exit

Delete

Tranzaction Set: ISS?

[

Helease:

Tranzlation. ..

Envelope...

<¢ Advanced

Help

Graups | [ Outbnd %3030 FA Gip

_ e |
__ Do |
| manston. |
_Envelpe., |
<chancad|
_ b |

|

|

Interchanges | | Outbnd #3030 FA, Int

Laszt Used Control Mumber: |EIEIDEI

[T Expect fcknowledoement | [ Duplicate Documents

Hemirs [Hierdues ID

Test Indicator: | € Test € Production
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Thefollowing lists the parts of the Outbound Relationship dialog box and their

Part

Function

Relationship
Description

Select the relationship description.

Standard

Specifies the EDI standard to be used in this
relationship.

Note

Only standards for which you have existing translation
objects are displayed. Thisbox cannot be changed for an
existing relationship. Selection of this box is mandatory.

Valid values
A-TRADACOMS

C-ClI

D-NCPDP
E-EDIFACT
O-ODETTE
P-OTHER
R-ROSETTANET
T-TDCC

U-UcCs

V-VDA

X-X12

Version

Select the EDI standard version to be used in this
relationship.

Note

Only versions of the selected standard for which you
have existing trandlation abjects are displayed. If this
box is changed for an existing relationship, al of the
information defined below it is cleared and must be
reselected. Selection of this box is mandatory.

Transaction Set

Select the transaction set to be used in this relationship.

Note

Only transaction sets for the selected version for which
you have existing trand ation objects are displayed. If
thisbox ischanged for an existing relationship, all of the
information defined below it is cleared and must be
reselected. Selection of this box is mandatory.
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Part

Function

Release

Select the release number to be used in this relationship.

Note

Only releases for the selected transaction set for which
you have existing tranglation objects will be displayed.
This box is currently only used for messages defined in
the TRADACOMS standard. Selection of thisbox is
mandatory for all TRADACOM S messages.

Groups

Accesses the Outbound Group Select Dialog Box.

I nterchanges

Accesses the Outbound I nterchange Select Dialog Box.

Last Used Control
Number

Specify avalue that will be used to generate the next
transaction set control number or message reference.
The number generated will always be one more than the
number in this box. Initially, this box will be set to zero.

Expect
Acknowledgement

Instructs the system to expect a functional
acknowledgement to be received from this trading
partner as aresult of your partner receiving the
transaction set (message) defined in this relationship.
The default value for this box is not checked (do not
expect an acknowledgement).

Hours Overdue

Defines how many hours must elapse before an
expected functional acknowledgement is considered
overdue. Thisbox isonly valid if the Expect
Acknowledgement box is checked. The default value for
thisbox is*“48,” indicating that the acknowledgement
will be considered overduein two days. If you enter a
value of zero in this box, the acknowledgement will be
immediately considered overdue.

Note
This box isdisabled if Expect Acknowledgement is not
checked.
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Part

Function

Duplicate
Documents

Instructs the system to check for duplicate document
names.

Notes

» If you manualy import documentsinto the
Workspace, this function checks for duplicate
documents. Duplicate documents remain in the
Workspace until they are deleted. If you try to move
or post a duplicate document, awarning messageis
displayed. If you use the Process Control import
feature to import documents, the duplicate
document islocated in 20ut Documents.

» If duplicate document checking is activated for a
relationship, the translation object used in this
relationship must update the document name viaa
standard or extended rule.

Reference

See the IBM® Serling Gentran: Server® for Microsoft
Windows Application Integration User Guide for more
information about using standard and extended rules.

Test Indicator

Specify if thisrelationship definition isin test or
production mode. The default value is production.

Save

Saves the modified information.

Exit

Exits the Outbound Relationship dialog box.

New

Accesses the New Outbound Relationship dialog box,
which allows you to create a new relationship.

Delete

Removes the specified outbound relationship from the
system.

Trandation

Accesses the Outbound Tranglation Object Dialog Box.

Envelope

Accesses one of the following Outbound Envelope
dialog boxes depending on which version you specified:
» Outbound UNH Envelope

» Outbound MHD Envelope

» Outbound ST Envelope

Reference

Refer to the Partner Editor online help for specific
information about the envelope dialog boxes.
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Outbound Relationship Dialog Box

Part

Function

Advanced

Toggles the display of the advanced options.

Help

Displays Online Help.
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Outbound Trandlation Object Dialog Box

Introduction  The Outbound Trandlation Objects dialog box is used to specify which translation
objects are used to process the data defined by this relationship.

The following lists the outbound trandlation levels (from the lowest level up):

Translation Level Description

Document Trandate from import format or data entry to EDI.

Transaction Build the EDI-specific enveloping around a single
document.

Group Build the EDI-specific enveloping around a set of
related transactions (the transactions do not have to be
the same type).

Interchange Build the EDI-specific enveloping around groups
destined for the same trading partner.

Diagram  Thefollowing illustrates the Outbound Translation Object dialog box with the

Advanced options displayed:
Dutbound Translation Objects - PETZ0NE E3

Select Translation Objects
Import [scxeuiLn_ss7 =l
Frint I ﬂ
Diata Entry I ﬂ
Application [0; I
Application Alias Yalue: |E|E!?

Additional Translation Objects
Turndround I j
Expart | j
Transaction  [ST Build Template - ANS =]
Acknowledge | j
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Outbound Translation Object Dialog Box

Thefollowing lists the parts of the Outbound Tranglation Object dialog box and

their functions:

Part

Function

Import

Displaysall import transation objectsin the system for the
Standard, Version, Transaction Set, and Release defined by
the relationship.

Print

Displays all print tranglation objects in the system for the
Standard, Version, Transaction Set, and Rel ease defined by
the relationship. The selected tranglation object will be
used to print documents sent to this partner.

Data Entry

Displays all screen entry translation objects in the system
for the Standard, Version, Transaction Set, and Release
defined by the relationship.

Application ID

Specify the application identifier that indicates the
destination of the documents.

Application Alias
Value

Specify the criteriafor this relationship definition, which
will be used during the application import function.

Example

The application contains data that can generate either an
invoice or a credit memo. Use one relationship definition
for invoices and another for credit memos.

Thereisabox in the application that defineswhether thisis
aninvoice or acredit memo. The box will display CREDIT
if acredit memo is created and INVOICE if aninvoiceis
created. Type CREDIT in the Application Alias Value for
the relationship defining the credit memo or INVOICE for
theinvoice.

Note
This box will only be used if you receive translation
objects that are defined to use the Application Alias Value.
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Part Function

TurnAround Select other trandation objects associated with the
relationship, which gives you the capability to change the
system behavior at the transaction and document
trandation level. This allows you to use translation objects
that are as partner-specific as required and/or perform as
many functions as required.

You must select atranslation object from the TurnAround
list if you have created a specific turnaround translation
object for thisrelationship and if you want to change the
way the system behaves for this partner relationship.

Note
TurnAround translation objects may not be appropriate for
an Outbound Relationship.

Export Select other trandlation objects associated with the
relationship, which gives you the capability to change the
system behavior at the transaction and document
tranglation level. This allows you to use tranglation objects
that are as partner-specific as required and/or perform as
many functions as required.

You must select atranslation object from the Export list if
you have created a specific export translation object for
thisrelationship and if you want to change the way the
system behaves for this partner relationship. Export
tranglation objects are used to export an outbound
document to afile.

Transaction Select other translation objects associated with the
relationship, which gives you the capability to change the
system behavior at the transaction and document
tranglation level. This allows you to use tranglation objects
that are as partner-specific as required and/or perform as
many functions as required.

You must select atrandation object from the Transaction
list if you have created a specific Transaction Build
tranglation object for this relationship and if you want to
change the way the system behaves for this partner
relationship.
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Part

Function

Acknowledge

Select other trandation objects associated with the
relationship, which gives you the capability to change the
system behavior at the transaction and document
trandation level. This allows you to use translation objects
that are as partner-specific as required and/or perform as
many functions as required.

You must select atranslation object from the Acknowledge
list if you have created a specific translation object for this
relationship and if you want to change the way the system
behaves for this partner relationship. When the system
generates an acknowledgement, it writes the
acknowledgement to an interna file containing the
acknowledgement details and then maps that internal file.
If you need the system to process acknowledgements
differently, you should select an additional translation
object from the Acknowledge list.

Save

Saves the modified information.

Exit

Exits the Outbound Tranglation Object dialog box.

Advanced

Toggles the display of the advanced options.

Help

Displays Online Help.
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Outbound Group Select Dialog Box

Introduction  The Outbound Group Select dialog box is used to select an existing functional
group definition to be associated with this relationship. You can also useit to
initiate the definition of anew functional group or to modify or delete an existing
definition. The groupsthat are available to you are determined by the version you
selected on the Outbound Relationship dialog box.

Functional groups are required for ANSI X12, TDCC, and UCS standards, are
optional for EDIFACT and ODETTE, and are not specified for TRADACOMS.

Diagram  Thefollowing illustrates the Outbound Group Select dialog box:

Outbound Group Select - PETZO0OME |

Groups: Select |

< None:

Dutbid #3030 FA Gip E xit |
COutbnd #3030 1M Grp
Hew... |

Delete

Help |

Partsand  Thefollowing lists the parts of the Outbound Group Select dialog box and their
functions  functions:

Part Function

Groups Displays all functional group definitions established for
this trading partner.

Select Selects the indicated functional group as the one the
system uses for this relationship.

Exit Exits the Outbound Group Select dialog box.

New Displays the Outbound Group Entry Dialog Box, which
allows you to create a new group.

Edit Displays the Outbound Group Entry Dialog Box, which
allows you to edit the selected group.

Delete Removes the selected group from the system.

Help Displays Online Help.

Sterling Gentran:Server — May 2011 User Guide



Using Partners Outbound Group Entry Dialog Box

Outbound Group Entry Dialog Box

Introduction  The Outbound Group Entry dialog box is used to specify a new functional group
definition.

Diagram  Thefollowing illustrates the Outbound Group Entry dialog box with the

Advanced options displayed:

Description: | Save |
Standard: w12 E wit |
Wersion: 003030 Envelope... |

Functional Group 1D IFA

Help |

Laszt Uzed Group Control Mumber: [ Expect &cknowledgement
ID Hiaurs Dverdie; IU
Tranzaction Contral Mumbers
™ Sequence From Group Farmat
& el
LLast [ sed Eamtra] Humben B/
ID (g
) 5/3
Group Tranzl Obj: IGS Build Template - AMSI ﬂ
Acknowledge Transl. Obj; I j

Partsand  Thefollowing lists the parts of the Outbound Group Entry dialog box and their
functions  functions:

Part Function
Description Specify the name of the functional group description.
Standard Displaysthe EDI standard the system is using for this
relationship definition.
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Part Function

Version Displays the version of the EDI standard the system is
using for this relationship.

Functional Group | Specifies the functional group. These identification boxes
ID are defined by each appropriate standards group to group
like documents. The standard defines which functional
group ID should be used with each document type. Thisis
amandatory box.

Examples

IN 810 X12 Invoice

PO 850 X 12 Purchase Order
IG 830 UCS Invoice

oG 875 UCSP. O.

INVOIC EDIFACT INVOIC

ORDERS EDIFACT ORDERS
INVOIC TradacomsINVOIC
ORDERS Tradacoms ORDERS

This element islocated in:

ANSI X12: GS01
EDIFACT: UNGO01
TRADACOMS:BAT

Last Used Group | Specify avaluethat is used to generate the next

Control Number | interchange control number. The number generated will
always be one more than the number in this box. This box
will initially be set to zero.

Note

To ensure that functional acknowledgements work
correctly, you must define a unique control number for
each group relationship that exists for the same partner
relationship.

Expect Instruct the system to expect a functional
Acknowledgement | acknowledgement to be received from this trading partner
asaresult of your partner receiving the group defined in
thisrelationship. The default value for this box is not
checked (do not expect an acknowledgement).
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Part Function

Hours Overdue Specify how many hours must el apse before an expected
functional acknowledgement is considered overdue. This
box isonly valid if the Expect Acknowledgement box is
checked. The default value for this box is*48,” indicating
that the acknowledgement will be considered overdue in
two days. If you enter avalue of “0” (zero) in this box, the
acknowledgement will be immediately considered

overdue.
Note
This box isdisabled if Expect Acknowledgement is not
checked.
Sequence From Specify if the transaction set control number options for
Group this group setup should be controlled at the group level. If
this box is not checked, the following two fields are
disabled.
Last Used Specify avalue that will be used to generate the next

Control Number | transaction set control number for the sets defined within
this functional group. The number generated will always
be one more than the number in this box. This box will
initialy be set to zero.

Note
This box isdisabled if Sequence From Group is not
checked.
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Part

Function

Format

Select the format of the transaction set control number that
will be generated:

Normal The number will be generated by incrementing the

6/3

5/4

5/3

Note

last used control number. Thelength of the number
will be defined by the standard.

The number will be a composite of two numbers.
Thefirst six digits are the last six digits of the
functional group control number. The last three
digits are a counter beginning at “1” within the
functional group. Usethisformat only as
instructed by your trading partner.

The number will be a composite of two numbers.
Thefirst five digits are the last five digits of the
functional group control number. The last four
digits are a counter beginning at “1” within the
functional group. Thisisthe normal TDCC
numbering convention. It is used by the Motor,
Rail, and Ocean transportation industries.

The number will be a composite of two numbers.
Thefirst five digits are the last five digits of the
functional group control number. The last three
digits are a counter beginning at “1” within the
functional group. Thisisthe normal UCS
convention, which is used by the Grocery and
Warehousing industries.

This box isdisabled if Sequence From Group is not
checked.

Obj.

Group Trandl.

Select a partner-specific Group Build Map trandlation
object if thistrading partner group deviates from the
normal system behavior. You must select atranslation
object from thislist if you want the system to perform
partner-specific grouping.

Warning
We strongly recommend that you do not change the

trangdlation objects in the Group Trand. Obj. and

Acknowledge Trangl. Obj. lists, unless you have a specific

reason for doing so.
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Part Function

Acknowledge Select an Acknowledgement Build Map if one existson the
Trand. Obj. system.

You must select atrandation object from the Acknowledge
Trand. Obyj. list if you have created a specific translation
object for thisrelationship and if you want to change the
way the system behaves for this partner group. When the
system reconciles an acknowledgement, it maps the
acknowledgement to an internal file and then processesiit.
If you need the system to process acknowledgements
differently, you should select an additional trandation
object from the Acknowledge list.

Warning

We strongly recommend that you do not change the
tranglation objects in the Group Trand. Obj. and
Acknowledge Transl. Obj. lists, unless you have a specific
reason for doing so.

Save Saves the modified information.
Exit Exits the Outbound Group Entry dialog box.
Envelope Accesses one of the following Outbound Functional Group

Envelope dialog boxes depending on which version you
specified on the Outbound Relationship Dialog Box:

» Outbound GS Functional Group

»  Outbound UNG Functional Group
» Outbound BAT Functional Group
Reference

Refer to the Partner Editor online help for specific
information about the envelope dialog boxes.

Advanced Toggles the display of the advanced options.

Help Displays Online Help.
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Outbound Interchange Select Dialog Box

Introduction  The Outbound Interchange Select dialog box is used to select an existing
interchange definition to be associated with this relationship. It can also be used to
initiate the definition of a new interchange, or to modify or delete an existing
definition. The interchanges available to you are determined by the version you
selected on the Outbound Relationship dialog box. Interchanges are required for
EDIFACT, ODETTE, TRADACOMS, and UCS, and are optional for ANSI X12
and TDCC.

Diagram  Thefollowing illustrates the Outbound Interchange Select dialog box:

Outbound Interchange Select - PETZ0ONE |

Interchanges: Select |

< None:

Outhind #3030 FA Int E xit |
COutbid #3030 1M 1rt

Outhnd #3040 FA Int Mew... |
Outbid #3040 1M 1t —

Delete |
Help |

Partsand  Thefollowing lists the parts of the Outbound Interchange Select dialog box and
functions  their functions:

Part Function
Interchanges Displays all interchange definitions established for this
trading partner.
Select Selects the indicated interchange to be used with this
relationship.
Note

Select <none> if the standard you are using does not
require interchanges and you do not want to use one.

Exit Exits the Inbound Interchange Select dialog box.

New Displays the Outbound Interchange Entry Dialog Box,
which allows you to create a new interchange.

Edit Displays the Outbound Interchange Entry Dialog Box,
which allows you to edit the selected interchange.
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Part

Function

Delete

Removes the selected interchange from the system.

Help

Displays Online Help.
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Outbound Interchange Entry Dialog Box

Introduction  The Outbound Interchange Entry dialog box is used to specify a new interchange
definition.

Note

EDIFACT version 4 defines the infrastructure necessary to support the creation
(and processing) of interchanges that have been encoded using a character set
other than 8-bit ASCII. Sterling Gentran:Server for Microsoft Windows supports
the processing of an encoded interchange as long as the encoding of the
interchange matches the default code page of the operating system where Sterling
Gentran; Server is running.

Diagram  Thefollowing illustrates the Outbound Interchange Entry dialog box with the
Advanced options displayed:

Outbound Interchange Entiy - PETZ0NE

Description IEIulI:-nu:I %3030 FA Int Save |
Standard: X12 = |
Wersion: 003030 Envelope... |

|rterctatae [0 |5 - 2 d;

Help

W Use the default Mailbox and E-mail &ddress

M il JGENTRAN Application | HEw M Bilbcr |
E-mail Address I =l =1 |

Content Type: I.-’-'n.pplic:atiu:um"EDl

[ Set Max Mumber of Documents per Interchange

fl & W umben af [Macuments Genlrterchatae: IEI

Laszt Used Control Number: [ Expect &cknowledgement

Q00000000 Hiours Meerdue: IU

Interchange Transl Obi. {154 Build Template - ANSI

—
Acknowledge Tranzl. Obj. I j
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Partsand  Thefollowing lists the parts of the Outbound Interchange Entry dialog box and
functions  their functions:

User Guide

Part Function

Description Displays the name of the interchange description.

Standard Displays the EDI standard the system is using for this
relationship definition.

Version Displays the version of the EDI standard the system is
using for this relationship.

Interchange ID Displays the type of interchange you specified. The
standard defines which interchange I D should be used with
each standard. Thisis amandatory box.

Example

ANS| X12 - ISA
ICS

UcCs - BG

EDIFACT - UNB

Tradacoms - STX

Use the default Specify that the system will use the default Mailbox and

Mailbox and E-mail address specified on the Partner Definition (New/

E-mail Address Edit) Dialog Box.

Mailbox/ Specify amailbox to use to identify this partner for

New Mailbox

RosettaNet relationships.

Or, click New Mailbox to display the Create New Mailbox
wizard, which alows you to create a new mailbox.

Reference

See the IBM® Serling Gentran: Server® for Microsoft
Windows Communications User Guide for more
information.

E-mail Address/
Edit Mailbox

Specify an e-mail addressto identify this partner for
RosettaNet relationships.

Or, click Edit Mailbox to display the Mailbox Properties
dialog box, which allows you to edit the mailbox.

Reference

See the IBM® Serling Gentran: Server® for Microsoft
Windows Communications User Guide for more
information.

Content Type

Specify the content type of the interchange.
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Part

Function

Set Max Number
of Documents per
Interchange

Instruct the system to only allow the specified maximum
number of documents per interchange for this relationship.

Max Number of

Specify the maximum number of documents allowed per

Documents per interchange for this relationship.
Interchange
Last Used Specify avauethat will be used to generate the next

Control Number

interchange control number. The number generated is
always one more than the number in this box. Initialy, this
box will be set to zero.

Expect
Acknowledgement

Instruct the system to expect a functional
acknowledgement to be received from this trading partner
as aresult of your partner receiving the interchange set
defined in this relationship. The default value for this box
is not checked (do not expect an acknowledgement).

Hours Overdue

Specify how many hours must el apse before an expected
functional acknowledgement is considered overdue. This
box isonly valid if the Expect Acknowledgement box is
checked. The default value for this box is“48,” indicating
that the acknowledgement will be considered overdue in
two days. If you enter avalue of zero in this box, the
acknowledgement will be immediately considered
overdue.

Note
This box isdisabled if Expect Acknowledgement is not
checked.

Interchange
Trandl. Obj.

Select apartner-specific Interchange Build Map trandlation
object if thistrading partner interchange deviates from the
normal system behavior. You must select atranslation
object from thislist if you want the system to perform
partner-specific interchanging.

Warning

We strongly recommend that you do not change the
tranglation objects in the Interchange Trangl. Obj. and
Acknowledge Trangl. Obj. lists, unless you have a specific
reason for doing so.
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Part Function

Acknowledge Select an Acknowledgement Build Map if one existson the
Trand. Obj. system.

You must select atrandation object from the Acknowledge
Trand. Obyj. list if you have created a specific translation
object for thisrelationship and if you want to change the
way the system behaves for this partner interchange. When
the system reconciles an acknowledgement, it maps the
acknowledgement to an internal file and then processesiit.
If you need the system to process acknowledgements
differently, you should select an additional trandation
object from the Acknowledge list.

Warning

We strongly recommend that you do not change the
tranglation objects in the Interchange Trangl. Obj. and
Acknowledge Transl. Obj. lists, unless you have a specific
reason for doing so.

Save Saves the modified information.
Exit Exits the Outbound I nterchange Entry dialog box.
Envelope Accesses one of the following Outbound Interchange

Envelope dialog boxes depending on which version you
specified on the Outbound Relationship Dialog Box:

» Outbound ISA Envelope

» Outbound ICS Envelope

» Outbound BG Envelope

» Outbound UNB Envelope

» Outbound UNA Envelope

» Outbound STX Envelope

» Outbound VDA Envelope

» Outbound NCPDP Envelope

» Outbound Envelope PIP Initiation
Reference

Refer to the Partner Editor online help for specific
information about the envelope dialog boxes.

Advanced Toggles the display of the advanced options.

Help Displays Online Help.
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Creating a Partner Definition

Introduction

Prerequisite
knowledge

Procedure

Using Partners

The partner definition contains the basi ¢ information about the trading partner that

the system needs before you define the rest of the partner profile.

Before setting up anew partner definition, you must have the following
information:

» The communication profile name you use to communicate with this partner

» TheEDI code for this partner
» Theapplication code used to identify this partner in the import file

This application code is needed only if the transactions are processed using

the file Import facility.

To create a partner definition, complete the following steps:

Sep Action

1 From the Tools menu, select Partner Editor.

System Response
The system displays the Partner Editor Dialog Box.

2 Click New.

System response

The system displays the Partner Definition (New/Edit) Dialog Box.

3 In the Profile ID box, type a unique aphanumeric Profile ID
partner.

Note
Do not use specia characters.

for this

4 In the Name box, type the partner name.

5 In the EDI Code box, type the EDI identifier for this partner.
Note

the correct partner.

The system uses thisidentifier during inbound processing to select
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Sep

Action

If necessary, in the Application Code box, type an application code to
identify this partner.

Note
The system uses thisidentifier during outbound import processing, to
select the correct partner.

» Select the appropriate mailbox from the Default Mailbox list.

OR
» Click New Mailbox to create a new mailbox.

Note

See the IBM® Serling Gentran: Server® for Microsoft Windows
Communications User Guide for more information about creating
mailboxes.

After you enter all the partner definition information, click Save.

Click Exit to return to the Partner Editor dialog box.

Note
To complete the partner profile, you need to define an inbound or
outbound relationship or both.

» If you arereceiving and processing information from thistrading
partner, you need to define an appropriate inbound relationship
established.

» If youaresending information to thistrading partner, you need to
define an outbound relationship.
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Creating an Inbound Relationship

Introduction  To correctly receive and process information from atrading partner, you must
have an appropriate inbound rel ationship established that defines the parameters
needed to receive data files from that partner. Each inbound relationship defines
which business documents are received from a partner.

Necessary  Youmust set up severa parametersthat are used to create an inbound relationship.
parameters  These parameterstell the system the following information:

» Thetype of datareceived
» Thecriteriathe system usesto validate the information it receives

» Thefunctiona groups and interchanges in which you expect to receive the
documents

Trandation  Eachinbound relationship must have one or more associated inbound translation
objects  objects. These trandation objects determine how the received data is processed.
You need to specify which translation objects are used to define the rules for
exporting, printing, and creating turnaround documents. At a minimum, one
tranglation object must be available.

Note

If this relationship requires a new translation object, you must register that
translation object with the system before creating the inbound relationship. See
Registering New Tranglation Objects on page 2 - 7 for instructions.

Inbound groups  You must define or select an inbound interchange and/or inbound functional group
and interchanges  before the system allows you to complete the setup of an inbound rel ationship.
The inbound functional group defines the format of the functional group and the
parameters that should be used to verify it. The inbound interchange defines the
format of the interchange and the parameters that should be used to verify it.

However, for some transactions, the functional group or interchange is optional
and if your trading partner has chosen not to useit then it is not necessary for you
to select one. Refer to the following standards to determine whether or not you are
required to select an inbound functional group or interchange:

» For some ANSI X12 documents, the interchange is optional and the
functional group isrequired. However, for most documents, both an
interchange and functional group are required.

» For TDCC, theinterchangeis optional and the functional group is required.
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Creating an Inbound Relationship

» For UCS, theinterchangeisrequired and the functional group is also
required.

» For EDIFACT, theinterchangeis required and the functional group is
optional.

» For ODETTE, theinterchangeis required and the functional group is
optional.

» For TRADACOMS, the Interchange is required and thereis no functional
group.

Note

If you do not want to use an optional functional group or interchange, you must

still select <none> from the appropriate dialog box to aert the system that you are
not using a group.

Before setting up an inbound relationship, you must know the following
information to plan the implementation of this partner:

» TheEDI standard you expect from this trading partner (such as ANSI)

» Thestandard version you expect from thistrading partner (such as 003020 for
ANSI or 090001 for EDIFACT)

» The code for the transaction set you expect from this trading partner (such as
““INVOIC” for an EDIFACT invoice)

» Thetypeof functional group and interchange the transaction set iswrapped in
when it is received from this partner

After you complete your implementation planning for this partner, you can set up
the inbound relationship by using the Inbound Relationship dialog box. The
Inbound Relationship dialog box controls other subordinate dialog boxes, where
you define everything that is necessary to establish the relationship.

The following describes the process for defining an inbound relationship:

Sage Description

1 Create a new inbound relationship.

2 Create and register the inbound translation object to be used with this
relationship.

Reference

See the IBM® Serling Gentran: Server® for Microsoft Windows
Application Integration User Guide for more information about
creating atrandation object. Also see Registering New Translation
Objects on page 2 - 7 for more information.
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Sage Description

3 Select at least one inbound translation object.

4 Create and select at least one inbound group to define how the
document is received from this partner.

Note

Depending on the standards you are using, either the functional group
or interchange may be optional. (See Inbound groups and
interchanges on page 3 - 58 to determine what is optional for the
standard you are using.)

5 Create and select at least one inbound interchange to define how the
document is received from this partner.

Note

Depending on the standards you are using, either the functional group
or interchange may be optional. (See Inbound groups and
interchanges on page 3 - 58 to determine what is optional for the
standard you are using.)

6 If you are generating functional acknowledgements as a result of
receiving documents for an inbound relationship, you must set up the
corresponding outbound relationship to generate the
acknowledgements your partner requests.

Reference
See Creating an Outbound Relationship on page 3 - 66 for more
information.
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Procedure  To create an inbound relationship, complete the following steps:

Sep Action

Creating a new inbound relationship

1 From the Tools menu, select Partner Editor.

System Response
The system displays the Partner Editor Dialog Box.

2 » Select the partner profile for which you want to create an
inbound relationship.

» Click Inbound.

System response
The system displays the Inbound Relationship Dialog Box.

Note
You must have already created a partner definition for this partner.

Reference
See Creating a Partner Definition on page 3 - 56 for more
information.

3 Click New.

System response
The system displays the New Inbound Relationship dialog box.

4 In the description box, type a unique relationship name (such as
Inbound Invoice).

5 Click Save.

System response
The system creates an inbound relationship and returns to the
Inbound Relationship dialog box.
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Sep

Action

From the appropriate drop-down lists on the Inbound Relationship
dialog box, select the following:

» Standard

» Version

» Transaction Set

» Release (for TRADACOMS only)

Notes

» The contents of these lists are displayed from the translation
objects registered in Sterling Gentran: Server. For example, if
there are no trandation objects for ANSI X12 version 003040
registered with Sterling Gentran: Server, you will not be ableto
select that version on this dialog box.

» Theinformation required for this dialog box should be provided
to you by your trading partner when this partner defines the
details of the transactions they send you.

If you need to define parametersto comply with the processing needs
of your partner (such as Sequence Checking, Last Used Control,
Duplicate Documents, or Generate Acknowledgement), click
Advanced.

System response
The system displays the Advanced fields on the Inbound
Relationship dialog box.

Selecting an inbound translation object

On the Inbound Relationship dialog box, click Translation.

System response
The system displays the Inbound Translation Object Dialog Box.

From the drop-down lists, select the tranglation objects required for
thisinbound relationship.

Note

» Thelistsdisplay al translation objects registered in the system
that are appropriate for the type of trandation object (such as
Export or Print) and the transaction set.

» If there are no tranglation objects displayed in the drop-down

lists, no trand ation objects of that type are registered for the
version of the document defined in the relationship.

If you selected an Export File trand ation object and you want to
export to aspecific file, type the universal naming convention (UNC)
name of that file in the Export File Name box.
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Sep Action

4 Do you want to use the “Export to Mailbox” function to specify a
mailbox and E-mail address so the output of the inbound translation
object can be delivered directly back to the Mailbox Server Manager?

» If yes, select Export to Mailbox and complete the appropriate
boxes. Continue with the next step.

Reference
See Inbound Trandlation Object Dialog Box on page 3 - 15 for
more information.

» If no, continue with the next step.

5 Click Save to save your selections and return to the Inbound
Relationship dialog box.

Selecting an inbound functional group

1 On the Inbound Relationship dialog box, click Groupsto display a
list of existing groups.

System response
The system displays the Inbound Group Select Dialog Box.

2 Isthe required group in the Groups list?

» If yes, select the group. Or, if you are not using groups, select
<none>.
Then, click Select. Continue with Selecting an inbound
interchange on page 3 - 64.

System response
This action selects the highlighted group and returns you to the

Inbound Relationship dialog box.

» If no, continue with the next step to create the group.

3 On the Inbound Group Select dialog box, click New.

System response
The system displays the Inbound Group Entry Dialog Box.

4 In the Description box, type the group description.

5 In the Functional Group ID box, type the identification of the
functional group you are specifying.

Note
The EDI standards define which functional group 1D should be used
for each type of document.
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Sep

Action

If you have more complex regquirements for processing the functional
group, click Advanced to display the full list of functional group
setup options.

System response
The system displays the Advanced fields on the Inbound Group
Entry dialog box.

After you set up the required parametersin thisdial og box, click Save
to store the information and return to the Inbound Group Select
dialog box.

» Highlight the new group.
» Click Select.

System response
Selects the group and returns to the Inbound Relationship dialog box.

Selecting an inbound interchange

On the Inbound Relationship dialog box, click Interchanges to
display alist of existing interchanges.

System response
The system displays the Inbound Interchange Select Dialog Box.

Isthe required interchange in the Interchanges list?

» If yes, select the group. Or, if you are not using groups, select
<none>.
Then, click Select. Continue with Finalizing the inbound
relationship on page 3 - 65.

System response
Thisaction selects the highlighted interchange and returns you to
the Inbound Relationship dialog box.

» If no, continue with the next step to create the interchange.

On the Inbound Interchange Select dialog box, click New.

System response
The system displays the Inbound Interchange Entry Dialog Box.

In the Description box, type the interchange description.
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Sep Action

5 In the Interchange ID box, type the identification of the interchange

you are specifying.

Note

The EDI standards define which interchange ID should be used for
each type of document.

6 If you have more complex requirements for processing the
interchange, click Advanced to display the full list of interchange
setup options.

System response
The system displays the Advanced fields on the Inbound Interchange
Entry dialog box.

7 After you set up the required parametersin thisdial og box, click Save
to store the information and return to the Inbound I nterchange Select
dialog box.

8 » Highlight the new interchange.

» Click Select.
System response
Sel ects the interchange and returns to the Inbound Relationship
dialog box.
Finalizing the inbound relationship

1 On the Inbound Relationship dialog box, click Save to save the
inbound relationship.

2 Click Exit to return to the Partner Editor dialog box.
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Creating an Outbound Relationship

Introduction  To correctly send information to atrading partner, you need to define an outbound
relationship. Outbound relationships define the parameters needed to send a data
file to atrading partner. Each outbound relationship defines the format of asingle
business document, and how that business document is formatted and sent to the
specified trading partner.

Necessary  You must set up several parameters that are used to create an outbound
parameters  relationship. These parameterstell the system the following information:

» How to create the required message
» Thecriteriathat the system uses to validate the information entered

» How to create the functional group and interchange envelopes in preparation
for sending

Tranglation  Each outbound relationship must have one or more associated outbound
objects  trandlation objects. These translation objects determine how the sent datais
formatted. You need to specify which translation objects are used to define the
rulesfor screen entry or file import. At aminimum, one translation object must be
available.

Note

If this relationship requires a new translation object, you must register that
tranglation object with the system before creating the outbound relationship. See
Registering New Translation Objects on page 2 - 7 for instructions.

Outbound  You must define or select an outbound interchange and/or outbound functional
groupsand  group before the system allows you to complete the setup of an outbound
interchanges  relationship. The outbound functional group defines the format of the functional
group and the parameters that should be used to verify it. The outbound
interchange defines the format of the interchange and the parameters that should
be used to verify it.

However, for some transactions, the functional group or interchange is optional,

and if your trading partner has chosen not to useit, it is not necessary for you to

select one. Refer to the following standards descriptions to determine whether or
not you are required to select an outbound functional group or interchange:

» For some ANSI X12 documents, the interchange is optional and the
functional group is required. However, for most documents, both an
interchange and functional group are required.
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Creating an Outbound Relationship

» For TDCC, theinterchangeis optional and the functional group is required.

» For UCS, theinterchangeis required and the functional group is also
reguired.

» For EDIFACT, theinterchangeisrequired and the functional group is
optional.

» For ODETTE, theinterchangeisrequired and the functiona groupis
optional.

» For TRADACOMS, the Interchange is required and there is no functional
group.

Note

If you do not want to use an optional functional group or interchange, you must

till select <none> from the appropriate dialog box to alert the system that you are
not using a group.

Before setting up an outbound relationship, you must know the following
information to plan the implementation of this partner:

» TheEDI standard this trading partner expects (such as ANSI X12)

» Thestandard version that this partner expects (such as 003020 for ANSI or
090001 for EDIFACT)

» Thecode for the transaction set you use (such as“INVOIC” for an EDIFACT
invoice)

» Thetype of functional group and interchange envelope the transaction set is
wrapped in when it is sent to this partner

After you complete your implementation planning for this partner, you can set up
the outbound relationship by using the Outbound Relationship dialog box. The
Outbound Relationship dialog box controls other subordinate dialog boxes, where
you define everything that is necessary to establish the relationship.

The following describes the process of defining an outbound relationship.

Stage Description

1 Create a new outbound relationship.

2 If you are using the EDIFACT, ODETTE, or TRADACOMS
standard, you must compl ete the envelope (header) information for
this type of document. For the ANSI, UCS, and TDCC standards, the
envelope information is optional.
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Stage

Description

Create and register theinbound transl ation object to be used with this
relationship.

Reference

See the IBM® Serling Gentran: Server® for Microsoft Windows
Application Integration User Guide for more information about
creating atrandation object. Also see Registering New Trandlation
Objects on page 2 - 7 for more information.

Select at least one outbound tranglation object.

Create and select at least one outbound group (including enveloping
information) to define how the document is received from this
partner.

Note

Depending on the standards you are using, either the functional
group or interchange may be optional. (See Outbound groups and
interchanges on page 3 - 66 to determine what is optional for the
standard you are using.)

Create and select at |east one outbound interchange (including
enveloping information) to define how the document is received
from this partner.

Note

Depending on the standards you are using, either the functional
group or interchange may be optional. (See Outbound groups and
interchanges on page 3 - 66 to determine what is optional for the
standard you are using.)

If you will receive functional acknowledgements for the outbound
documents, set up the corresponding inbound relationship to receive
the acknowledgements you expect from your partner.

Reference
See Creating an Inbound Relationship on page 3 - 58 for more
information.
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Creating an Outbound Relationship

To create an outbound rel ationship, complete the following steps:

Sep Action

Creating a new outbound relationship

1 From the Tools menu, select Partner Editor.

System Response
The system displays the Partner Editor Dialog Box.

2 » Select the partner profile for which you want to create an
outbound relationship.

» Click Outbound.

System response
The system displays the Outbound Relationship Dialog Box.

Note
You must have already created a partner definition for this partner.

Reference
See Creating a Partner Definition on page 3 - 56 for more
information.

3 Click New.

System response
The system displays the New Outbound Relationship dialog box.

4 In the description box, type a unique relationship name.

5 Click Save.

System response
The system creates an outbound relationship and returns to the
Outbound Relationship dialog box.
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Sep

Action

From the appropriate drop-down lists on the Outbound Relationship
dialog box, select the following:

» Standard

» Version

» Transaction Set

» Release (for TRADACOMS only)

Notes

» The contents of these lists are displayed from the translation
objects registered in Sterling Gentran: Server. For example, if
there are no trandation objects for ANSI X12 version 003040
registered with Sterling Gentran: Server, you will not be ableto
select that version on this dialog box.

» Theinformation required for this dialog box should be provided
to you by your trading partner when this partner defines the
details of the transactions they send you.

If you need to define parametersto comply with the processing needs
of your partner (such as Last Used Control Number, Expect
Acknowledgement, Hours Overdue, Duplicate Documents, or Test
Indicator), click Advanced.

System response
The system displays the Advanced fields on the Outbound
Relationship dialog box.

Selecting a transaction envelope (mandatory for EDIFACT, ODETTE, and
TRADACOMS standar ds—optional for ANSI, UCS, and TDCC)

1

If you are using the EDIFACT, ODETTE, or TRADACOMS
standard, click Envelope to complete the envel ope (header)
information.

Note
For the ANSI, UCS, and TDCC standards, the envelope information
isoptional.

System response

The system displays one of the following dialog boxes:
» Outbound UNH Envelope dialog box

» Outbound MHD Envelope dialog box

» Outbound ST Envelope dialog box
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Sep

Action

Enter the appropriate information and click Save.

System response
Saves the information and returns to the Outbound Relationship
dialog box.

Selecting an outbound translation object

On the Outbound Relationship dialog box, click Translation.

System response
The system displays the Outbound Translation Object Dialog Box.

From the drop-down lists, select the tranglation objects required for
this outbound relationship.

Note

» Thelistsdisplay al translation objects registered in the system
that are appropriate for the type of trandation object (such as
Import or Print) and the transaction set.

» If there are no tranglation objects displayed in the drop-down
lists, no trand ation objects of that type are registered for the
correct version of the document defined in the relationship.

If you selected an Import trandation object, you may need to define
the following:

» IntheApplication ID box, type the application identifier that
indicates the destination for the documents.

» IntheApplication Alias Value box, type criteria that the system
will use to distinguish this relationship from others during the
application import function.

Click Save to save your selections and return to the Outbound
Relationship dialog box.

Selecting an outbound functional group

On the Outbound Relationship dialog box, click Groupsto display a
list of existing groups.

System response
The system displays the Outbound Group Select Dialog Box.
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Sep Action

2 Isthe required group in the Groups list?

» If yes, select the group. Or if you are not using groups, select
<none>.
Then, click Select. Continue with Selecting an outbound
interchange on page 3 - 73.

System response
This action selects the highlighted group and returns you to the
Outbound Relationship dialog box.

» If no, continue with the next step to create the group.

3 On the Outbound Group Select dialog box, click New.

System response
The system displays the Outbound Group Entry Dialog Box.

4 In the Description box, type the group description.

5 In the Functional Group 1D box, type the identification of the
functional group.

Note
The EDI standards define which functional group ID should be used
for each type of document.

6 If you have more complex requirements for processing the functional
group, click Advanced.

System response
The system displays the Advanced fields on the Outbound Group
Entry dialog box.

Recommendation

Do not change the translation objectsin the Group Transl. Obj. and
Acknowledge Trangl. Obj. lists, unless you have a specific reason to
do so.

7 Click Envelope to set up the parameters for the generation of the
Functional Group segment.

System response

The Outbound Functional Group dialog box displayed is one of the
following depending on the standard you selected on the Outbound
Relationship dialog box:

» Outbound GS Functional Group

» Outbound UNG Functional Group

» Outbound BAT Functional Group
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Sep Action

8 After you set up the required parameters in the envel oping dialog
box, click Save to store the information and return to the Outbound
Group Entry dialog box.

9 Click Save to store the information about the Outbound Group Entry
dialog box and return to the Outbound Group Select dialog box.

10 » Highlight the new group.
» Click Select.
System response

Selects the group and returns to the Outbound Relationship dialog
box.

Selecting an outbound interchange

1 On the Outbound Relationship dialog box, click Interchanges.

System response
The system displays the Outbound Interchange Select Dialog Box.

2 Isthe required interchange in the Interchanges list?

» If yes, select the interchange. Or if you are not using groups,
select <none>.
Then, click Select. Continue with Finalizing the outbound
relationship on page 3 - 75.

System response
Thisaction selects the highlighted interchange and returns you to
the Outbound Relationship dialog box.

» If no, continue with the next step to create the interchange.

3 On the Outbound Interchange Select dialog box, click New.

System response
The system displays the Outbound Interchange Entry Dialog Box.

4 In the Description box, type the interchange description.
5 In the Interchange ID box, type the identification of the interchange.
Note

The EDI standards define which interchange ID should be used for
each type of document.
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Sep Action

6 If you have more complex requirements for processing the
interchange, click Advanced.

System response
The system displays the Advanced fields on the Outbound
Interchange Entry dialog box.

Recommendation

Do not change the translation objectsin the Interchange Trand. Obj.
and Acknowledge Trangl. Obyj. lists, unlessyou have a specific reason
to do so.

7 Do you want to use the default Mailbox and E-mail Address?
» If yes, continue with step 9.
» If no, continue with the next step.

8 » Select the appropriate mailbox from the Default Mailbox list.

OR
» Click New Mailbox to create a new mailbox.

Note

See the IBM® Serling Gentran: Server® for Microsoft Windows
Communications User Guide for more information about creating
mailboxes.

9 Click Envelope to set up the parameters for the generation of the
interchange segment.

System response

The Outbound Interchange dialog box displayed is one of the
following depending on the standard you selected on the Outbound
Relationship dialog box:

» Outbound ISA Envelope

» Outbound ICS Envelope

» Outbound BG Envelope

» Outbound UNB Envelope

» Outbound UNA Envelope

» Outbound STX Envelope

» Outbound Envelope PIP Initiation

10 After you set up the required parameters in the enveloping dialog
box, click Save to store the information and return to the Outbound
Interchange Entry dialog box.
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Sep Action

11 Click Save to store the information about the Outbound Interchange
Entry dialog box and return to the Outbound I nterchange Select
dialog box.

12 » Highlight the new interchange.
» Click Select.
System response

Selects the interchange and returns to the Outbound Relationship
dialog box.

Finalizing the outbound relationship

1 On the Outbound Relationship dialog box, click Save to save the
outbound relationship.

2 Click Exit to return to the Partner Editor dialog box.
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Editing and Deleting Partner Definitions

Introduction

Editing a partner
profile

The partner definition contains the basic partner profile information to which the
system associates the rest of that partner’s records. You can edit nd delete the
partner definition from the Partner Editor dialog box.

To edit a partner profile, complete the following steps:

Sep

Action

1

From the Tools menu, select Partner Editor.

System Response
The system displays the Partner Editor Dialog Box.

» Select the appropriate partner from the Select a Partner list.
» Click Edit.

System response
The system displays the Partner Definition (New/Edit) Dialog Box
for that partner.

» Make the necessary changes.
» Click Save.

System response
The system returns to the Partner Editor dialog box.

Note

» You can also edit other aspects of a partner relationship (such as
inbound relationship or outbound relationship) by clicking the
appropriate button (Inbound or Outbound) on the Partner Editor
dialog box.

» Youarenot ableto edit any boxes that are grayed; these are the
“keys’ to the relationship. In this case, you must create a new
inbound or outbound relationship for that partner.

Reference
See Creating an Inbound Relationship on page 3 - 58 and Creating
an Outbound Relationship on page 3 - 66 for more information.
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Deletinga  To delete apartner profile, complete the following steps:
partner profile

Sep Action

1 From the Tools menu, select Partner Editor.

System Response
The system displays the Partner Editor Dialog Box.

2 » Select the appropriate partner from the Select a Partner list.
» Click Delete.

System response
You are prompted to confirm the deletion.

Warning

» When you delete a partner relationship, the documents and
interchanges associated with that partner are also deleted.

» If any documents or interchanges exist for a partner you choose
to delete, you are warned before the actual deletion.

3 Click Yesto delete the selected partner profile.

System response
The partner profile and all associated records are deleted.
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Routing Partner Profiles
Import File Select Dialog Box
Introduction  The Import File Select dialog box enables you import a partner into the system.

Diagram  Thefollowing illustrates the Import File Select dialog box:

Import File Select K E3
Loak in: I {4 Partrers j ﬁl
File narne: I*.par
Filez of tppe: IImpmt Files [*.par) j Cancel |
Help |

Partsand  Thefollowing lists the parts of the Import File Select dialog box and their
functions  functions:

Part Function

Look in Select the folder where the system should look for thefile.
Displays the current folder.

File name Specify the name of the file to be imported.

Files of type Select the type of file.
Note
The default file extension for partnersis .par.

Open Begins the import process for the selected partner file.

Cancel Cancels the action and exits the dialog box.

Help Displays Online Help.
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Export File Build Dialog B

Introduction  The Export File Build
export file and begins

Export File Build Dialog Box

OX

dialog box enables you to specify the name of a partner
the export process.

Diagram  Thefollowing illustrates the Export File Build dialog box:

Export File Build

(7] ]

Save I 5] Partners

= & = [=E

File name:  [PETZONE.par

Save as type: IE:-:pDrl Files

[* par) j Cancel |
Help |

Partsand  Thefollowing lists the parts of the Export File Build dialog box and their

functions  functions:

Part

Function

Savein

Select the folder where you want to save the file. Displays
the current folder.

File name

Specify the name of the file to be exported.

Note

The Partner Name field isused to generate the file name. If
the Partner Name contains any Windows reserved
characters (/,\, :,*, ?2,", <, >, |), the file drops those
characters and pads the file name with spaces (one space
for each reserved character in the name).

Example
If the Partner Name is AB/ CD- TEST, the file name will be
AB CD TEST. par.

User Guide
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Part

Function

Savetype

Select the type of file.

Note
The default file extension for partnersis .par.

Save

Begins the export process.

Cancel

Exits the dialog box without making a selection.

Help

Displays Online Help.
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Partner Copy Dialog Box

Introduction  The partner copy feature allows you to copy partner information. Once you copy
the partner, this dialog enables you to change the partner definition and other
identifying boxes for the copied partner.

Note

You must export the partner profile before you copy it. See Exporting Partner
Profiles on page 3 - 87 for more information. If you do not know which EDI
standard that partner profile uses, check the profile to obtain that information
before you export and copy it.

Diagram  Thefollowing illustrates the Partner Copy dialog box:

FErofile 10: I CEelect Partner | Saye |

Mame: | Clear

EDI Code: | Exit

i

Application Code: | Help

Default Mailbox: I j

Group Receiver Qualifier: I E difact with UNG only
Group Receiver |D: | AMSI/Edifact/UCSTDCC

Interchange Receiver Qualifier; I AMSI/Edifact/UCS/TDCC

Interchange Receiver 10: AMSI/Edifact/UCS/TDCC

Interchange Communication 10: I IICS
Interchange Paszsword: | CS
Recipignt Code: I Tradacoms
Recipient Mame: | Tradacoms
Receiver DLIMNS+4: | RosettaMet
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Partsand  Thefollowing lists the parts of the Partner Copy dialog box and their functions:

functions
Part Function
Profile ID Specify a unique identifier for the selected partner.
Select Partner Accesses the Import File Select Dialog Box, which allows

you to select a partner profile to copy.

Name Specify a unique name for the partner.

Note
Make this name as descriptive as possible because thisis
the name displayed in the partner selection list.

EDI Code Specify the EDI identifier for this partner. The system uses
this value during inbound processing to select the correct
trading partner definition.

Application Code | Specify an application code used to identify this partner.
The system uses this value during outbound import
processing to select the correct trading partner definition.

Default Mailbox | Select the mailbox to identify this partner.

Reference

See the IBM® Serling Gentran: Server® for Microsoft
Windows Communications User Guide for more
information.

Group Receiver Specify your partner's Qualifier asit will appear on the
Qualifier UNG group header. Qualifiers are predefined by the EDI
standards.

Note

If the partner profile uses the EDIFACT or ODETTE
standard, you must complete this box. If you do not
complete this box, the system uses the value from the
copied partner profile's envel ope information.

Group Receiver Specify your partner's Group ID. The value can be up to 15
ID characters.

Note

If the partner profile usesthe ANSI, EDIFACT, ODETTE,
UCS, or TDCC standard, you must complete this box. If
you do not complete this box, the system uses the value
from the copied partner profile's envelope information.
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Part Function
Interchange Specify your partner's Qualifier asit will appear on the
Receiver interchange header. Qualifiers are predefined by the EDI
Qualifier standards. The value can be up to four characters.
Note

If the partner profile usesthe ANSI, EDIFACT, ODETTE,
UCS, or TDCC standard, you must complete this box. If
you do not complete this box, the system uses the value
from the copied partner profile's envel ope information.

Interchange Specify your partner's Interchange ID. The value can be up
Receiver ID to 15 characters.
Note

If the partner profile usesthe ANSI, EDIFACT, ODETTE,
UCS, or TDCC standard, you must compl ete this box. If
you do not complete this box, the system uses the value
from the copied partner profile's envelope information.

Interchange Specify your BG communication identifier. This D will
Communication | appear on the BG Interchange Header.
ID

Note

If the partner profile uses the UCS standard, you must
complete this box. If you do not complete this box, the
system uses the value from the copied partner profile's
envelope information.

Interchange Specify a password that is agreed upon by you and your
Password trading partner. This password will appear on the BG
Interchange Header.
Note

If the partner profile uses the UCS standard, you must
complete this box. If you do not complete this box, the
system uses the value from the copied partner profile's
envel ope information.

Recipient Code Specify the code agreed on by you and your partner.

Notes

» If thepartner profile usesthe TRADACOMS standard,
you must complete this box. If you do not complete
this box, the system uses the value from the copied
partner profile's envelope information.

» TheRecipient Codeis mandatory if you do not
complete the Recipient Name box.
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Part

Function

Recipient Name

Specify your partner's name.

Notes

» If thepartner profile usesthe TRADACOMS standard,
you must complete this box. If you do not complete
this box, the system uses the value from the copied

partner profile's envelope information.

» TheRecipient Name is mandatory if you do not

complete the Recipient Code box.

Receiver DUNS+4

Specify the DUNS number of your partner.

Note
This value is mandatory.

Save

Saves the modified information.

Clear

Clears the information from the dialog box.

Exit

Exits the Partner Copy dialog box.

Help

Displays Online Help.
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Importing Partner Profiles

Introduction

Before you begin

Procedure

User Guide

The partner profile defines the parameters that control the processing and
structure of inbound and outbound data. As aresult, the partner profiles may
become complex and may require you to define a significant number of
parameters.

To simplify this process, Sterling Gentran: Server includes the import partner
feature, which enables you to import partner detailsfrom afile. Thefile of partner
details can originate from a partner profile that was exported from another copy of
the Sterling Gentran: Server system.

You can also use the import facility to update information for existing partners. If
you import to an existing partner profile, you can add new trading rel ationships.
Existing relationships are not modified.

Note
Any tables (cross-reference, lookup, or location) attached to the partner profile are
also imported.

Reference
See the Partner File Layouts appendix in the IBM® Serling Gentran: Server® for
Microsoft Windows Administration Guide for more information.

You must create a mailbox for the partner prior to loading the partner profile.
Please see the IBM® Serling Gentran: Server® for Microsoft Windows
Communications Guide for more information.

To import a partner profile, complete the following steps:

Sep Action

1 From the Tools menu, select Partner Editor.

System Response
The system displays the Partner Editor Dialog Box.

2 Click Import.

System response
The system displays the Import File Select Dialog Box.

3 Select the partner file by doing the following:
» Navigate to the folder using the Look in drop-down list.
» Select thefile or type the file name in the File name box.
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Sep

Action

Click Open.

System response
The system displays the Import dialog box.

Note
This dialog box allows you verify this partner is the correct one.

Click Save to continue.

If you are prompted to enter additional partner information, enter that
information and click Save.

System response

The system importsthe partner details (if they do not already exist on
the system) and any relationships for which there are translation
objects. During this process, the system prompts you for any
additional information it needs by displaying the appropriate Partner
Editor dialog box. You are prompted with dialog boxes when you
would normally be required to provide information about your site.
Thisisusually restricted to your EDI identifiers, which the system
uses to generate outbound EDI envelopes. The system continues
displaying Partner Editor dialog boxes until it has all the information
it needs.

When the import is complete, the system displays the following
message:

I mport process conpleted. Please note any warnings or
errors.

Click OK to return to the Import dialog box.

Click Exit to return to the Partner Editor dialog box.
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Exporting Partner Profiles

Introduction  Sterling Gentran: Server includes a feature that enables you to export existing
partner detailsto afile. You can also export your partnersto disk to use asa
backup of your partner system.

Note
Any tables (cross-reference, lookup, or location) attached to the partner profile are
also exported.

Reference
See the Partner File Layouts appendix in the IBM® Serling Gentran: Server® for
Microsoft Windows Administration Guide for more information.

Procedure  To export apartner profile, complete the following steps:

Sep Action

1 From the Tools menu, select Partner Editor.

System Response
The system displays the Partner Editor Dialog Box.

2 » Select apartner.
» Click Export.

System response
The system displays the Export File Build Dialog Box.

3 Name the export file by doing the following:

» Navigate to the correct folder using the Look in list.
» Typethe namein the File name box.

Note

The system automatically prompts you to name the export file with
the name of the partner and the .par extension.

4 Click Save to export the partner.
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Copying Partner Profiles

Introduction

Procedure

The partner copy function enables you to copy partner information so you do not
haveto typein similar partner profiles from scratch. Instead, you can copy from
an existing profile and enter unique partner definition and key enveloping
information for the copied partner.

The partner copy function provides a quick method for establishing partners that
have similar or identical trading relationships.

Note

You must export the partner profile before you copy it. If you do not know which
EDI standard that partner profile uses, check the profile to obtain that information
before you export and copy it.

Reference
See Exporting Partner Profiles on page 3 - 87 for more information.

To copy a partner profile, complete the following steps:

Sep Action

1 From the Tools menu, select Partner Editor.

System Response
The system displays the Partner Editor Dialog Box.

2 Click Copy.

System response
The system displays the Partner Copy Dialog Box.

3 Click Select Partner.

System response
The system displays the Import File Select Dialog Box.

4 Select the file you want to copy by doing the following:
» Navigate to the folder using the Look in list.
» Typethefile namein the File name box.

5 Click Open to copy that partner.

Note

The system displays the model partner profile namein thetitle bar of
the Partner Copy dialog box. The default file extension for exported
partnersis .par.
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Copying Partner Profiles

Sep

Action

On the Partner Copy dialog box, type aunique profileidentifier in the
Profile ID box.

In the Name box, type the partner name.

In the EDI Code box, type the EDI identifier for this partner.

Note
The system uses this identifier during inbound processing to select
the correct partner.

If necessary, inthe Application Code box, type an application code to
identify this partner.

Note
The system uses thisidentifier during outbound import processing to
select the correct partner.

10

Select the appropriate mailbox from the Default Mailbox list.

Note
See the IBM® Serling Gentran: Server® for Microsoft Windows
Communications User Guide for more information.

11

Complete the appropriate boxes in the envel oping section of the
dialog box.

Note

» You should only complete those boxes that are necessary for the
standard the copied partner profile uses. The standards are listed
to theright of each box.

» If the partner profile you copied uses a standard, you must
complete all the necessary enveloping boxes for that standard. If
you do not complete the necessary boxes for the standard, the
system takes the necessary information from the copied partner
profile envelope.

Example
If the copied partner profile uses the UCS standard, you must
complete the Interchange Communication 1D box, among others.

12

After you enter all the partner information, click Save.

System response
The system displays the Outbound Interchange Entry Dialog Box.

User Guide
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Sep Action

13 Do you need to change the default mailbox?

» If yes, select the appropriate mailbox from the Default Mailbox
list. Or click New Mailbox to create a new mailbox

Then, click Save.

» If no, click Save.
System response

The system completes the partner copy operation, displays a
compl etion message.

14 Click OK.

System Response
The system returns to the Partner Copy dialog box.

15 Click Exit to return to the Partner Editor dialog box.
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Using Partner Tables

Overview

I ntroduction

Tableuse

Using tables

User Guide

The trandation process allows you to set up tables to use information in the
Partner database when a document is entered into the system, either from afile or
from the Document Editor facility.

The Partner Editor allows you to use an internal system partner (Internal System
User) to define your company to the system. Tables may be set up to be used
either with atrading partner or with the special system partner.

» Tablesthat you establish under a specific partner are valid only for that
partner.

» Tablesthat you set up under theinternal system user can be used globally.

The use of partner or system partner tables is defined in the trand ation objects at
design time. This allows commonly used items such as names and addresses to be
inserted into the outbound data without the need to typeit. It also allows you to
use Lookup and Cross-reference tables to supplement or convert data that you
either enter or receive.

You can create cross-reference and lookup tables in Sterling Gentran: Server, or
you can import and export existing tables to and from your system.

Notes
» You canonly import and export Sterling Gentran: Server partner tables.

» Tablesareused only if you create atranslation object that specifically
accesses those tables.
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Partner Tables Dialog Box

Introduction  ThePartner Tables dialog box enablesyou to create, edit, or delete cross-reference
or lookup tables. Tables are only used with trand ation objects that are designed to
incorporate that data. When you receive a translation object from IBM, you will
be informed if you need to create tables to be used with that translation object.

Diagram  Thefollowing illustrates the Partner Tables dialog box:

Partner Tables - PETZ0ONE E

Tables: Exit

-ERODCODE

Edit...
Delete
Import

Export

L

Help

Partsand  Thefollowing lists the parts of the Partner Tables dialog box and their functions:

functions _
Part Function
Tables Displays all currently defined partner tables.
Exit Exits the Partner Tables dialog box.
New Accesses the New Table Dialog Box, which allows you to

create anew table.

Edit Accesses either the CrossRef Select Dialog Box or the
Lookup Select Dialog Box, which allows you to edit the
selected table.

Delete Removes the selected partner table from the system.

Import Accesses the Table Import File Select Dialog Box, which

enables you to import a partner table.

Export Accesses the Table Export File Build Dialog Box, which
enables you to export a partner table.

Help Displays Online Help.
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New Table Dialog Box

Introduction

Diagram

Parts and
functions

User Guide

New Table Dialog Box

The New Table dialog box enables you to create a cross-reference or lookup table.

Thefollowing illustrates the New Table dialog box:

Mew Table ER
Table Marme: I
Tahle Tupe
’75' Cross Reference ¢ Lookup

Thefollowing lists the parts of the New Tables dialog box and their functions:

Part

Function

Table Name

Specify the name of the table.

Note

The table name must be the same as the name used in the
tranglation object that requires the table. If your databaseis
case-sensitive, when you reference the table using standard or
extended rules, you must type the exact name of the table
(including case).

Reference

See the IBM® Serling Gentran: Server® for Microsoft Windows
Application Integration User Guide for more information about
standard and extended rules.

Table Type

Specify the type of table. Valid vaues:

Cross-Reference Used to convert your values to your trading
partner's values during outbound processing,
and to convert your trading partner's valuesto
your values during inbound processing.

Lookup Used to find values in inbound or outbound
data

Save

Saves the modified information.

Exit

Exits the New Table dialog box.

Help

Displays Online Help.
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CrossRef Select Dialog Box

Introduction

Diagram

Parts and
functions

Items:

12345678301 2734 <
3456733012345 <
4567890123456 <--
4BE7EI01 234567 <
SE7EI01 2345673 <
E73301 23456739 <

Thefollowing illustrates the CrossRef Select dialog box:

CrossRef Select - PETZONE E3

Table Mame: PRODCODE

Mew...
> B556EE411
+ BOBEEEETT Edit... |
» BOBEEEI0S
+ BERRER3 Delete
> BOBEEE2ET _—l

> 555666413 Help

Using Partners

The CrossRef Select dialog box contains al cross-reference partner tables.

Thefollowing lists the parts of the CrossRef Select dialog box and their functions:

Part Function

Items Displaysalist of tableitems.

Exit Exitsthe CrossRef Select dialog box.

New Accesses the CrossRef Entry Dialog Box, which allows
you to create anew table item.

Edit Accesses the CrossRef Entry Dialog Box, which allows
you to edit the selected table item.

Delete Removes the selected table item.

Help Displays Online Help.
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CrossRef Entry Dialog Box

Introduction

Diagram

Parts and

User Guide

functions

The CrossRef Entry dialog box enables you to create a new table item.

Thefollowing illustrates the CrossRef Entry dialog box:

CrossHef Entry - PETZONE

Table Marme: FRODCODE

by W alue: I

Partrnier Walue: I

Dezcription:

eference Data:

—_ 4 /] M

Thefollowing lists the parts of the CrossRef Entry dialog box and their functions:

Part Function
My Value Specify your data value that corresponds to your partner's
datavalue.
Partner Value Specify your partner's data value that corresponds to your
datavalue.
Description Specify adescription of the codes.
Reference Data Specify up to four values that can be mapped when they

are associated with a specific code value.

Note
These boxes are not currently used by Sterling
Gentran:Server.

Save Saves the modified information.
Exit Exits the CrossRef Entry dialog box.
Help Displays Online Help.
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L ookup Select Dialog Box

Introduction

Diagram

Parts and
functions

Table Mame: PRODCODE
Itemz:
&

The Lookup Select dialog box contains all lookup partner tables.

Thefollowing illustrates the Lookup Select dialog box.

Lookup Select - PETZONE |

B

Edit...

Delete

Hew.
_ Do |
[ b |

Help

Using Partners

The following lists the parts of the Lookup Select dialog box and their functions:

Part Function

Items Displaysalist of tableitems.

Exit Exits the Lookup Select dialog box.

New Accesses the Lookup Entry Dialog Box, which allows you
to create a new table item.

Edit Accesses the Lookup Entry Dialog Box, which allows you
to edit the selected table item.

Delete Removes the selected table item.

Help Displays Online Help.

Sterling Gentran:Server — May 2011

User Guide



Using Partners

L ookup Entry Dialog Box

Introduction

Diagram

Parts and

User Guide

functions

Lookup Entry Dialog Box

The Lookup Entry dialog box enables you to create a new table item.

Thefollowing illustrates the Lookup Entry dialog box:

Lookup Entiy - PETZO0OME [ x|

Table Mame: PRODCODE

Lookup Y alue: | Exit |
Drescription:
eference D ata;

B
|
|
|
|

The following lists the parts of the Lookup Entry dialog box and their functions:

Part Function
Lookup Value Specify the value that will be looked up in the data during
inbound or outbound processing.
Description Specify adescription of the code.
Reference Data | Specify up to four values that can be mapped when they

are associated with a specific code value.

Note
These boxes are not currently used by Sterling
Gentran:Server.

Save Saves the modified information.
Exit Exits the CrossRef Entry dialog box.
Help Displays Online Help.
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Table Export File Build Dialog Box

Introduction  The Table Export function allows you to export partner cross-reference and
lookup tables to a sequentia file. This allowsyou to define atable for one trading
partner and copy that table to another partner profile.

Notes
» You can only export Sterling Gentran: Server partner tables.

» Thedefault file extension for cross-reference tablesis .xrf. The default file
extension for lookup tablesis .Ikp.

Diagram  Thefollowing illustrates the Table Export File Build dialog box:

Save in; Ia Partners j gl

File name: IPETZDNEPHDDEDDE.Ikp

Save az lype: IE:-:pu:urt Files [*.lkp) ﬂ Canicel |
Help |

Partsand  Thefollowing lists the parts of the Table Export File Build dialog box and their
functions  functions:

Part Function
Savein Select the folder where you want to save the file. Displays
the current folder.
File name Specify the name of the file to be exported.
Save astype Select the type of file.
Note

The default file extension for cross-reference tablesis .xrf
and for lookup tablesis .lIkp.

Save Begins the table export process.
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Table Export File Build Dialog Box

Part

Function

Cancel

Exits the dialog box without making a selection.

Help

Displays Online Help.
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Table Import File Select Dialog Box

Introduction  The Table Import function allows you to import partner cross-reference and
lookup tables from a sequential file. This allows you to import tables created for
another partner profile, share tables with other users of Sterling Gentran: Server,
and build tables outside of Sterling Gentran:Server by formatting your datain the
export file layout.

Notes
» You canonly import Sterling Gentran: Server partner tables.

» Thedefault file extension for cross-reference tablesis .xrf. The default file
extension for lookup tablesis .Ikp.

Diagram  Thefollowing illustrates the Table Import File Select dialog box:

Table Import File Select EHE
Look jr: |E Partrers j | ﬁl |
File name: |".:-<rf
Files af twpe: IE[DSS Reference Files [%.xrf) j Cancel |

Help |

Partsand  Thefollowing lists the parts of the Table Import File Select dialog box and their
functions  functions:

Part Function

Look in Select the folder where you want the system to ook for the
file. Displays the current folder.

File name Specify the name of the file to be imported.
Files of type Select the type of file.
Note

The default file extension for cross-reference tablesis .xrf
and for lookup tablesis .Ikp.
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Table Import File Select Dialog Box

Part Function
Open Begins the import process for the selected partner table
file.
Cancel Cancels the action and exits the dialog box.
Help Displays Online Help.
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Creating Partner Tables

Procedure  To create a partner table, complete the following steps:

Sep Action

1 From the Tools menu, select Partner Editor.

System Response
The system displays the Partner Editor Dialog Box.

2 » Select the partner profile or the system partner (Internal System
User) for which you want to create a Cross-reference or Lookup
table.

» Click Tables.

System Response
The system displays the Partner Tables Dialog Box.

3 Click New.

System response
The system displays the New Table Dialog Box.

4 In the Table Name box, type the unique table name.

Note

The table name must be the same as the name used in the translation
object that requiresthetable. If your database is case-sensitive, when
you reference the table using standard or extended rules, you must
type the exact name of the table (including case).

Reference

See the IBM® Serling Gentran: Server® for Microsoft Windows
Application Integration User Guide for more information about
standard and extended rules.

5 In the Table Type section, select the Cross-reference or Lookup table
option.

6 Click Save.

System response

Saves the information you entered and accesses either the CrossRef
Select Dialog Box or Lookup Select Dialog Box depending on which
type of table you selected in Step 5.
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Creating Partner Tables

Sep

Action

Click New.

System response
Displays either the CrossRef Entry Dialog Box or Lookup Entry
Dialog Box depending on which type of table you selected in Step 5.

Type the following table values:

» Two valuesfor across-reference and one value for alookup table
» A description

Note

How your datais used depends on how the tranglation object is

defined. Consult with the trandlation object designer if you are
unclear about what is required.

Click Save after each entry to save the information and enter another
table record.

10

Once you finish typing al entries, click Exit to return to the
Cross-reference or Lookup Select dialog box.

11

Click Exit to return to the Partner Editor dialog box.
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Editing Partner Tables

Procedure  To edit apartner table, complete the following steps:

Sep Action

1 From the Tools menu, select Partner Editor.

System Response
The system displays the Partner Editor Dialog Box.

2 » Select the partner profile or the system partner (Internal System
User) for which you want to modify a Cross-reference or Lookup
table.

» Click Tables.

System Response
The system displays the Partner Tables Dialog Box.

3 » Select the table you want to modify.
» Click Edit.

System response
Displays either the CrossRef Select Dialog Box or Lookup Select
Dialog Box (depending on the type of table).

4 » Select theitem you want to modify.
» Click Edit.
System response

Displays either the CrossRef Entry Dialog Box or Lookup Entry
Dialog Box depending on the type of table.

5 Modify the entry.

6 After you finish modifying all necessary table entries, click Save.

System Response
The system returns to the Cross-reference or Lookup Select dialog
box.

7 Click Exit.

System Response
The system returns to the Partner Editor dialog box.
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Deleting Entriesin a Partner Table

Procedure  To delete entriesin a partner table, complete the following steps:

Sep Action

1 From the Tools menu, select Partner Editor.

System Response
The system displays the Partner Editor Dialog Box.

2 » Select the partner profile or the system partner (Internal System
User) for which you want to delete a table entry.

» Click Tables.

System Response
The system displays the Partner Tables Dialog Box.

3 » Select the table you want to modify.
» Click Edit.

System response
The system displays either the CrossRef Select Dialog Box or
L ookup Select Dialog Box depending on the type of table.

4 » Select theitem you want to modify.
» Click Delete.

System response
The system displays the Confirm Delete dialog box.

5 Click Yesto complete the deletion.

System response
The system returns to either the CrossRef Select Dialog Box or
L ookup Select Dialog Box depending on the type of table.

6 Click Exit.

System Response
The system returns to the Partner Editor dialog box.
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Deleting Partner Tables

Procedure  To delete apartner table, complete the following steps:

Sep Action

1 From the Tools menu, select Partner Editor.

System Response
The system displays the Partner Editor Dialog Box.

2 » Select the partner profile for which you want to delete atable.
» Click Tables.

System Response
The system displays the Partner Tables Dialog Box

3 » Select the table you want to delete.
» Click Delete.

System response
The system displays the Confirm Delete dial og box.

4 Click Yesto complete the deletion.

System Response
The system returns to the Partner Editor dialog box.
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Exporting Partner Tables

Introduction  The Table Export function allows you to export partner cross-reference and
lookup tables to a sequentia file. This allowsyou to define atable for one trading
partner and copy that table to another partner profile.

Reference
See the Partner File Layouts appendix in the IBM® Serling Gentran: Server® for
Microsoft Windows Administration Guide for more information.

Export filelayout  Typically, you export and then import tables created for another partner profile.
However, if necessary, you can build tables outside of Sterling Gentran:Server by
formatting your datain the export file layout.

The export file layout is afree-format ASCII text file. Each field must be
delimited (separated) with Hex01 because the field lengths are variable.

Note

You can create the file with atext editor (such as Notepad). The default file
extension for alookup export fileis.Ikp. The default file extension for a
cross-referencefileis .xrf.

L ookup table fields
The following table identifies the fields in lookup tables. Mandatory fields are

designated with an asterisk (*).

Field Description
PartnerKEY * Unique identifier for the partner
TableCode For lookup, thisvalueis“L".
TableName* Descriptive name for the table

Thisvaueisdisplayed in the table selection list.

Item* Value that islooked up in the data during inbound
or outbound processing

Description Brief comment about the item

Textl, Text2, Text3, Text4 | Additional reference information as required by
the tranglation object using thistable
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Export filelayout  Cross-reference table fields
(contd)  Thefollowing table identifies the fields in cross-reference tables. Mandatory
fields are designated with an asterisk (*).

Field Description
PartnerK EY* Unique identifier for the partner
TableCode For cross-reference, thisvalueis“C”.
TableName* Descriptive name for the table

Thisvaueisdisplayed in the table selection list.

Myltem* Your data value that corresponds to your partner’s
datavalue

Partneritem* Your partner’s data val ue that corresponds to your
datavalue

Description Brief comment about the item

Textl, Text2, Text3, Text4 | Additiona reference information as required by
the translation object using thistable

Procedure  To export apartner table, complete the following steps:

Sep Action

1 From the Tools menu, select Partner Editor.

System Response
The system displays the Partner Editor Dialog Box.

2 » Select the partner profile or the system partner (Internal System
User) for which you want to export a Cross-reference or Lookup
table.

» Click Tables.

System Response
The system displays the Partner Tables Dialog Box.

3 Click Export.

System response
The system displays the Table Export File Build Dialog Box.
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Sep Action
4 From the Save in drop-down list, select the location of the exported
tablefile.
Note
You can only export Sterling Gentran:Server partner tables.
5 » Typethe export file name in the File name box.
OR

» Sdectitfromthelist.

Note
The default file extension for cross-reference tablesis .xrf. The
default file extension for lookup tablesis .Ikp.

6 Click Save to begin the export process.

Note
When the export process is complete the system displays an
informational dialog box.

7 Click OK.

System Response
The system returns to the Partner Tables dialog box.

8 Click Exit.

System Response
The system returns to the Partner Editor dialog box.
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Importing Partner Tables

Introduction  The Table Import function allows you to import partner cross-reference and
lookup tables from a sequential file. This alows you to import tables created for
another partner profile and build tables outside of Sterling Gentran: Server by
formatting your datain the export file layout.

Reference
See the Partner File Layouts appendix in the IBM® Serling Gentran: Server® for
Microsoft Windows Administration Guide for more information.

Procedure  Toimport apartner table, complete the following steps:

Sep Action

1 From the Tools menu, select Partner Editor.

System Response
The system displays the Partner Editor Dialog Box.

2 » Select the partner profile or the system partner (Internal System
User) for which you want to import a Cross-reference or Lookup
table.

» Click Tables.

System Response
The system displays the Partner Tables Dialog Box.

3 Click Import.

System response
The system displays the Table Import File Select Dialog Box.

4 From the Look in drop-down list, select the location of the tablefile.

5 » Typetheimport file namein the File name box.

OR
» Sdectitfromthelist.

Notes
» You can only import Sterling Gentran:Server partner tables.

» Thedefault file extension for cross-reference tablesis .xrf. The
default file extension for lookup tablesis .Ikp.
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Sep Action

6 Click Open to begin the import process.

Note
When the export process is complete the system displays an
informational dialog box.

7 Click OK.

System Response
The system returns to the Partner Tables dialog box.

8 Click Exit.

System Response
The system returns to the Partner Editor dialog box.
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Using Partner Locations

Overview

Introduction  Each partner profile may have many associated location tables. The location
tables may contain address- and contact-related information about the partner.
You can use location tables in many different ways. Locations are referenced in
tranglation objects through one of the location keys (reference codes). Locations
are used only if you use atrandation object that specifically accesses those
locations.

Example
You may need alist of apartner’s store addresses, warehouse addresses, or
“invoice to” addresses. Any or all of these can be stored in alocation table.

Necessary  You must set up two parameters that contain the following information:
parameters ,  Thename of the trading partner location
» Thereference codes that the system uses to identify this location

These parameters are used to create a partner location.

Beforeyou begin  Before setting up a partner location, you must know the following information to
plan the implementation of this partner:

» Theunique name that identifies this partner location
» Atleast onereference code to identify the location
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L ocation Select Dialog Box

Introduction

Diagram

Parts and
functions

User Guide

The Location Select dialog box allows you to add, edit, and del ete partner-specific
name and address information. Locations are only used with tranglation objects
that are designed to incorporate that data.

Thefollowing illustrates the Location Select dialog box:

Location Select - PETZ0ONE E3

Locationz:

E it |

Edif.. |
[elete |
Help |

Thefollowing lists the parts of the Location Select dialog box and their functions:

Part Function

Locations Displays all defined locations.

Exit Exits the Location Select dialog box.

New Accesses the Location Entry Dialog Box, which alows
you to create a new location.

Edit Accesses the Location Entry Dialog Box, which alows
you to edit the selected location.

Delete Removes the selected location from the system.

Help Accesses Online Help.
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L ocation Entry Dialog Box

Introduction  The Location Entry dialog box enables you to create and edit location

information.

Diagram  Thefollowing illustrates the Location Entry dialog box:

Location Entry - PE TZONE ]|

Mame: I

Reference Codel:

Reference Codez:

LContact:

Address1

Address3

|

:
Addresss: I
-

|

City:

State: I £ip Code; I
Country: I

Fhone: I

Partsand  Thefollowing liststhe parts of the Location Entry dialog box and their functions:

functions

Part

Function

Name

Specify the name of thistrading partner location. This
name should accurately describe the location because this
box will be displayed in the location selection list.

Note
This box is mandatory.

Reference Codel

Specify areference code to identify the location being
defined (such as a DUNS number).

Note
This box is mandatory.

Reference Code2

Specify areference code to identify the location being
defined (such as a DUNS number).
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Part Function
Contact Specify the name of a personal contact.
Addressl Specify the partner’s business address.
Address2
Address3
City Specify the partner’s city.

State Specify the partner’s state.

Zip Code Specify the partner’s zip or postal code.
Country Specify the partner’s country.

Phone Specify the partner’s phone number.
Fax Specify the partner’s fax number.

Save Saves the modified information.

Exit Exits the Location Entry dialog box.
Help Displays Online Help.
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Creating Partner Locations

Procedure  To create partner locations, complete the following steps:

Sep Action

1 From the Tools menu, select Partner Editor.

System Response
The system displays the Partner Editor Dialog Box.

2 » Select the partner profile or the system partner (Internal System
User) for which you want to create alocation.

» Click Locations.

System Response
The system displays the Location Select Dialog Box.

3 Click New.

System response
The system displays the Location Entry Dialog Box.

4 In the Name box, type a unique identifier that defines this location
within the partner.

5 In the Reference Code 1 box, type the unique identifier for the
location you are defining.

Example
The DUNS number for the location.

6 Complete the remaining boxes, as necessary.

Note
If you use Reference Code 2, it must also be unique.

7 Click Save.

System response
Saves the location information and displays a blank Location Entry
dialog box.

8 If you want to enter additional locations for this partner, repeat steps
4 through 7 as many times as necessary.

9 Click Exit.

System Response
The system returns to the Partner Editor dialog box.
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Editing Partner Locations

Procedure  To edit a partner location, complete the following steps:

Sep Action

1 From the Tools menu, select Partner Editor.

System Response
The system displays the Partner Editor Dialog Box.

2 » Select the partner profile or the system partner (Internal System
User) for which you want to create alocation.

» Click Locations.

System Response
The system displays the Location Select Dialog Box.

3 » From the Locationslist, select alocation.
» Click Edit.

System response
The system displays the Location Entry Dialog Box.

4 Make any necessary changes.

Note
The Reference Codel box must be compl eted.

5 » Click Save to save the location information and return to the
Location Select dialog box.

OR
» Click Exit to return to the Location Select dialog box without
saving changes.

6 Click Exit.

System Response
The system returns to the Partner Editor dialog box.
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Delete Partner Locations

Using Partners

Procedure  To delete apartner location and all associated records, complete the following

steps:

Sep

Action

1

From the Tools menu, select Partner Editor.

System Response
The system displays the Partner Editor Dialog Box.

» Select the partner profile or the system partner (Internal System

User) for which you want to create alocation.
» Click Locations.

System Response
The system displays the Location Select Dialog Box.

» From the Locationslist, select alocation.
» Click Delete.

System response

The system displays the Delete Confirmation dialog box.

Click Yes to confirm the delete.

Click Exit.

System Response
The system returns to the Partner Editor dialog box.
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| ntroduction

Inthischapter  Thischapter explains how to use the Sterling Gentran: Server document functions,
including:
» creating and editing documents
» managing documents
» routing documents

EDI documents  Sterling Gentran:Server tracks the relationship between an EDI document and the
corresponding application data. For import processing, the system makes a
persistent copy of the application data at the start of processing. For inbound
(export) processing, the system assigns a unique identifier to the document, which
is then permeated throughout the system for all database entries associated with
the received document.

References
For additional information, see the following:

» Importing Documents on page 4 - 60
» Exporting Documents on page 4 - 62
» Using Tracking, chapter 9in this guide

Document Editor  The Document Editor feature is the Sterling Gentran: Server data entry tool. It
alows you to create, modify, and view documents.

Note

To use the Document Editor, you must register the appropriate screen entry
tranglation object with the system and set up a corresponding outbound
relationship for the partner.
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Document Browsar's

Accessing the Document Browsers

Introduction  You can access document browsers in Sterling Gentran:Server in one of three
ways:
» TheDesk givesyou accessto the In Documents, ?ln Documents, Workspace,
Out Documents, ?0ut Documents, Interchanges, In Drawer, and Out Drawer.

» TheMain Toolbar givesyou access to the In Documents, ?ln Documents,
Workspace, Out Documents, ?0ut Documents, Interchanges, In Drawer, Out
Drawer, and Send Queue.

» TheView menu gives you access to the In Documents, ?in Documents,
Workspace, Out Documents, ?0ut Documents, Interchanges, In Drawer, Out
Drawer, and Send Queue.

Summary dialog  If you select the In Documents, ?In Documents, Out Documents, ?0ut
boxes  Documents, In Drawer, or Out Drawer browser from any of the three locations
above, the system displays the appropriate summary dialog box for that browser.

The summary dialog box displays the number of each type of document for each
partner contained in the appropriate browser. This enables you to filter the display
of documents in the browser to only those of the document type and partner that
you want.

Browser columns  Thefollowing lists the columns displayed in all browsers:

Part Function
Partner Identifies the trading partner.
Type | dentifies the specific type of EDI document.
Example

810 identifies an invoice.

Name Displays the user-assigned name of the document.
Status The alowable status depends on the browser.
Reference

See the Glossary for more information about status values.
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Procedure

Browser Page Size and Position Preferences

Part

Function

RefData

Displays the reference data assigned by the trandlation
object designer to identify this document:

Segment/element positional value (such as a PO
Number for a purchase order)

Blank (no reference datais assigned)

Note

In the browsers, you can click a column heading to sort the display by that values

in that column.

To access any of the document browsers, complete the following steps:

Step

Action

1

From the appropriate area of The Desk, select the browser.

System Response
The system displays the appropriate summary dialog box for that
browser.

Select the type of document for the appropriate partner.

Notes
To highlight more than one partner/document type combination,
click on the first partner/document type and then press SHIFT
and click the last partner/document type in the group.

To highlight several partner/document types that are not adjacent
to each other in the summary dialog box, press CTRL and click
the partner/document types.

Click View.

System response
The system displays the browser containing those documents.

Browser Page Size and Position Preferences

User Guide

By default, Sterling Gentran: Server maintains your current page sizes and
positions after you have changed them. You can reset your browser window sizes
and positions to the defaullt.
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Diagram  Thefollowing illustrates the Preference dialog box:

Preferences g|
Refresh I Directories ] Change Password ] Send Options ]
Interchange Fitter ] Extemal Data Fitter Browser Views

Interchange Browser and Restored Interchange Browser default settings

[~ iTum on Bxtemal Data View:

[~ Tum on Gentran Data View

[ Tum on Translator Report View

[v Sawve Browser Postions and Sizes

oK | Cancel | Help ‘

Procedure  To access Preference dialog box and result the default views, complete the
following steps:

Sep Action

1 From the appropriate area of The Desk, select the Options >
Browser Views.

System Response
The system displays the dialog box.

2 To reset the default view, deselect the Save All Browser Positions
and Sizes check box.

3 Click OK.

System response
The system displays the browser containing those documents.
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|n Documents Browser

In Documents Browser

Introduction  The In Documents browser contains alist of documents that the system received
but that have not yet been processed by the user. After the documents are
processed (printed or exported) the documents are transferred to the In Drawer.

Diagram  Thefollowing illustrates the In Documents browser:

* In Documents - PETZONE - 850 - 2 = E3
Farther | Type | M ame | Status Wigw, . I
FETZOME F, Fri
PETZ0OM ELi 1234567890 ok L5

Delete
Expart...
Mowve
Receiwe
Fefrezh
« | ] ferEsn |
Cloze

2 Documents w 1zelected =

<7 ok

Partsand  Thefollowing lists the parts of the In Documents browser and their functions:

functions

Part

Function

View

Accesses the View Choice Dialog Box, which alows you
view the selected document.

Print

Accesses the Print Choice Dialog Box, which allows you
to print the selected document.

Delete

Deletes the selected document.

Note

If adocument is waiting for acknowledgement processing
(acknowledgement generation or reconciliation), you can
not delete it until this processing is complete.

Export

Accesses the Select Export Method Dialog Box, which
alows you to export the selected document

User Guide
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Part Function
Move Moves the selected document to the In Drawer.
Receive Accesses the Communication Session dialog, which allows

you to begin areceive-only session.

Refresh Refreshes the display of the browser.
Close Closes the browser.
Help Displays Online Help.
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?ln Documents Browser

Introduction  The ?2ln Documents browser contains alist of documents that the system received
but failed compliance checking or do not have an identifiable partner or
transaction set.

Diagram  Thefollowing illustrates the 21n Documents browser:

i ?In Documents - - ORDERS - 1 =
Fartner I Type I MHame | Status Wiew. .. I
Ik piowr ik nown .

Unknown nkhown Print_
Delete
Export...

tove |

Fefrezh
4| | ﬂ —_— 1
Cloze
1 Documents i 1 selected
Help

Partsand  Thefollowing lists the parts of the ?ln Documents browser and their functions:

functions
Part Function

View Accesses the View Choice Dialog Box, which alows you
view the selected document.

Print Accesses the Print Choice Dialog Box, which allows you
to print the selected document.

Delete Deletes the selected document.
Note

If adocument is waiting for acknowledgement processing
(acknowledgement generation or reconciliation), you may
not delete it until this processing is complete.

Export Accesses the Select Export Method Dialog Box, which
allows you to export the selected document
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Part Function
Move Moves the selected document to the In Drawey.
Refresh Refreshes the display of the browser.
Close Closes the browser.
Help Displays Online Help.
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In Drawer Browser

Introduction  TheIn Drawer browser contains alist of documents that the system received and
processed.

Diagram  Thefollowing illustrates the In Drawer browser:

* In Drawer - Rons Egos - Receipt Acknowledge - 1 M= B3
Fartner | Tyupe | Mame | Status Wik, . I
jeceipt Acknow... -BORZFZ E-... )
Hecel kh BUOEF Frint
Delete
Expart...

Rezpond |

Fiefresh
4| | _bl - — |
Cloze
1 Documents 7 1zelected ———
Eﬁ Help

Partsand  Thefollowing lists the parts of the In Drawer browser and their functions:

functions
Part Function

View Accesses the View Choice Dialog Box, which alows you
view the selected document.

Print Accesses the Print Choice Dialog Box, which allows you
to print the selected document.

Delete Deletes the selected document.

Export Accesses the Select Export Method Dialog Box, which

alows you to export the selected document.
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Part Function

Respond Creates a turnaround document in response to the selected
document or documents.

Note

The Respond function is only valid when one or more
documents are selected and Turn Around translation
objects exist for the selected documents.

Reference
See Inbound Translation Object Dialog Box on page 3 - 15
for more information.

Refresh Refreshes the display of the browser.
Close Closes the browser.
Help Displays Online Help.
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Wor kspace Browser

Workspace Browser

Introduction  The Workspace browser contains alist of documents that the system received but
that have not yet been processed by the user. After the documents are processed
(printed or exported) the documents are transferred to the In Drawer.

Diagram  Thefollowing illustrates the Workspace browser:

* Workspace - 1

= 3

Partner

1

| Type | Mame | Status Wiew... I

Frint...
Delete

Ewpart..

Open
Piost
Mew...
Impaoit...

| , Refresh

1 Documents

Cloze

i 1 zelected T
EW el

Partsand  Thefollowing lists the parts of the Workspace browser and their functions:

functions

Part

Function

View

Accesses the View Choice Dialog Box, which alows you
view the selected document.

Print

Accesses the Print Choice Dialog Box, which allows you
to print the selected document.

Delete

Deletes the selected document.

Export

Not avalid function for this browser.

Open

Accesses the Document Editor facility, which allows you
to edit the selected document.

User Guide
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Part Function

Post Moves the selected compliant document to the Out
Documents Browser.

Note
Post documents to the Out Documents before sending
them.

New Accesses the Create New Document dialog box, which
allows you to select a partner/transaction set combination
for which you want to enter a new document using the
Document Editor facility.

Note

The Document Editor uses the associated screen entry
tranglation object to alow information to be entered into
the system.

Reference
See Creating an Outbound Relationship on page 3 - 66 for
more information.

Import Accesses the Application Filesto Import Dialog Box,
which alows you to import data from an external
application file.

Note

Depending on the content of the file, the system may
prompt you for partner, transaction, or trandlation object
information. The Import function does not affect any
selected documents.

Refresh Refreshes the browser display.
Close Closes the browser.
Help Displays Online Help.
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Out Documents Browser

Introduction  The Out Documents browser contains alist of documentsthat are ready to be sent.

After the documents are successfully sent, they are automatically transferred to
the Out Drawer.

Diagram  Thefollowing illustrates the Out Documents browser:

* OQut Documents - PETZ0ONE - 810 -5 !Eﬁ
Partrer | Type | M ame I Status Yiew,.. I
PETZONE g 000000005 4 Fi
FETZONE &1 0000000006 ok It
FETZONE 2410 Qooaooaoay (4 Delete
FETZOME 2410 Qooaooaoos (]
FETZOME 2410 Q0oaooa0o3 (4 Epport...
Send
UnPozt
Refresh
| | ] — |
Close
5 Documents a Tselected ——
o e

Partsand  Thefollowing lists the parts of the Out Documents browser and their functions:

functions
Part Function

View Accesses the View Choice Dialog Box, which alows you
view the selected document.

Print Accesses the Print Choice Dialog Box, which allows you
to print the selected document.

Delete Deletes the selected document.

Export Not avalid function from this browser.
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Part Function

Send Accesses the Send/Receive dialog box, which enables you
to manually start a communications session to send data.

Notes

» Only selected documentswill be enveloped and sent. If
no documents are selected then all documents will be
sent. Successfully sent documentswill be moved to the
Out Drawer.

» Initiating a Send session also prompts the system to
receive any documents that are waiting to be received.

» The Send functionisonly valid if Out Documentsis
the currently selected browser and documents are
present or if interchanges in the Interchanges browser

have a Ready status.
UnPost Moves the selected document back to the Workspace
browser.
Refresh Refreshes the display of the browser.
Close Closes the browser.
Help Displays Online Help.
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?0ut Documents Browser

Introduction  The ?0ut Documents browser contains alist of documentsthat were imported into
the system but are invalid.

Diagram  Thefollowing illustrates the 20ut Documents browser:

i ?0ut Documents - 810 - PETZONE - 2 M= E
Partrer I Tupe I M ame I Status | Wiew... I
FET-0OMNE 210 Fatk, Print
PETZ0OM a10 Q000000008 MatOk, " |

Delete
Erport. .

Maove |

Refresh

1 | 10

2 Documents a7 1 selected

“ Help

Cloze

Partsand  Thefollowing lists the parts of the 20ut Documents browser and their functions:

functions Part Function

View Accesses the View Choice Dialog Box, which alows you
view the selected document.

Print Accesses the Print Choice Dialog Box, which allows you
to print the selected document.

Delete Deletes the selected document.

Export Not avalid function from this browser.

Move Moves the selected document to the In Drawer.

Refresh Refreshes the browser display.

Close Closes the browser.

Help Displays Online Help.
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Out Drawer Browser

Using Documents

Introduction  The Out Drawer browser contains alist of documents that the system successfully

sent.

Diagram  Thefollowing illustrates the Out Drawer browser:

* Out Drawer - Bons Egogs - Purchase Order Request Action - 1 M= B

Fartner

| Tyupe | Mame | Status Wi, I

4]

Furchasze Crder ...

Fr456d.324 FE - Ackd

Frint...
[elete

Exmart,

Copy
Al

| - Fefresh

1 Documents

Cloze
[T=

1sgelected ——
\H Help

Partsand  Thefollowing lists the parts of the Out Drawer browser and their functions:

functions

Part

Function

View

Accesses the View Choice Dialog Box, which allows you
view the selected document.

Print

Accesses the Print Choice Dialog Box, which allows you
to print the selected document.

Delete

Deletes the selected document.

Export

Not avalid function from this browser.

Copy

Copies the selected documents to the Workspace.

Note
This function enables you to reprocess and resend
documents that were already sent by the system.
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Out Drawer Browser

Part Function
Ack Changes the status of the selected documents to
Acknowledged.
Refresh Refreshes the browser display.
Close Closes the browser.
Help Displays Online Help.
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Processing Browser

Introduction  The Processing browser contains alist of documents that the system is currently
processing.

Note

The Processing browser displays the current status of the processing document. If
the document is processing, the status code is set to 1. If the document or
acknowledgement is deferred, the status code is set to 2.

Diagram  Thefollowing illustrates the Processing browser:

* Processing - 0 M= 3

Fartrer | Tupe | Hame | RefDat EEset I

‘ | _’I Refresh
Cloze
0 Documents EA 0 selected Tlp
Partsand  Thefollowing lists the parts of the Processing browser and their functions:
functions
Part Function
Reset Returnsto their previous location any documents that are
displayed on this dialog box but for which processing has
terminated.
Note

Thisfunction istypically used for exception cases when
the processing of a document terminated improperly.

Refresh Refreshes the browser display.
Close Closes the browser.
Help Displays Online Help.
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Related Dialog Boxes

View Choice Dialog Box

Introduction  The View Choice dialog box enables you to specify how you want to view the
selected document.

Diagram  Thefollowing illustrates the View Choice dialog box:

Yiew Choice |

" Gentran Data
" External Data
" Formatted Documerk

™ Translatar Fepaort
" Data Audit

" Tracking Information

Cancel |

Partsand  Thefollowing lists the parts of the View Choice dialog box and their functions.
functions  You can select only one of these options.

Part Function
Gentran Data Displays the raw EDI data.
External Data Displays the data file used in trandl ation.
Note

This option is not available if the external datafile used in
tranglation does not exist.

Formatted Displays the data in the Document Editor using a screen
Document entry trandation object.
Note

This option is not available if no screen entry translation
object exists for the document.
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Part Function

Trandator Report | Displaysareport of the actions the translator took on this
document and lists any EDI- or trand ation object-based
compliance errors.

Reference

See Error Messagesin the IBM® Serling

Gentran: Server® for Microsoft Windows Administration
Guide for more information about translator reports.

Data Audit Displays the document tracking information that is
available for a single document.
Note
Thisfunction is not available if document level auditing is
disabled.
Tracking Displays information that tracks an external datafile.
Information
OK Executes the selected function; exits the dialog box.
Cancel Exits the dialog box.
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Print Choice Dialog Box

Introduction  The Print Choice dialog box enables you to specify whether you want to print the
selected item (document or translation object) or asummary list of all itemsin the
browser.

Diagram  Thefollowing illustrates the Print Choice dialog box:

Print Choice [ x|

i+ Selected ltems.

I Eormatted
Cahcel

¥ Move documents to In Drawer

= Sumrnary List of [bems.

_Cred |
Help |

Partsand  Thefollowing lists the parts of the Print Choice dialog box and their functions:
functions

Part Function

Selected Items Tellsthe system to perform the selected items or items (the
following two fields).

Formatted Tells the system to print the items as formatted (using the
appropriate translation object).

Note

This option is unavailable when printing a translation
object (alwaysformatted) or when a print transl ation object
does not exist for the item.

Movedocumentsto | Tells the system to move the document to the In Drawer.

In Drawer
Note

Thisoption isonly available for the In Documents and ?In
Documents browsers.

Summary List of Tells the system to print a summary list of the items

Items selected in the browser.

OK Executes the selected function; exits the dialog box.
Cancel Exits the dialog box.

Help Accesses Online Help.
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Select Export Method Dialog Box

Introduction  The Select Export Method dialog box enables you to write documents to an
external file for processing by another application.

Notes

» There must be a system export translation object for the document or a
partner-specific export trand ation object for the document.

» TheExport function is only valid when one or more documents are selected
from one of the following browsers: In Documents, In Drawer, or ?2In
Documents.

Diagram  Thefollowing illustrates the Select Export Method dialog box:

Select Export Method E3

& Ewport to Single File Cancel |

" Export to Default Files
" Select File by Document

Help |

Partsand  Thefollowing lists the parts of the Select Export Method dialog box and their
functions  functions. You can select only one of these options.

Part Function

Export to Single | Converts all selected documents to data and accesses the
File Choose File to Export Document Dialog Box to writethem
toasinglefile.

Export to Default | Writes selected documents to the files set up in the partner
Files inbound relationship.

Reference
See Inbound Translation Object Dialog Box on page 3 - 15
for more information about designating the export file.

Select File by Accessesthe Choose File to Export Document Dialog Box,

Document which enables you to rename selected documents to be
exported.

OK Executes the selected function; exits the dialog box.
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Select Export Method Dialog Box

Part

Function

Cancel

Exits the dialog box.

Help

Accesses Online Help.
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Choose Fileto Export Document Dialog Box

Introduction  The Choose File to Export Document dialog box enables you to specify the name
of the file to which the system exports the selected document.

Notes

» There must be a system export translation object for the document or a
partner-specific export translation object for the document.

» TheExport function is only valid when one or more documents are selected
from one of the following browsers: In Documents, In Drawer, or 2In
Documents.

Diagram  Thefollowing illustrates the Choose File to Export Document dialog box:

Chooze file to Export document:

Look in: I £ Expaorts

File nare: I

Files of type: |Tentfiles[".t:-:t] j Cancel |

Partsand  Thefollowing lists the parts of the Choose File to Export Document dialog box
functions  and their functions:

Part Function

Look in Select the folder where the system should look for thefile.
Displays the current.

File name Specify the name of the export file.

Files of type Select the type of file.

Open Executes the selected function; exits the dialog box.

Cancel Exits the dialog box.

Help Accesses Online Help.
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Application Filesto Import Dialog Box

Application Filesto Import Dialog Box

Introduction

Diagram

Parts and
functions

User Guide

The Application Files to Import dialog box enables you to import data from an
external application file.

Note

Depending on the content of the file, the system may prompt you for partner,
transaction, or translation object information. The Import function does not affect
any documents that may be selected.

The following illustrates the Application Files to Import dialog box:

Application Files to Import

Loak jn:

I =3 Imparts

Pet_tiny. kst
File narne: |F'et_8'| (0.tat Open
Files of type: [l files 7] = Cancel

Wi

Help

Thefollowing lists the parts of the Application Files to Import dialog box and

their functions:

Part Function

Look in Select the folder where the system should look for thefile.
Displays the current.

File name Specify the name of the export file.

Files of type Select the type of file.

Open Executes the selected function; exits the dialog box.

Cancel Exits the dialog box.

Help Accesses Online Help.
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Document Search Dialog Box

Introduction  The Document Search dialog box enables you to specify criteriafor which
Sterling Gentran: Server performs a system-wide search. This enables you to
quickly access a subset of documents without searching each browser manually.

Diagram  Thefollowing illustrates the Document Search dialog box:

B Document Search

Enter zearch criteria to dizplay Tracking Information for
each match found:

Diocument M anme:

RefD ata:

Partner:

Docurmnent Type:

Application Field 1:

Application Field 3:

Application Field 4:

Application Field 5:

|
|
|
|
|
Application Field 2 |
|
|
|
|

Application Field B:

Search I LCloze

Partsand  Thefollowing lists the document search criteria and their descriptions:
functions

Function Description

Document Name Searches for documents with the specified user-assigned
document name.

RefData Searchesfor documentswith the specified reference data
(assigned by the translation object designer).

Partner Searches for documents with the selected partner 1D
(identifies the partner for/from whom the document was
generated or received).
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Function Description

Document Type Searches for documents of the specified EDI type.

Example
810 identifies an invoice.

Application Field 1 | Searchesfor documents with the specified valuein
Application Field 1.

Application Field 2 | Searchesfor documents with the specified valuein
Application Field 2.

Application Field 3 | Searchesfor documents with the specified valuein
Application Field 3.

Application Field 4 | Searchesfor documents with the specified valuein
Application Field 4.

Application Field 5 | Searches for documents with the specified value in
Application Field 5.

Application Field 6 | Searches for documents with the specified value in
Application Field 6.
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Search Results Dialog Box

Parts and
functions

Il Search Results

Document(z] Found:

Using Documents

After you enter criteriaand click Search, the system displays the Search Results
dialog box as shown below:

2446 document(s] found

Document Data

Mame FefData Partrer Tvpe P
4 A PETZOME 997
5505555555 222222X222333333..  PETZONME a0
10000234500 PETZOME 850
4 A PETZ0OMNE 337
4 A PETZOME 997
4 A PETZOME 997
4 A PETZOME 997
4 A PETZOME 997
4 A PETZOMNE 337
4 A PETZOME 997
4 A PETZOME 997
4 A PETZOME 997
4 A PETZ0OME 997
4 A PETZOME 337
4 A PETZOME 337
4 A PETZOME 937 ~
3 ?

Interchange Data | LClose

[ Minimize results on view

The following lists the search results functions and their descriptions:

Function

Description

Document Data

Displays data for a document. To display data for the
document, select the document from the list and click
Document Data

Note:

You can also use this function by right-clicking the
document and selecting Document Data.

Interchange Data

Opensthe Interchange Browser and displaysinterchange
data for the document. To display for interchange data
for the document, select the document from the list and
either click Interchange Data.

Note:

You can also use this function by right-clicking the
document and selecting I nterchange Data.

Minimizeresultson
view

Minimizes the Search Results dialog box when viewing
data, tracking information, or an interchange. To
minimize results, select the check box.
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Function Description
Double-click Displays the tracking information for the document. To
display information, select an item and then double-
click.
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Filter Dialog Box

Introduction  The Filter function can be used when the Out Drawer is active to filter the display
of documents by status.

If you want to filter the display of documents in the Out Drawer by the document
status you can choose not to display documents with a certain status by selecting
the check box next to each status that you do not want displayed.

Note
When you clear acheck box, the display of that status is turned “off.” The default

isto display documents regardless of status.

Diagram  Thefollowing illustrates the Filter dialog box:

Filter DutDrawer Contents E

— Filter
v Sent
V¥ Feceived by Metwark

W wharming from Mebwark:

v Errar from Metwork

W Picked Up by Trading Partner
v Acknowledged with Mo Emors

v wiaiting for Acknowledgement

W Acknowledgements Dverdue
W Acknowledgements with Emrars
v Partially scknowledged

W Acknowledged but Fejected

¥ Send Failed
Cancel |

Partsand  Thefollowing liststhefilter criteria and their descriptions:

functions
Part Function
Sent Filters for documents that were successfully transmitted.
Received by Filters for documents that were successfully delivered to
Network aValue Added Network (VAN).
Warning from Filters for documents that were delivered to a VAN,
Network which detected non-critical errorsin the data
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Filter Dialog Box

Part

Function

Error from Network

Filters for documents that were delivered to a VAN,
which detected critical errorsin the data.

Picked up by
Trading Partner

Filters for documents that were successfully delivered to
atrading partner through a VAN.

Acknowledged with
No Errors

Filters for documents that were acknowledged by your
partner with no errors.

Waiting for
Acknowledgement

Filters for documents that are waiting to be reconciled
with an inbound functional acknowledgement.

Acknowledgements
Overdue

Filters for documents that are waiting to be reconciled
with an inbound functional acknowledgement but have
exceeded the number of hours by which the
acknowledgement is deemed late.

Acknowledgements

Filters for documents that were acknowledged by your

with Errors partner with errors. These documents were accepted by
your partner in spite of the errors.

Partially Filters for documents that were partially acknowledged.

Acknowledged
Note
If your partner is going to issue partial
acknowledgements at the interchange or group level,
they should also indicate acceptance or rejection at the
transaction level.

Acknowledged but | Filters for documents that were acknowledged by your

Rejected partner with errors. These documents were rejected by
your partner.

Send Failed Filters for documents for which the send transmission

failed.
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Creating and Editing

Documents

Creating Documents

I ntroduction

Procedure

To create a document using the Document Editor, the system must be set up to
support screen entry for the partner/transaction set combination you want to enter.

Note
The appropriate Screen Entry translation object must be registered and a
corresponding Outbound relationship must be set up for the partner.

References
For additional information, see the following:

» Registering New Translation Objectson page 2 - 7
» Creating an Outbound Relationship on page 3 - 66
» Sterling Gentran:Server Online Help (Document Editor)

To create adocument, compl ete the following steps:

Sep Action

1 From the appropriate area of The Desk, select Workspace.

System Response
The system displays the Workspace Browser.

2 Click New.

System response
The system displays the Create New Document dialog box.
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Sep Action

3 Select the appropriate partner/transaction set combination from the
list and click OK.

System response
The system displays the translation object for the selected
combination, as shown below:

7% Document Editor - ANSI %12 Invoice (810] - Pet Zone

File Edit Group Wiew ‘window Help

=TT = N A T B RRT )

ANSI X12 Invoice [810] - Pet Zone M= 3
Irvaice Ma. I:l Invaoice Date I:l :A Open
Lo
New:
Contract Ma. I:l Contract D ate I:l
el
Ship Ta | | Brov
| | e
| | Frame ?

Remit Ta | |

Payment Terms Code I - l

El
|For Help, press F1 LI i
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Sep Action

4 Type al the required data items into the boxes on the document
tranglation object.

Note
If the document contains alooping structure (lower-level detall

records such aslineitems), the input translation object contains alist,
as shown below:

7% Document Editor - ANSI %12 Invoice (810] - Pet Zone

File Edit Group Wiew ‘window Help
dl@] =2 @ (ox]«(»]|
ANSI X12 Invoice [810] - Pet Zone M= 3

Item  Praduct Gty Price Open
Line Items Siure
New
Del

Prew.

MNumber OF Line ltems I:l _I Next
Frame ?
Tatal Invoice Amount |:|

Jud

|For Help, press F1 LI i

5 To accessitemsin alist, highlight the first entry and click New.

System response
The system displays the list box, as shown below:

Line Items [ |O] x|
Item Mo I:l Product Code I:l Guantity I:l ; Open
. Store
Description | Del
[rate Shipped I:lTransport Methodlﬁ Carrier Eodel— Prev
Next
Frame ?
=l
6 Enter the data for the item.
Notes
» To enter asecond or subsequent item, click Next or press
ALT +T.
» After al loop items are entered, click Store to save and exit the
loop dialog box.

» If the document contains codes, press SHIFT + F1 from each
code field to access alist of the codes.
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Creating Documents

Sep

Action

If the document contains cal cul ated fields, select Recalculate from the
File menu before saving the document.

System response
The system updates the totals and checks the document for errors.

When you are finished entering data, select Save from the File menu.

System response

The system saves the information and automatically recal culates and
check for errors. If errors are found, you are prompted to view the
errors.

From the File menu, select Exit.

System response
You exit the Document Editor. The system prompts you to save the
document before closing.

Note
You can now open and edit this document from the Workspace
Browsser.
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Opening and Editing Documents

Introduction

Procedure

To edit a document using the Document Editor, you need to set up the system to
support screen entry for the partner/transaction set combination you want to edit.

Note
The appropriate Screen Entry translation object must be loaded and a
corresponding outbound relationship must be set up for the partner.

References
For additional information, see the following:

» Registering New Translation Objects on page 2 - 7
» Creating an Outbound Relationship on page 3 - 66
» Sterling Gentran:Server Online Help (Document Editor)

To open and edit a document, compl ete the following steps:

Sep Action

1 From the appropriate area of The Desk, select Workspace.

System Response
The system displays the Workspace Browser.

2 Select the desired document from the Workspace.

Note
Only documents in the Workspace can be edited.

» If the document has already been moved to the Out Documents
and has not been sent, you can move it back to the Workspace
using the UnPost function (see UnPosting Documents on page 4 -
57).

» If adocument has been sent, it cannot be modified. However,
you can move a copy of the document from the Out Drawer to
the Workspace, modify the copy, and send it (see Copying a
Document (to Reprocess and Resend) on page 4 - 55).
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Sep Action

3 Click Open.

System response

The system displays the document in the Document Editor facility, as
shown below:

7% Document Editor - ANSI %12 Invoice (810] - Pet Zone

File Edit Group Wiew ‘window Help

=TT = N A T B RRT )

ANSI X12 Invoice [810) - Pet Zone =] E3
Imvoice No. [0714653 Irvvoice Date [05/11/97 :‘ Open
L Store
F.O. Mo,  |PO18535 F.O. Date 0511/97
New,
Cantract Mo. 1203 Contract Date [11,/11/95 =
WE
Ship To  [MwT Ca. | Prov
4675 Lakshurst Tt | Next
| | Frame ?
[Dublin | [oH] [+3018 |
Remit To [PETZONE - Accounts Payable |
|1 Pet Zone Plaza |
[arevmiTy | [oH] [7777 | -
|Far Help, press F1 CAP |MLUM i

4 Modify the data as required.

Note

If the document contains alooping structure (lower-level detail
records such aslineitems), the input translation object contains alist,
as shown below:

7% Document Editor - ANSI %12 Invoice (810] - Pet Zone

File Edit Group Wiew ‘window Help

=TT = N A T B RRT )

ANSI X12 Invoice (810) - Pet Zone =] 3
Item  Product Gty Frice ||| Open
Line | Store
e iz 1 4532 10 993
2 7E5544 4 2250 New
3 11463 50 16.88 el
Breyv.
MNumber OF Line ltems Next
L] Frame ?
Total Invoice Amount [1033.9
|F0r Help, press F1 MLk i
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Sep

Action

» Toadd anew lineitem, highlight the first entry and click New.
» Toaccessitemsin thelist, highlight the entry to be changed and
click Open (or double-click the item).

System response
The system displays the list item detail s, as shown below:

Line Items =] 3

Item Ma. Product Code  |4532 Quantity 10 = Qpen
L] _.:I

Store
New:
Description |Large Dog Collar el
Date Shipped |05/11/97 Tranzport Methodl1 vl Carrier CUdElLIF'S Prev
Next

Frame ?

You can now change or enter the data for the item.

Notes
» To move through the entries, use Next and Prev.

» Toenter asecond or subsequent item, click Next or press
ALT +T.

» After al loop items are entered, click Store to save and exit the
loop dialog box.

» If the document contains codes, press SHIFT + F1 from each
code field to access alist of the codes.

If the document contains calcul ated fields, select Recalculate from the
File menu before saving the document.

System response
The system updates the totals and checks the document for errors.

When you are finished entering data, select Save from the File menu.

System response

The system saves the information and automatically recalculates and
checksfor errors. If errors are found, you are prompted to view the
errors.

From the File menu, select Exit.

System response
The system prompts you to save the document before closing.
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Managing Documents

Viewing Documents

View function

Using the View
function

Viewing a
Document from
the Document
Browsers

User Guide

The View function enables you to view various types of information, depending
on the format selected in the View Choice Dialog Box. The view typesinclude:

» Raw input data

» Externa data

» EDI-formatted data

» Trandator report

» Dataaudit

» Tracking information

Notes
» Theformatted view optionisonly activeif a Screen Entry translation object is
available in the Partner Relationship record.

» Theexterna data option isonly activeif the datafile used in trandation is
available.

» When viewing raw input or external data, you can switch from Text to Hex
format by selecting the appropriate command from the View menu.

The View function can be accessed using either of the following methods:

» A document browser is active and a single document is sel ected.

» Thelnterchanges or Restored Interchanges browser is active and asingle
document within an interchange is selected.

Reference
See Viewing Documents within Interchanges on page 7 - 14 for information about
the Interchanges browser.

To view a document from a document browser, compl ete the following steps:

Sep Action

1 From the appropriate area of The Desk, select one of the document
browsers.

System Response
The system displays the appropriate summary dialog box for that
browser.
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Sep Action

2 Select the type of document for the appropriate partner and click
View.

System Response
The system displays the browser containing those documents.

3 Select a single document from the appropriate browser.

4 Click View.

System Response
The system displays the View Choice Dialog Box.

5 Select an option to display the input data:
» Todisplay raw EDI data, select Gentran Data.
» Todisplay the datafile used in translation, select External Data.

Note
Thisoption isnot available if the external datafileused in
translation does not exist.

» Todisplay the datain the Document Editor using a screen entry
tranglation object, select For matted Document.

Note
This option is not available if no screen entry translation object
exists for the document.

» Todisplay areport of the actions the translator took on this
document and list any EDI- or trandglation object-based
compliance errors, select Translator Report.

Reference

See Error Messagesin the IBM® Serling Gentran: Server®
for Microsoft Windows Administration Guide for more
information about transl ator reports.

» Todisplay the document tracking information available for a
single document, select Data Audit.

Note
Thisfunction is not available if document level auditing is
disabled.

» Todisplay information that tracks an external datafile, select
Track Information.

6 Click OK to access the view that you specified.
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Viewinga  To view adocument from the Interchanges or Restored Interchanges browser,
Document from  complete the following steps:
the Interchange

Browser Sep Action
1 From the appropriate area of The Desk, select the I nterchanges
browser.
2 Select a single document.
3 Click the Data icon on the Toolbar.

System response

The system displays the raw EDI data view of the Interchange
(displayed in the Data View window on the Interchanges or Restored
Interchanges browser).

Note
When viewing raw input or external data, you can switch from Text
to Hex format by selecting the appropriate command from the View
menul.
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Viewing Currently Processing Documents

Processing  The Processing Browser displays any document that is currently being processed
browser  inthe Sterling Gentran:Server system. This browser enables you to ascertain
which documents are currently being processed by you or other usersin the
Sterling Gentran: Server system.

Note

Any document that is currently being processed in the Sterling Gentran: Server
system is displayed in the appropriate browser as unavailable, and you are not
permitted to access that document until processing is complete and the document
has been released to the system.

Reset function  The Processing Browser enables you to use the Reset function to return to their
previous location any documents that are displayed in the browser but for which
processing has terminated. Typically, you use this function for exception cases
when the processing of a document terminated improperly.

Procedure  To view the documents that are currently being processed, complete the following

steps:
Sep Action
1 From the View menu, select Processing.
System Response
The system displays the Processing Browser.
2 You can view the currently processing documents or perform the

function listed in this table.

Note

You can use the Reset function to return to their previous location
documentsthat are displayed in the Processing browser but for which
processing has terminated. Thisistypically done when the
processing of adocument terminated improperly.
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Finding Specific Text in a Document

Find function  Thisfunction enables you to find specified text in the active data-view window.

UsingtheFind  TheFind function is available when a data-view is the active window. The
function  following are the data-view windows.

Audit Log
Document Tracking
Interchange Tracking

Raw Data-View of an Interchange

Raw Data-View of a Document

External Data-View of an Interchange
External Data-View of a Document

Procedure  To find specific text, complete the following steps:

Step

Action

1 Access one of the following data-view windows.

Note

When viewing raw input or external data, you can switch from Text
to Hex format by selecting the appropriate command from the View

menul.

To display this

window... Do the following:

Audit Log Select Audit Log from the View menu.

Document 1. Select adocument in a browser.

Tracking 2. Select View from the Commands menu.
3. Click the Tracking information option.
4. Click OK.

Interchange 1. Select an interchange in the Interchanges browser.

Tracking 2. Select View from the Commands menu.
3.
4.

Click the Tracking information option.
Click OK.

User Guide
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Sep Action
1 Todisplay this
(contd) | window... Do thefollowing:
Raw DataView of |1- Select Interchanges from the appropriate area of
an Interchange the The Desk.
2. Sedlect an interchange from the Interchanges
browser.
Selecting | nterchanges from the View menu.
4. Selecting Data from the Interchanges cascading
menu.
Raw DataView of |1 Select adocument in the Interchanges browser.
a Document 2. Select View from the Commands menu.
3. Click OK onthe View Choice dialog box.
External Data 1. Select Interchanges from the appropriate area of
View of an the The Desk.
Interchange 2. Select aninterchange from the Interchanges
browser.
Select | nterchanges from the View menu.
4. Select External Data from the Interchanges
cascading menu.
External Data 1. Select adocument in the Interchanges browser.
View of a 2. Select View from the Commands menu.
Document 3. Select External Data and click OK on the View
Choice dialog box.
4 From the Edit menu, select Find.
System response
The system displays the Find dialog box.
5 In the Find what box, type the text you want to locate.
6 Do you want the system to search for case-sensitive text?
» If yes, select the Match Case check box and continue with step 7.
» If no, continue with step 7.
7 Click Find Next to find the first occurrence of the specified text.
Notes
» If the system locatesthat text, it is highlighted in the data-view
window.
» If the system does not find the specified text, the system beeps. If
thisisthe case, skip to step 7.
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Finding Specific Text in a Document

Sep Action
8 Continue clicking Find Next to find each subsequent occurrence of
that text.
9 Click Cancdl.

System response

The system returns to the data-view window.
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Searching for Documents

Introduction  The Document Search facility enables you to quickly and easily locate specific
documentsin the system. This facility returns the available tracking information
for each matching document.

Procedure  To search for documents, complete the following steps:

Sep Action

1 From the Commands menu, select Document Sear ch.

System response
The system displays the Document Search Dialog Box.

2 Enter the appropriate criteria.

3 Click Search.

System response
The system displays the tracking data for each document it locates
that matches the criteria you specified.

4 Double-click a document to display the associated tracking
information.
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Sorting Documents

Procedure  To sort documentsin any document browser or the Send Queue browser, click the
appropriate column heading to sort by that values in that column.
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Filtering Out Drawer Documents by Status

Introduction  When the Out Drawer Browser is active, you can use the Filter function to filter
the display of documents by status.

Sorting with Out  To filter the document display in the Out Drawer browser, complete the following

Drawer browser  steps:

Sep

Action

1

From the appropriate area of The Desk, select the Out Drawer.

System response
The system displays the Out Drawer Summary diaog box.

Select the type of document for the appropriate partner and click
View.

System response
The system displays the Out Drawer Browser.

Click Filter.

System response
The system displays the Filter Dialog Box.

If you want to filter the display of documentsin the Out Drawer by
the document status, you can choose not to display documents with a
certain status by selecting the check box next to each status that you
do not want displayed.

Note
When you clear a check box, the display of that statusis turned off.
The default isto display documents regardless of status.

Click OK.

System response
The contents of the Out Drawer browser are filtered as specified.
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Deleting Documents

Introduction

Procedure

User Guide

Deleting Documents

The Delete function is used to remove a document or group of documents from

the system.

Notes

» When adocument is deleted, all the associated document information,
tracking information, and trand ation report information is also deleted. When
the last document in an interchange is deleted, the interchange entry is also
deleted.

» Documentsin the Send Queue can only be deleted from the Interchanges
Browser.

To delete adocument or group of documents, compl ete the following steps:

Step

Action

1

From the appropriate area of The Desk, select the current location of
the document by selecting the location.

System response
If you select one of the document browsers, the system displays the
appropriate summary dialog box for that browser.

If the system displays a summary dialog box, select the type of
document for the appropriate partner and click View.

System response
Access the browser containing those documents.

Click Delete.

System response
The system displays a confirmation dial og box.

Click Yes.

System response
The document is deleted.
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Introduction  If no documents are selected, the Print function prints a summary list of all
documentsin the browser. For selected documents, the Print function prints one of
the following:

» Raw EDI data

» Formatted version of the documents using the print translation object
established (partner relationship)

» Summary list of those documents

Procedure  To print adocument or group of documents, complete the following steps:

Sep

Action

1

From the appropriate area of The Desk, select the current location of
the document by selecting the location.

System response
If you select one of the document browsers, the system displays the
appropriate summary dialog box for that browser.

Select the type of document for the appropriate partner and click
View.

System response
The system displays the browser containing those documents.

Do you want to print asummary list of al documents?

» If yes, click Print to access the Print dialog box. Continue with
step 6.

» If no, continue with step 4.

Do you want to print selected documents (either formatted or not) or
asummary list of selected documents?

» If yes, select adocument or group of documents and click Print
and continue with step 5.

System response
The system displays the Print Choice Dialog Box.

» If no, continue with step 6.
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Printing Documents

Sep Action
5 On the Print Choice Dialog Box, select one of the following options
and click OK:

» To print selected unformatted documents, select the Selected
Items option.

» If you want the selected documents printed as formatted (a print
tranglation object must exist for the documents to be printed as
formatted), select the Selected Items option and the For matted
check box.

» If you are printing from the In Documents Browser or ?In
Documents Browser, you can either move the document to the
In Drawer Browser or leave the document in place.

» Toprintasummary list of selected documents, select the
Summary List of Items option.

System response

The system displays the Print dialog box.

6 On the Print dialog box, set the appropriate options and click OK.

Note

The system displays the Print dialog box if you either selected no
documents from the browser and clicked Print, or if you chose
Summary List of Items from the Print Choice dialog box.
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Moving Documentsto the In Drawer

Using Documents

Introduction  Thisfunction moves a selected document or group of documentsto the In Drawer
Browser. Documents are automatically moved from the In Documents Browser or
?In Documents Browser to the In Drawer Browser by the system at the
completion of a successful export or print. However, you might want to manually
move a document to the In Drawer Browser so that you could create a turnaround

(response) document.

Procedure  To move adocument or group of documents, complete the following steps:

Sep Action

1 From the appropriate area of The Desk, select the In Documents
Browser or ?In Documents Browser.
System response
The system displays the appropriate summary dialog box for that
browser.

2 Select the type of document for the appropriate partner and click
View.
System response
The system displays the browser containing those documents.

3 Select the documents that you want to move to the In Drawer
Browser and click Move.
System response
The selected documents are moved to the In Drawer Browser.
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Copying a Document (to Reprocess and Resend)

Introduction

Procedure

User Guide

The Copy function copies a document (that was already sent successfully) to the
Workspace Browser so you can modify the document and resend it. The Copy
function can only be used when Out Drawer is active.

Note
This function can result in sending duplicate documents to atrading partner.

Reference
After you modify the documents, you may want to resend them. See Resending
Documents on page 5 - 9 for more information.

To copy adocument or group of documents, complete the following steps:

Sep Action

1 From the appropriate area of The Desk, select the Out Drawer.

System response
The system displays the Out Drawer Summary dialog box.

2 Select the type of document for the appropriate partner and click
View.

System response
The system displays the Out Drawer Browser.

3 Select the documents that you want to copy to the Workspace
Browser and click Copy.

System response
The selected documents are copied to the Workspace Browser.
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Introduction  The Post function moves a selected compliant document or group of compliant
documents to the Out Documents Browser. A document is compliant if it
conforms to the validation rules as defined by the translation object. A document
is designated compliant if the Status column contains OK. If the Status column
contains NotOk, the document is not compliant and is not posted.

Note

The Post function can only be used when the Workspace is active.

Procedure  To post adocument or group of documents, complete the following steps:

Sep

Action

1

From the appropriate area of The Desk, select the Workspace.

System response
The system displays the Workspace Browser.

Select the compliant documents that you want to move to the Out
Documents Browser.

Note

A document is designated compliant if the Status column contains
OK. If the Status column contains NotOKk, the document is not
compliant and is not posted.

Click Post.

System response
The selected documents are moved to the Out Documents Browsers.
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UnPosting Documents

Introduction  The UnPost function moves a selected document or group of documents to the
Workspace Browser. You can use UnPost to prevent a document from being sent
to atrading partner or to allow the document to be modified beforeit is sent. The
UnPost function can only be used when the Out Documents Browser isthe active
browser.

Note
If you modify the document, you must repost it before the system sendsit.

Procedure  To UnPost adocument or group of documents, complete the following steps:

Sep Action

1 From the appropriate area of The Desk, select the Out Documents.

System response
The system displays the Out Documents Summary dialog box.

2 Select the type of document for the appropriate partner and click
View.

System response
The system displays the Out Documents Browser.

3 Select the documents that you want to move back to the Workspace
Browser and click UnPost.

System response
The selected documents are moved back to the Workspace Browser.
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Responding to Documents

Introduction  The Respond function automatically generates a response document by
transferring data from an inbound source document. The Respond function isonly
available when al of the following are true:

» Theln Drawer isthe currently selected browser.
» Oneor more documents are selected.
» Turn Around trandation objects exist for the selected documents.

Turnaround  The Respond function creates a turnaround document (using the Turn Around
documents  trandation object from the Partner relationship — see Selecting an inbound
translation object on page 3 - 62 for instructions) in response to the currently
selected documents. You can create a turnaround document for non-compliant
documents (documents with a NotOK status), as well as for compliant documents.

Modifying  The documents generated by the turnaround process are placed in the Workspace,
documents  where you can modify them prior to sending.

Note
To modify a document, a Screen Entry translation object must be set up in the
outbound relationship for the created document.

Reference
See Creating an Outbound Relationship on page 3 - 66 for instructions on setting
up an appropriate screen entry translation object.

Procedure  To respond to one or more documents, complete the following steps:

Sep Action

1 From the appropriate area of The Desk, select In Drawer.

System response
The system displays the In Drawer Summary dialog box.

2 Select the type of document for the appropriate partner and click
View.

System response
The system displays the In Drawer Browser.
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Responding to Documents

Sep

Action

Select the document or documents for which you want to create a
turnaround (response) document and click Respond.

System response

» The system automatically creates a turnaround document in
response to each document you selected by using the Turn
Around translation object that you specified in the Partner
relationship.

» Theturnaround documentsthat are produced are displayed in the
Workspace for you to modify, if necessary, before posting to the
Out Documents Browser.

Reference
See Posting Documents on page 4 - 56 for instructions.
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| mporting Documents

Introduction  Sterling Gentran:Server allows you to import data from datafiles as an aternative
to using the Document Editor to enter data directly into the system. To import a
document, you must have a system import and/or import translation object for the
transaction set that isimported, registered with the system.

Reference
See Registering New Tranglation Objects on page 2 - 7 for more information.

Additional  For each type of import file, you need to define an import specification on the
configuration  Import tab in the System Configuration program that indicates which import or
task  Systemimport translation object is used to begin trandation during the import
process.

You need to see your system administrator about adding the UNC file path or file
name to the System Configuration program if either of the following are true
(because the system may be unable to import the file):

» Youseect afilefromaUNC file path and alocal driveis specified for
imports of that file type in the System Configuration program.

» Youseectafilefromalocal drive and a UNC filename is specified for
imports of that type in the System Configuration program.

Reference

See How to Edit an Import Specification in the IBM® Serling Gentran: Server®
for Microsoft Windows Administration Guide for more information about adding
import specifications.

Procedure  Toimport adocument, complete the following steps:

Sep Action

1 From the appropriate area of The Desk, select the Workspace.

System response
The system displays the Workspace Browser.

2 Click Import.

System response
The system displays the Application Files to Import dialog box.
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Importing Documents

Sep

Action

Select the file or filesto beimported and click Open.

System response
The system imports the documents into the Workspace Browser.

The documents either have an OK status (the documents were
successfully read and compliance checked) or aNotOK status (the
documents failed compliance checking).

Note

You may not send hon-compliant documents—either delete those
documents and reprocess them from the datafile, or correct the
documents in the Document Editor (if you have Screen Entry
tranglation objects for them).

Reference
See Opening and Editing Documents on page 4 - 38 for more
information about correcting the documents in the Document Editor.

I mportant
If youimport afile and no documents are displayed in the Workspace
Browser, check the Audit Log.
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Exporting Documents

Introduction

Procedure

To export adocument to adatafile, an export translation object for the transaction
set must be:

» Loaded into the system and registered
» Set up asthe Export trandation object in the inbound relationship record for
the partner

Notes

» After performing an export command, any subseguent exports to the same
export file increases the size of the file by appending the new external datato
thisfile.

» If you set up the Export to Mailbox command on the Inbound Translation
Objects dialog box, the document is exported to the mailbox you specify.

References
For additional information, see the following:

» Registering New Translation Objectson page 2 - 7
» Outbound Translation Object Dialog Box on page 3 - 40

» Inbound Trandlation Object Dialog Box on page 3 - 15 (setting up the Export
to Mailbox function)

To export a document, complete the following steps:

Sep Action

1 From the appropriate area of The Desk, select the In Documents
Browser, 2ln Documents Browser, or In Drawer Browser.

System response
The system displays the appropriate summary dialog box for the
selected browser.

2 Select the type of document for the appropriate partner and click
View.

System response
The system displays the appropriate document browser.

3 Select the document or documents that are to be exported, and click
Export.

System response
The system displays the Select Export Method Dialog Box.
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Exporting Documents

Sep

Action

Select one of the following options and click OK:

» Toconvert all selected documents to data and write them to a
singlefile, select the Export to Single File option.

System response
The system displays the Choose File to Export Document Dialog
Box.

» To write selected documents to the files set up in the partner
inbound relationship, select the Export to Default Files option.

» To rename selected documents, select the Select File by
Document option.

System response
The system displays the Choose File to Export Document Dialog
Box.
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Overview

Inthischapter  This chapter explains how to use communications with Sterling Gentran: Server.

Communications  The Communications feature enables you to send and receive data from your
feature trading partners. Sterling Gentran:Server uses the Communicator to handle your
communication needs.

Send process  Thefollowing describes the system process that occurs when you send an
interchange:

Sage Description

1 The documents in the selected interchange are batched into EDI
envel opes and the required information (including control numbers)
is generated from the information in the partner profile.

2 After the interchangeis built, it islisted in the Interchange browser.

Reference
See Viewing Interchanges on page 7 - 10 for more information.

3 Communication is established with the remote end. The status of the
message is updated based on the success or failure of the
communications session.

» If the communication fails because there is no mailbox set up or
the Mailbox serviceis not started, the interchange and
documents are left in a Ready to send status.

» |f communication fails because there is no modem, the
interchange and documents are left in a Queued status.

Note
No user action is required at this point. Interchanges that failed to
send are automatically sent as part of the next transmission session.

4 After asuccessful communications session, the documents are
moved to the Out Drawer and the interchange statusis set to Sent.
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Send Queue Browser

Introduction  The Send Queue browser contains alist of documents that are currently queued
for the system to send.

Note

To delete adocument that isin the Send Queue, you must open the Interchanges
Browser and delete the document from there.

Diagram  Thefollowing illustrates the Send Queue browser:

i Queue - 3 M= B
nt T | Wiew. .. I
FPETZONMEZ INVOIC 2112222 [ueued 222212
FETZONEZ INVOIC 2113114 (ueued 955

Refresh

Cloze
3 Documents 1 zelected 1

rrrra Help

Partsand  Thefollowing lists the parts of the Send Queue browser and their functions:

functions

Part

Function

View

Accesses the View Choice Dialog Box, which allows you
view the selected document.

Print

Accesses the Print Choice Dialog Box, which allows you
to print the selected document.

Refresh

Refreshes the display of the browser.

Close

Closes the browser.

Help

Displays Online Help.

User Guide
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Communications Session Dialog Box

Introduction  The Communications Session dialog box enables you to select mailboxes and
initiate a communications session to send and receive data.

Diagram  Thefollowing illustrates the Communications Session dialog box:

Communication Session E3

Select the mailbox pou wish to communicate with:
[ IGEMTRAM Application

CIGENTRAN Tutarial ' '
Cancel |

Partsand  Thefollowing lists the parts of the Communications Session dialog box and their
functions  functions:

Part Function

Select the Displays the list of Sterling Gentran:Server mailboxes.
mailbox you wish
to communicate

with

OK Exits the dialog box; starts a communication session for
the selected mailbox or mailboxes.

Cancel Cancels the function; exits the dialog box.
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Process File Dialog Box

Introduction  The Process File feature allows you to invoke the post-communications process
with any EDI file, asif the file was received via a communications session.
Diagram  Thefollowing illustrates the Process File dialog box:
Look i I 3 Tutorial j ﬁl
Pet_eard.tpl Peteiris. stp Pettirz. stp Pettst]. ink
Pet_tinee.map Peteiris. tpl Piettitres.tpl Pettatt2.int
Pet_tir.tpl Peteardp.stp Pettordp.stp Petzone. p.
% Pet_tiree. tut Peteardp. tpl Pettordp.tpl Petzonel |
Pet_tord. map Pettast. int Pettztel.int PetzongZ.|
Pet_tord.tpl Pettest.int Pettste int Petzoned.|
[« | 1
File name: |F'ettest.int
Files of type: |AII Filez [*.7) j Cancel |
Partsand  Thefollowing lists the parts of the Process File dialog box and their functions:
functions
Part Function
Look in Select the folder where the system should look for thefile.
Displays the current.
File name Specify the name of the export file.
Files of type Select the type of file.
Open Executes the selected function; exits the dialog box.
Cancel Exits the dialog box.
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Procedure  To send a selected document or set of documents, complete the following steps:

Step

Action

1

From the appropriate area of The Desk, select Out Documents.

System response
The system displays the Out Documents Summary dialog box.

Note

If the documents to be sent are not in the Out Documents Browser,
you must post the documents from the Workspace Browser to the Out
Documents Browser.

Reference
See Posting Documents on page 4 - 56 for more information.

Select the type of document for the appropriate partner and click
View.

System response
The system displays the Out Documents Browser.

Select the document or documents that need to be sent.

Note

To select agroup of documents click the first document, press
SHIFT, and click the last document. To select severa documents that
are not adjacent to each other in the Out Documentsllist, press CTRL
and click the documents.

Click Send.

System response
The system displays the Sterling Gentran: Server for Microsoft
Windows dialog box.

Click Yesto start the transmission session.
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Sending All Documents

Introduction  You can send all documentsin the Out Documents by two different methods:
Select the Transmit icon on The Desk.
Access the Out Drawer browser and click Send.

Procedure:  To send all documents, complete the following steps:

Method 1

Step

Action

1

From the appropriate area of The Desk, select Transmit.

System response
The system displays the Sterling Gentran: Server for Microsoft
Windows dialog box.

Click Yes to start the transmission session.

System response
The system displays the Communications Session Dialog Box.

»  Select one or more mailboxes for which you want to send data.

» Click OK to start acommunication session to send data (click
Cancel if you want to cancel the transmission session).

Note

This action sends all documents currently located in the Out
Documents for which the partner is using one of the selected
mailboxes.

If there are no documents in the Out Documents or interchanges with
a Ready status in the Interchanges browser, areceive-only session is
performed and, as aresult, the In Documents and ?In Documents are
updated with any data received.

User Guide
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Procedure:  To send all documents, complete the following steps:

Method 2

Step

Action

1

From the appropriate area of The Desk, select Out Documents.

System response
The system displays the Out Documents Summary dialog box.

Note
If the documents to be sent are not in the Out Documents, you must
post the documents from the Workspace to the Out Documents.

Reference
See Posting Documents on page 4 - 56 for more information.

Select the type of document for the appropriate partner and click
View.

System response
The system displays the Out Documents Browser.

Do not select any documents. If any documents are selected, press
CTRL and click the primary mouse button to deselect them.

Click Send.

System response
The system displays the Sterling Gentran: Server for Microsoft
Windows dialog box.

Click Yes to start the transmission session.

Note
All the documents in the Out Documents are sent to the appropriate
mailboxes.
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Resending Documents

Introduction  After adocument is successfully enveloped and sent, it is stored in the Out
Drawer. If you need to resend the document, you must make a copy of the
document and execute the Send process again using the copy.

Procedure  To resend a document, complete the following steps:

Sep

Action

1

From the appropriate area of The Desk, select Out Drawer.

System response
The system displays the Out Drawer Summary dialog box.

Select the type of document for the appropriate partner and click
View.

System response
The system displays the Out Drawer Browser.

Select the document or documents that need to be resent.

Note

To select agroup of documents click the first document, press
SHIFT, and click the last document. To select severa documents that
are not adjacent to each other in the Out Drawer list, pressCTRL and
click the documents.

Click Copy to make a copy of the document and place the copy in the
Workspace.

From the appropriate area of The Desk, select Workspace.

System response
The system displays the Workspace Browser.

Make any necessary changes to the documents.

Note
You can modify adocument only if thereisa Screen Entry trandation
object for the partner relationship.

Select the documents and click Post.

System response
The documents are posted to the Out Documents Browser.

User Guide
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Sep Action

8 From the appropriate area of The Desk, select Out Documents.

System response
The system displays the Out Documents Summary dialog box.

9 Select the type of document for the appropriate partner and click
View.

System response
The system displays the Out Documents Browser.

10 Select the documents and click Send.

System response
The system displays the Sterling Gentran: Server for Microsoft
Windows dialog box.

11 Click Yes to start the transmission session.
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Receiving Documents

Introduction  Any time a Send session is executed, the system automatically checks your
Mailbox for any information waiting to be received by your system. If any datais
in the Mailbox, it is received without any action from you.

If you need to receive information without first sending anything, you must
initiate areceive-only session using one of two methods:

» From the Commands menu, select the Receive command.

» Accessthe In Documents browser and click Receive.

Procedure:  To start areceive-only session, complete the following steps:
method 1

Sep Action

1 From the Commands menu, select Receive.

System response
The system displays the Communi cations Session Dialog Box.

2 Click OK to start a communication session to send data.

Note

The system initiates areceive-only session and the In Documents
Browser and ?In Documents Browser are updated with any data
received.

Procedure:  To start areceive-only session, complete the following steps:
method 2

Sep Action

1 From the View menu, select | n Documents.

System response
The system displays the In Documents Summary dialog box.

2 Select the type of document for the appropriate partner and click
View.

System response
The system displays the In Documents Browser.

3 Click Receive.

System response
The system displays the Communications Session Dialog Box.

User Guide Sterling Gentran: Server — May 2011



Receiving Documents Using Communications

Sep Action

4 » Select one or more mailboxes for which you want to send data.
» Click OK to start acommunication session to send data.

Note

This action initiates a communications session and updates the In
Documents Browser and ?1n Documents Browser with any data
received as aresult of that session.
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Viewing the Send Queue

Introduction  The Send Queue browser displays alist of the documents that are currently
gueued to be sent and enables you to perform document-based tasks similar to
those available in the main system browsers.

Note

The Send Queue contains documents only if atransmission session failed. The
documents remain in the Send Queue until a successful transmission session
OCCUrs; no user intervention is required.

Procedure  To view the Send Queue, complete the following steps:

Sep Action

1 From the View menu, select Send Queue.

System response
The system displays the Send Queue Browser.

2 Select a document or documents.

3 » Click View to view the contents of any of the following:
— Selected document (raw EDI data)

— Formatted document
— Trandation report

Reference
See Viewing Documents on page 4 - 41 for more information.

» Click Print to print the selected documents or summary of the
documents.

Reference
See Printing Documents on page 4 - 52 for more information.
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Processing Data Files

Introduction  The Process File feature invokes the post-communications process with any data
file, asif the file was received via a communications session. This enables you to
process a data file from adisk or anywhere on your system.

Procedure  To send adatafile to the Communicator, complete the following steps:

Step

Action

1

From the Commands menu, select Process File.

System response
The system displays the Pracess File Dialog Box.

Select the desired data file and click Open.

System response
The system immediately invokes the post-communications process
with thefile, asif the file was received via a communication session.
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Overview

In thischapter

External data

External data
viewer

Using External Data

This chapter explains how to use external data with Sterling Gentran:Server.

References

See the following for more information:

» Restoring Archived Data on page 10 - 44
» Interchanges Browser on page7 - 3

Sterling Gentran: Server can track the relationship between an EDI document or
interchange and the corresponding external (application) data. For import
processing, the system makes a persistent copy of the external data at the start of
processing. For inbound (process file and export) processing, the system again
copies the external datafilefor persistent storage. Sterling Gentran: Server also
enables you to archive external data.

You can specify which external data (processfile, import, and export) is copied to
the External Data folder in the System Configuration subsystem.

Note

If you do not specify that the system should copy external datafor at least one of
the export, import, or process file functions, the option to view external datais not
available.

Reference
For more information, see the following:

» Importing Documents on page 4 - 60

» Exporting Documents on page 4 - 62

» Using Tracking on page9- 1

» Using Archive and Restore on page 10 - 1

» System Configuration—External Data Tab in the IBM® Serling
Gentran: Server® for Microsoft Windows Administration Guide

The External Data viewer enables you to do the following:

» Viewalist of al external datafiles associated with documents or interchanges
that were sent or received.

» Filter the display of external data.

» View externa data, correlated EDI data, and the related trandlator report (if
they are available).

Note
When viewing EDI or external data, you can switch from Text to Hex format
by selecting the appropriate command from the View menu.
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External Data Summary Viewer

Introduction  The External Data Summary Viewer enables you to view alist of all externa data
files associated with documents or interchanges that were sent or received. The
Externa Data Summary Viewer can always be accessed.

Information  Theinformation displayed in the External Data Summary Viewer isorganizedin a
organization  hierarchical manner, as shown below:

Level How to access Information displayed
External data | Open External Data » Filepath and name
file Summary Viewer. » Dateandtimethefilewas
(numbered) created

Documentor | Double-click anexternal | » Document or interchange
Interchange | datafile. control number

» Associated partner

» Document type

» Acknowledgement status

» Document name

» Reference data

» Dateand timethe document was
created

Note

If any of these components are
missing or not appropriate for a
particular group, they are not

displayed.

External Data  You can perform the following functions on the Externa Data Summary Viewer:

Summary ,  Filter the display of external data by date/time and action from the External
functions Data Filter dialog box.

» Display the external data, raw-EDI data, and trandator report data for the
selected external datafile in the appropriate browser panes.

» Print aselected item.
» Dedetethe external datafile from the External Datafolder.
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Diagram  Thefollowing illustrates the External Data Summary Viewer with external data,
EDI data, and translator report options turned on:

2 External Data Summary - 7 =]
IAII Actions IDatex’Time Checking iz OFff.

w| 1 EAGEMSRWNTATutorialhPet_S10.kt 01/25/00 01:16:51 PM HDROETTEST X002030810 P |a
w| 2 EAGENSRYMTSTutoralPettestint 01/25/00 01:17:31 PM PEF22111111IARRRRRSSSS555555]

=38 SHIPTO

£ 000000004 PETZONE Received NotRequied 01/25/00 01173 [ Soosssssssssesnsis 15 15 -

E[7 3 OUTTI0BINT  01/25/00 01:19:40 PM
‘-l 000000001 PETZOME Sent Mot Required 01/25/0001:13:38 PM il_l

it

Ea 4 EAGEMSEWYMTATutorialhPet_810kt 0142500 02:09:00 P BIG*350510*5555555555%95051 24 a
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w| 7 ENGEMSRYNTATutorial\Pettestint 02/04/00 05:23:59 P 5 -

. i . ¥port Document Summary

E Q00000004 PETZOME Receiwed Mot Required 02/04/00 05:24:0 j
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Partsand  Thefollowing lists the parts of the External Data Summary Viewer and their
functions  functions:

Part Function
Status bar Displays the filer specifications from the External Data
Filter Dialog Box.
left pane— Displaysalist of al external datafilesand (if available) an
external tree associated EDI document or interchange that was sent or
received.
Reference

See the following for more information:

» Information organization on page 6 - 3
» lconsonpage6-5

upper right pane— | Displays the datafile used in trandation (if this option is

External Data selected from the View\External Data menu).
middle right Displays the associated document in EDI format (if this
pane—Gentran option is selected from the View\External Data menu).
Data

Note

This option is not available if the document used in
tranglation does not exist.
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Part Function

(lower right pane— | Displays areport of the external actions the translator took
Export Document | on this document and lists any EDI- or translation object-
Summary based compliance errors (if this option is selected from the
Translator Report | \/jew\External Data menu).

Reference

See Error Messagesin the IBM® Serling

Gentran: Server® for Microsoft Windows Administration
Guide for more information.

Icons  Thefollowing lists the icons that the system uses on the External Data Summary

Viewer:
Icon Description

Indicates a process file or mailbox process file system activity.

ED Indicates a send system activity.

Indicates an import or mailbox import system activity.
Indicates an export system activity.

port sy y

o Indicates an interchange related to the external datafile.

B Indicates a document related to the external datafile.
Note
If thisiconisred, it indicates that the document contains errors.
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External Data Filter Dialog Box

Introduction  The External Data Filter dialog box allows you to filter the display of external
datafiles by date and system action (process file, mailbox processfile, import,
mailbox import, send, and export).

Toaccess When the External Data Browser is active, select Filter from the Commands
menu. Or, from the Options menu, select Preferences and click on the External
Data Filter tab.

Diagram  Thefollowing illustrates the External Data Filter dialog box:

External Data Filter il

External Data Filter |

—Date
—From

I 51142004 VI
an- =]
I 8:00:00 A0 =

I 942342005 VI
Ea =7
I 1EBZEPM =

v Always Current

— 1o

[ END Date/Time Checking: Unselect All Actions |

Partsand  Thefollowing lists the parts of the External Data Filter dialog box and their
functions  functions:

Part Function

Date From Select the beginning date and time of a date/time range,
from which the system filters the display of externa data
files.

Note
The Date From box is only active if the No Date/Time
Checking check box is not selected.
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External Data Filter Dialog Box

Part

Function

Date To

Select the end date and time of a date/time range, to which
the system filters the display of external datafiles.

Note

The Date To box is not activeif either the No Date/Time
Checking check box is selected or the Always Current
check box is selected.

Always Current

Indicate that the end date for the date range is always the
current system date and time.

Note
The Always Current check box is only activeif the No
Date/Time Checking check box is not selected.

No Date/Time Indicate if the system filtersthe display of external data

Checking files by date and time (if selected).

Action Contains alist of all the actions the system can perform
using external datafiles. Thislist alowsyou to filter the
display of external datafiles by the actions you specify.
Note
The default display is all actions, but you can clear them.

Unselect All Clearsall the actions.

Actions
Note
Thisalowsyou to filter the display of external datafiles
by the actions you specify.

Warning
At least one action must be selected.

OK Exits the dialog box; saves the selections.

Cancel Exits the dialog box without saving selections.

Help Opens the online help.
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Viewing External Data Files

Procedure

Using External Data

To view external datafiles, complete the following steps:

Step

Action

1

From the View menu, select External Data\Browser.

System response

The system displays the External Data Summary Viewer.

Do you want to filter the display of external data files by action or

date?

» If yes, seeFiltering External Data Files on page 6 - 9.
» If no, continue with step 3.

Select an external datafile.

Use the following table to determine your next step:

To view the external data
for asingle selected file,

Select View > External Data > Related
External Data.

Note

When viewing raw-EDI or external data,
you can switch from Text to Hex format
by selecting the appropriate command
from the View menu.

To view the related EDI
data,

Select View > External Data> Gentran
Data.

Note

When viewing raw-EDI or external data,
you can switch from Text to Hex format
by selecting the appropriate command
from the View menu.

To view the trand ator
report for actionstaken on
the external datafile,

Select View > External Data >
Trandator Report.

To delete the external data
file from the Externa
Datafolder,

1. Select the appropriate file in the left pane

2. Select View > Delete.

of the viewer.

To print the external data
file, EDI data, or
tranglator report,

1. Select the appropriate right pane of the

2. Select File> Print.

viewer.
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Filtering External Data Files

Introduction

Procedure

User Guide

When the External Data Summary viewer isactive, the Filter function enablesyou
to filter the display of external datafiles by date and action.

To sort external datafiles by date and/or action, complete the following steps:

Step

Action

1

From the View menu, select External Data\Browser.

System response
The system displays the External Data Summary Viewer.

From the Commands menu, select Filter.

System response
The system displays the External Data Filter Dialog Box.

Do you want the system to filter the display of external datafiles by
date and time?

If yes, clear the No Date/Time Checking check box and proceed
with step 4.

If no, select the No Date/Time Checking check box and proceed
with step 6.

Use the Date From dlide bar to select the beginning date of a date
range, from which the system filters the display of external datafiles.

Do you want the end date for the date range to always be the current
system date and time?

If yes, select the Always Current check box.

If no, clear the Always Current check box and move the Date to
dlide bar to the date and time you want to use.

Do you want to filter the display of external datafiles by action?

If yes, from the Action list, select the actions that you want
displayed.

Note

The default display isall actions, but you can click actionsto
clear them and change the display. Alternately, you can click
Unselect All Actionsto clear all actions, so you can then click
the one or more actions to select them. At least one action must
be selected.

If no, continue with step 7.
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Step

Action

Click OK.

System response

The system filters the display of the external datafiles using the

criteriayou specified.
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Overview

Inthischapter  This chapter explains how to use interchanges with Sterling Gentran: Server.

Reference
See Restoring Archived Data on page 10 - 44 for more information about the
Restored Interchanges browser.

Interchanges  The Interchanges browser enables you to do any of the following:

browser , view ahierarchical list of al the interchanges, group, and documents that
were sent or received.

» View statusinformation for the interchanges (such as whether or not a
functional acknowledgement was received and the status of that
acknowledgement).

» Filter the display of interchanges.
» Accessthe documents within the interchanges.

» View externa data, EDI data, and the related translator report (if they are
available).

Note
When viewing EDI data, you can switch from Text to Hex format by selecting
the appropriate command from the View menu.
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| nter changes Browser

Introduction  The Interchanges browser enables you to view alist of all the interchanges,
groups, and documents that were sent or received. The Interchanges browser can
always be accessed. This browser contains status information about the
interchanges (such as whether or not a functional acknowledgement was received
and the status of that acknowledgement).

Information  Theinformation about the Interchanges browser is organized in a hierarchical
organization  manner. The following table describes the hierarchical organization of the
information about the Interchanges browser:

Information displayed

Level How to access (in middle pane
Interchange | Open Interchanges » Direction of the interchange
browser.

» Date and time the interchange
was created

» Partner name

» Control number

» Interchange process status
» Network status

» Interchange acknowledgement
status

» Message status
Note
If any of these components are

missing or not appropriate for a
particular interchange, they are not

displayed.
Group Double-click an » Group control number
interchange. »  Group type

» Group acknowledgement status

Note

If any of these components are
missing or not appropriate for a
particular group, they are not

displayed.
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Information displayed
Level How to access (in middle pane

Document Double-click agroup. » Document compliant status

» Document control number

» Document type

» Document name

» Reference data

» Document compliant status

» Transaction acknowledgement
status

Note

If any of these components are
missing or not appropriate for a
particular document, they are not

displayed.
document Double-click a Document data
data document.

Note

A screen entry translation object for
that document must available on
your system.

Browser  You can perform the following functions on the Interchanges browser:

functions

Filter the display of interchanges by date, partner, and direction (inbound and
outbound) from the Interchanges Filter dialog box.

Display the external data, raw-EDI data, and translator report data for the
selected interchange or document in the appropriate browser panes.

Note
When viewing raw-EDI or external data, you can switch from Text to Hex
format by selecting the appropriate command from the View menu.

Toggle the status of interchanges between Ready to Send and Hold.
Manually change the status of groups to Acknowledged.
Print or delete a selected item.

Note
You might want to use the toggle function if you do not want to send an
interchange right away.
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Diagram

Interchanges Browser

The following illustrates the I nterchanges browser with external data, EDI data,

and tranglator report options turned on:

& Interchanges Summary - 2

== I.-’-'«II Farthers IDate.-"Time Checking iz Off.

=] E3

EH:I Root Cantrol Humber | Type | Doz, Mame | Refers [IDEPETTEST X003030510 P -
o =054 0/2002 0%:33 Al @ oo 10 FEEREERE55 sooas [BEGIE1111111000000555555555535
; EIG 1-PETZOME 555555555555950515 15 15 300
| ..[8 0001-PETZ | 5 K
= 051142002 1220t EIG*950510%5555555555%950512%2 4
EG IéPETZONE i FEF*EM*555555555555~ -
.. n004-PETZ - _’|—|
Document SUumnary ﬂ
Trading Partrner: FETZONE
<| | sl i3 | KN ﬁ
Partsand  Thefollowing lists the parts of the Interchanges browser and their functions.
functions
Part Function
Status bar Reflects the filer specifications from the Interchange Filter
Dialog Box.
Note
The Electronic Commerce Manager status bar is updated
when you select asingle item from the middle pane.
left pane— Displaysalist of al the interchanges, groups, and
Interchangestree | documents that were sent or received. Also displaysthe
time created and partner name.
Note
To refresh the display of the Interchanges browser,
press F5.
Reference
See the following for more information:
» Information organization on page 7 - 3
» Document level statusiconson page7 -7
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Part Function

middle pane— Displays a detailed list of the selected interchange, group,
detailed list or document. The information displayed depends on the
level.

Notes

» Toselect multipleitems, pressand hold the CTRL key
while selecting the items.

» Torefreshthedisplay of the Interchanges browser,
right-click the middle pane and select Refresh from the
shortcut menu (or press F5).

upper right pane— | Displays the datafile used in trandation (if this option is
External Data selected from the View\I nterchanges menu).

Notes

» Thisoptionisonly availableif asingleitem is selected
from the detailed list.

» Thisoptionisnot availableif the external datafile
used in tranglation does not exist.

» When viewing raw-EDI or external data, you can
switch from Text to Hex format by selecting the
appropriate command from the View menu.

middle right Displaysthe datain EDI format (if this option is selected
pane—Gentran from the View\Interchanges menu).
Data

Notes

» Thisoptionisonly availableif asingleitem is selected
from the detailed list.

» When viewing raw-EDI or external data, you can
switch from Text to Hex format by selecting the
appropriate command from the View menu.

lower right pane— | Displays areport of the actions the translator took on this
Translator Report | document and lists any EDI- or translation object-based
compliance errors (if this option is selected from the
View\Interchanges menu).

Note
Thisoptionisonly available if asingle itemis selected
from the detailed list.

Reference

See Error Messagesin the IBM® Serling

Gentran: Server® for Microsoft Windows Administration
Guide for more information.
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Interchanges Browser

The following lists the status icons that the system may use at the document level
on the Interchanges browser:

Satus

I con

Description

OK

[

(green) — Indicates that the documents are fully
compliant with the EDI standard and are eligible for
further processing.

NotOK

(red) — Indicates one of the following:

The document failed to comply with the EDI
standard. If thisis the cause of the error, the errors
will beindicated on atrangator report associated
with the document. Despite the fact that the
document is not fully compliant, itiseligible for
further processing.

The received document could not be associated with
aspecific trading partner. If thisisthe case, the
partner for the document is listed as Unknown. To
associate this document, and the other documents
received in the interchange with a partner, attach the
documents from the Interchange browser.

A suitable trading relationship or translation object
could not be associated with the document. Detailed
information concerning what information was used
to locate the rel ationship and/or the trandl ation object
will belisted in the audit log. To correct this
problem, avalid relationship must be established
using the Partner Editor and avalid export, print, or
turn-around translation object must be defined for
that relationship.

A major error occurred while processing the
interchange, functional group, or transaction level
enveloping structures. This error may include header
and trailer control numbers that do not match, an
invalid trailer control count, or a control number
sequence checking error. If any of these errors occur,
they will be listed on the trandator report for the
interchange containing the document.

Duplicate

(yellow) — Indicates the document has the same name as
another document on the system.
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| nterchange Filter Dialog Box

Introduction

Diagram

Parts and
functions

The Interchange Filter dialog box alows you to filter the display of interchanges
by date, partner, and direction (inbound and outbound).

Note

You can set global Interchange Filter preferencesin the Sterling Gentran: Server
Preferences dialog box on Interchange Filter tab. Access the Preferences dialog
box by selecting Prefer ences from the Options menu.

The following illustrates the Interchange Filter dialog box:

Interchange Filter E3
—Diate — Partner
Eram PETZOME
07 February 97 15:00
o | i
e
07 February 00 16:00
Kl 12
] ey i Unzelect &l Partners
— Direction
[ Mo DatedTime Checking W IrBound 1

v OutBound =
Cancel |

The following lists the parts of the Interchange Filter dialog box and their

functions:
Part Function
Date From Select the beginning date of a date range, from which the

system should filter the display of interchanges.

Note

The Date From box is only active if the No Date/Time
Checking check box is not selected.
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Part Function

Date To Select the end date of a date range, from which the system
should filter the display of interchanges.

Note

The Date To box is not activeif either the No Date/Time
Checking check box is selected or if the Always Current
check box is selected.

Always Current Indicate that the end date for the date range is always the
current system date and time.

Note
The Always Current check box is only activeif the No
Date/Time Checking check box is not selected.

No Date/Time Indicate if the system filters the display of interchanges by
Checking date and time (if selected).
Partner Containsalist of all partner profiles on your system. This

list allowsyou to filter the display of interchanges by the
partners you specify.

Note
The default display is all partners, but you can click on
partner profilesto clear them.

Unselect All Clearsall partner profiles.

Partners
Note

Thisallows you to filter the display of interchange by the
partners you specify.

Warning
At least one partner must be selected.

InBound Select the direction of traffic (inbound and outbound) for
Outbound the system to filter the display of interchanges.

Note
The default display is both inbound and outbound
interchanges.

Warning
At least one of the Inbound/Outbound check boxes must be
sel ected.

OK Exits the dialog box; saves the selections.

Cancel Exits the dialog box without saving selections.
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Viewing I nterchanges

Procedure  To view interchanges, complete the following steps:

Sep Action

1 From the appropriate area of The Desk, select Interchanges.

System response
The system displays the Interchanges Browser.

Note
To refresh the display of the Interchanges browser, right-click the
middle pane and select Refresh from the shortcut menu (or press F5).

2 Do you want to filter the display of interchanges by status?

» If yes, see Filtering the Display of Interchanges on page 7 - 12.
» If no, continue with step 3.

Note

The Filter function enablesyou to filter the display of interchanges by
date, partner, and direction (inbound and outbound).

3 Select an interchange.

4 Use the following table to determine your next step:

To view the related Select View > Interchanges > Related
externa datafor asingle | External Data.

selected interchange,
Note

When viewing raw-EDI or External
Data, you can switch from Text to Hex
format by selecting the appropriate
command from the View menu.

Toview thecontent of a | Select View > Interchanges > Gentran

single selected Data.
interchange in raw EDI
data format, Note

When viewing raw-EDI or External
Data, you can switch from Text to Hex
format by selecting the appropriate
command from the View menu.
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Viewing Interchanges

Sep Action
4 To view the translator Select View > I nterchanges >
(contd) | report for asingleselected | Translator Report.
interchange,

To print a selected
interchange or a summary
of interchanges,

Print from the File menu.

To delete aselected
interchange and al
associated documents,

Select Document > Delete.

Notes

» If you delete an interchange with a
status of Queued, you receive a
warning that you must remove
specified messages from Out
Documents and from your trading
partner’sinbox. If you proceed, you
are warned that if your partner bases
processing results on control number
sequencing, you should modify the
transaction, group, and interchange
control numbers.

» If you delete an interchange with a
status of Ready to send, you are
warned that if your partner bases
processing results on control number
sequencing, you should modify the
transaction, group, and interchange
control numbers.

» If aninterchange contains a
document that is waiting for
acknowledgement processing
(acknowledgement generation or
reconciliation), you cannot delete it
until this processing is complete.

To attach an interchange
to a partner,

Select Document > Attach.
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Filtering the Display of Interchanges

Introduction ~ When the Interchanges browser is active, the Filter function enables you to filter
the display of interchanges by date, partner, and direction (inbound and

outbound).

Procedure  Tofilter interchanges by partner and/or date, complete the following steps:

Step

Action

1

From the appropriate area of The Desk, select I nterchanges.

System response
The system displays the Interchanges Browser.

From the Commands menu, select Filter.

System response
The system displays the Interchange Filter Dialog Box.

Do you want the system to filter the display of interchanges by date
and time?

» If yes, clear the No Date/Time Checking check box and proceed
with step 4.

» If no, select the No Date/Time Checking check box and proceed
with step 6.

Use the Date From slide bar to select the beginning date of the date
range, from which the system will filter the display of interchanges.

Do you want the end date for the date range to always be the current
system date and time?

» If yes, select the Always Current check box.

» If no, clear the Always Current check box and move the Date to
dlide bar to the date and time you want to use.
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Filtering the Display of Interchanges

Step

Action

Do you want to filter the display of interchanges by partner?

» If yes, select the partners that you want displayed from the
Partner list (listsal partner profiles on your system).

Note

The default display isall partners, but you can click partner
profiles to clear them and change the display. Alternately, you
can click Unselect All Partnersto deselect all partner profiles.
You can then click one or more profiles to select them. At least
one partner must be selected.

» If no, continue with step 7.

Which direction do you want to filter the interchange?

Default
The default display is both inbound and outbound interchanges.
Clear the Inbound or Outbound check box to clear the direction.

Note
At least one of the Direction check boxes must be selected.

Click OK.

System response
The system filters the interchange display based on the criteria you
selected.
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Viewing Documentswithin Interchanges

Introduction  You can view theindividual documentsin an interchange as long as a screen entry
translation object for each document is available on your system.

Procedure  Usethis procedure to view the documents within an interchange.

Sep Action

1 From the appropriate area of The Desk, select Interchanges.

System response
The system displays the Interchanges Browser.

Notes

» TheInterchanges browser displays all interchanges, group, and
documents that were sent or received.

» Torefreshthedisplay of the Interchanges browser, right-click the
middle pane and select Refresh from the shortcut menu (or press
F5).

2 Select a document and proceed with the next step or double-click a
document to view it.

Note
You must have a screen entry translation object for this document
available on your system.
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Viewing Documents within Interchanges

Step

Action

With a document selected, use the following table to determine your

next step:

To view atrandator report of
the actionsthetranslator took
on this document,

Select View > Interchanges >
Trandlator Report.

To view the content of a
single selected interchangein
raw EDI dataformat,

Select View > I nterchanges >
Gentran Data.

Note

When viewing raw-EDI or External
Data, you can switch from Text to
Hex format by selecting the
appropriate command from the View
menul.

To view the related external
data of asingle selected
interchange,

Select View > I nterchanges >
Related External Data.

Note

When viewing raw-EDI or External
Data, you can switch from Text to
Hex format by selecting the
appropriate command from the View
menu.

To print a selected document
or translation report,

Select File > Print.

To delete a selected
document,

Select Document > Delete.

To copy the document to the
appropriate browser,

1. Select Document > Copy.
2. Select the appropriate browser from

the submenu.

(?An Documents or In Documents
Browser for compliant Inbound
documents; Workspace Browser for
outbound documents)
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Attaching Interchangesto a Partner

Introduction  The Attach to Partner dialog box can be accessed when the Interchanges browser
is active and one interchange is selected. The Attach function enables you to link
the interchanges to a partner. Use this function if you received documents that did
not have an identifiable partner and are now listed without a partner in the 2In
Documents browser.

Note

The interchanges for these documents are listed without a partner in the
I nterchanges browser.

Procedure  Usethis procedure to attach an interchange to a partner.

Step

Action

1

From the appropriate area of The Desk, select | nterchanges.

System response
The system displays the Interchanges Browser.

Select one interchange.

Does the partner already exist?
» If yes, continue with step 4.
» If no, you must create the partner before you can continue.

Reference
See Creating a Partner Definition on page 3 - 56 for instructions.

From the Document menu, select Attach.

System response
The system displays the Select Partner dialog box.

Select the desired partner from the list and click OK.

System response
The system links the selected interchange to this partner and returns
to the Interchanges browser.

Does the partner to which you are attaching the interchange have
more than one interchange definition?

» If yes, you are prompted with an additional dialog box. Continue
with the next step.

» If no, continue with Step 3.
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Attaching Interchanges to a Partner

Sep Action

7 Use the following table to determine what to select on the dialog box:
If your partner has more 1 Select _the appropriate interchange
than one interchange definition.
definition, 2. Click OK.
If your partner has more 1. Select the appropriate group definition.
than one group definition, |2, click OK.
If your partner has more 1 Select _the appropriate relationship
than one relationship definition.
defined for adocument type [2. Click OK.
in the interchange,

3 After you attach the interchange to a partner, open ?ln Documents by

selecting it from the appropriate area of The Desk.

Note

You can then export, print, or move the documents to the In Drawer

Browser.
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Resending I nterchanges

Introduction  There are two ways to resend interchanges:

» Toautomatically resend all outbound interchanges, you can set the Send
Options preference.

» Toresend specific outbound interchanges, you can use the Resend command
from the Interchanges browser.

» Toresend interchanges during the next communications session, you can use
the Queue for the Resend command from the I nterchange browser

Note
You can only resend interchanges that were previously sent or that have a status of
Ready to send.

Resending  You can set an option for the system to automatically check for interchanges that
interchanges  are stuck in the Send Queue. Theinterval for checking the Send Queue is set by
automatically ~ default to 30 minutes in the Registry. However, you can change this value in the
UPIDValidationinterval key.

During the first system check, the Sterling Gentran:Server Executive Service
checks for interchanges that are possibly stuck and places those interchangesinto
aqueue. During the next system check, the Executive Service checksif those
interchanges are till in the queue. Any that are still in the queue at the second
system check are flagged to be sent during the next communications session.

To automatically resend outbound interchanges, complete the following steps:

Sep Action

1 From the Options menu, select Preferences.

System response
The system displays the Preferences dialog box.

2 Click the Send Optionstab.

3 Click the box for Check for interchangesthat did not send.

4 Click OK.

5 Optional
Change the System Check Interval in the registry. (Default is 30
minutes.)

6 Restart services.
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Queueing  Interchanges queued for sending are sent with then next matching
Interchangesfor ~ communications session. If the next session targets a specific partner or mailbox,
Sending with the  and the interchanges do not match that criteria, the interchanges are not resent.

. Next Example 1
Communications | nierchanges are queued for resending to mailbox SIB. A communications session
Session  for the * Gentran Tutorial” mailbox executes. The queued interchange are not sent.

Example 2

Interchanges for the partner PETZONE are queued for resending. A
communications session for data only for the partner PETZONE2 executes. The
gueued interchanges are not sent.

To queue interchanges for sending with the next communications session:

Sep Action

1 From the appropriate area of The Desk, select Interchanges.

System response
The system displays the Interchanges Browser.

2 Select the outbound interchange that needs resent. Multiple
interchanges can be selected using the Shift or Ctrl key (asin
Windows Explorer).

3 From the Document menu, select Queue for Resend.

System response
The interchanges “ I nterchanges Process Status’ will change to
“Ready to Send.”

Resendinga  To resend a specific outbound interchange, complete the following steps:
specific .
interchange Sep Action

1 From the appropriate area of The Desk, select Interchanges.

System response
The system displays the Interchanges Browser.

2 Select the outbound interchange that needs to be resent.

3 From the Document menu, select Resend.

System response
The system displays the Sterling Gentran: Server for Microsoft
Windows dialog box.

4 Click Yes to start the transmission session.
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Resend process  The following describes the system process that occurs when you resend an

interchange:
Sage Description
1 When the resend command is executed, the system first determinesif

itisaTRADACOMS interchange. If theinterchangeis
TRADACOMS, the system increments the current version number in
the FIL segment by one. After this update, theinterchangeisresentin
the same manner as all other interchanges.

Communication is established with the remote end. The status of the
message is updated based on the success or failure of the
communications session.

» If communication fails because there is no mailbox set up or the
Mailbox serviceisnot started, the interchange and documents are
left in a Ready to send status.

» If communication fails because there is no modem, the
interchange and documents are left in a Queued status.

Note
No user action is required at this point. Interchanges that failed to
send are automatically sent as part of the next transmission session.

The documents are moved to the Out Drawer Browser and the
interchange statusis set to Sent.
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Manually Acknowledging an Interchange, Group, or

Document

I ntroduction

Procedure

User Guide

The Acknowledge function does not generate an acknowledgement; it merely
changes the status of the outbound document.The status of an interchange, group,
or document in the Interchanges browser may need to be manually set to
acknowledged for many reasons.

Example
You contact a partner about an overdue document and the partner verifiesthat it
was received but they did not send an acknowledgement.

To manually change the status of an interchange, group, or document to
acknowledged, compl ete the following steps:

Sep Action

1 From the appropriate area of The Desk, select I nterchanges.

System response
The system displays the Interchanges Browser.

2 Select an unacknowledged interchange, group, or document that
needs to be set to acknowledged.

Note
Unacknowledged documents are marked with one of the following
Statuses.

» Overdue
» Waiting

» Sent

» OnNet

» PickedUp
» NetErr

» NetWarn

3 From the Document menu, select Ack.

System response
The system sets the status of the document to acknowledged.
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Overview

Inthischapter  This chapter explains how to use Sterling Gentran: Server acknowledgements,
including the following topics:

» Defining acknowledgement criteria (inbound)

» Defining acknowledgement criteria (outbound)

» Manually acknowledging a document, group, or interchange
» Checking for overdue acknowledgements

Acknowledgement  Acknowledgements are sent to atrading partner to inform them that you received
atransmission they sent and to inform them of any errors. You must define the
level of acknowledgementsthat you expect from your trading partners and you are
sending to your trading partners upon receipt of atransmission.
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Defining Inbound Acknowledgement Criteria

Introduction

User Guide

The criteriathat the system uses to acknowledge inbound documents, functional
groups, and interchanges is defined at the partner level on the Partner Editor
Inbound Relationship dialog boxes. The trandlation objects used by the system to
generate functional acknowledgements are included as system translation objects
and are registered automatically when you install Sterling Gentran: Server.

Note

If you generate functional acknowledgements as aresult of receiving documents
for an inbound relationship, you must set up the corresponding outbound
relationship to generate the acknowledgements your partner requests.

Reference
See Creating an Outbound Relationship on page 3 - 66 for information about how
to establish an outbound relationship to generate acknowledgements.
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Procedure  To define criteriato generate acknowledgements, complete the following steps:

Step

Action

1

Document acknowledgement criteriaiis defined when you set up the
partner relationship using the Advanced options on the Inbound

Relationship Dialog Box, which are illustrated bel ow.

Seguence Checking Last sed Control Mumber:

Generate Acknowledgments

&+ Mone IDDDD
" Duplicate

" Incremertal
" Chronglogical | [~ Skip Compliance Check

[ Duplicate Documents

Test Indicatar: 7 Test & Production

* o
™ ez - Mo Emor Detail
™ ‘es - With Error Detail

Acknowledgement Processing

" Deferned & Immediate

Note

If you select Immediate acknowledgement processing,

acknowledgement reconciliation occurs during the inbound break
session. If you select Deferred acknowledgement processing (the

default), reconciliation occurs at its scheduled interval.

References

» See System Configuration—System Tab in the IBM® Serling
Gentran: Server® for Microsoft Windows Administration Guide
for more information about setting the intervals for deferred

acknowledgement processing.

» See Creating an Inbound Relationship on page 3 - 58 for more

information about setting parameters on the Inbound

Relationship dialog box.
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Sep Action
2 Functional Group acknowledgement criteriais defined when you set
up the Inbound Group Entry using the Advanced options on the
Inbound Group Entry Dialog Box, as illustrated below.
Seguence Checking Last Used|Eroup Eomtraldumber
@ tone | [0 e T
" Duplicate .
" Incremental I j'
" Chronaological
Group Transl. Obj I j
Acknawledge Transl Obi  |ACKBUILD_CONTRL =
Reference
See Selecting an inbound functional group for more information
about setting parameters on the Inbound Group Entry dialog box.
3 Interchange acknowledgement criteriais defined when you set up the

Inbound Interchange Entry using the Advanced options on the
Inbound Interchange Entry Dialog Box, asillustrated below.

Seguence Checking  Last Used Contral Humber I Acknowledge Interchange
% None IDDDDDDDDD
" Duplicate Ackiransachon Seb
" Incremental Iﬁ
" Chronological

Interchanage Transl Ohbj. I

[
[]

Acknowledge Transl. Obj. I

Reference

See Selecting an inbound interchange on page 3 - 64 for more
information about setting parameters on the Inbound Interchange
Entry dialog box.
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Defining Outbound Acknowledgement Criteria

Introduction  Reconciling documents and their acknowledgements is a function that the system
automatically performs for you. The tranglation objects that are necessary to
process the acknowledgements you receive are included as system trangation
objects and are registered when you install Sterling Gentran: Server.

However, you must establish the level of acknowledgements that you expect by
completing the Partner Editor Outbound Relationship dialog boxes.

Note

If you are receiving functional acknowledgements as a result of sending
documents for an outbound relationship, you must set up the corresponding
inbound relationship to receive the acknowledgements you expect to receive.

Reference
See Creating an Inbound Relationship on page 3 - 58 for information about how
to establish an inbound relationship to receive acknowledgements.
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Defining Outbound Acknowledgement Criteria

To set up the level of acknowledgements that you expect to receive from your
partners, complete the following steps:

Sep

Action

1

The requirement for receiving interchange acknowledgements is set
in the Advanced section of the Outbound Interchange Entry Dialog
Box, asillustrated below.

¥ Use the default Mailbox and E-mail Sddress

Mailbo | GENTREN Application x| flEw ity |
E-rnail Address I Edlit |

Content Type: I.ﬂ.pplicationa’E ]l

™ Set Max Mumber of Documents per Interchange

i & W umbern ek eciumerts pernterchange; ID

Laszt Uged Control Mumber: ™ Expect Acknowledgement

IDDDDDDDDD HEnms [ erme: ID

Interchange Transl. OBl {154 Build Template - ANS| =]

Acknowledge Tranzl. Obj. I j
Reference

See Selecting an outbound interchange on page 3 - 73 for more
information about setting parameters on the Outbound Interchange
Entry dialog box.

Recommendation

Do not change the trand ation objects in the Interchange Trandl. Ob;.
and Acknowledge Transl. Obj. lists, unless you are certain of the
result.
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Sep Action

2 The requirement for receiving functional group acknowledgementsis
set in the Advanced section of the Outbound Group Entry Dialog
Box, asillustrated below.

Laszt Uged Group Contral Humber: [ Expect Acknowledgement
ID 1 otirs [ Erd e ID
Tranzaction Contral Mumbers
™ Sequence From Group Eafmiat
) hliarmal
[Last [ sed ot Himber: B/
ID B
5/
Group Trangl, Obj; IGS Build Template - AMSI

Ll [

Acknovledge Tranzl Obj; I

Recommendation
Do not change the trand ation objectsin the Group Transl. Obj. and
Acknowledge Transl. Obj. lists, unless you are certain of the result.

Note

If the acknowledgement is overdue (it is not received within the
number of hours designated in the Hours Overdue box), it is
indicated with a status of Overdue on the Interchanges Browser.

Reference

» See Slecting an outbound functional group on page 3 - 71 for
more information about setting parameters on the Outbound
Group Entry dialog box.

» SeeViewing Documents within Interchanges on page 7 - 14 for
instructions on how to access the Interchanges browser.
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Defining Outbound Acknowledgement Criteria

Sep

Action

The requirement for receiving transaction set acknowledgementsis
set in the Advanced section of the Outbound Relationship Dialog
Box, asillustrated below.

Last Uzed Contral Humber: IDDDD

T Eupect dckrowledgement | T Duplicate Documents
Hmnrs [ ierdie; ID Test Indicator: | & Test & Production
Reference

See Finalizing the outbound relationship on page 3 - 75 for more
information about setting parameters on the Outbound Relationship
dialog box.
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Manually Acknowledging Documents

Introduction

Procedure

The Acknowledge function does not generate an acknowledgement; it merely
changes the status of the outbound document.The status of a document in the Out
Drawer browser may need to be manually set to Acknowledged for many reasons.

Example
You have contacted a partner about an overdue document, and that partner
verified that it was received but they are not sending you an acknowledgement.

Reference
See Manually Acknowledging an Interchange, Group, or Document on page 7 - 21
for more information.

To manually change the status of a document to Acknowledged, complete the
following steps:

Sep Action

1 From the appropriate area of The Desk, select Out Drawer.

System response
The Out Drawer Summary dialog box is displayed.

2 Select the type of document for the appropriate partner and click
View.

System response
The system displays the Out Drawer Browser.

3 Select an Unacknowledged document that needs to be set to “Ack’ d”
(acknowledged).

Note
Unacknowledged documents are marked with one of these states.

Overdue
Waiting
Sent
OnNet
PickedUp
NetErr
NetWarn

4 Click Ack.

System response
The system sets the status of the document to “Ack’d.”
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Special Considerationsfor EDIFACT Acknowledgements

Introduction  When creating an outbound EDIFACT Control document, the default system
behavior isto extract the Sender ID and Receiver 1D from the Internal System
User partner. According to the EDIFACT standard, the Sender ID and Receiver ID
in the UCI and UCF record of the Control document should contain the values
from the Inbound UNB and UNG segment, respectively.

The Sterling Gentran: Server product CD (in the Maps\Special directory) contains
the translation object CntriBld_DLL.tpl. This map enables you to obtain the
Sender 1D and Receiver ID from the inbound datafile viaa user exit that accesses
the GentranAutomation.DLL. The GentranAutomation.DLL is automatically
registered when you install or upgrade the product. This DLL is currently only
used by the CntrIBld_DLL map.

Note
You can either use either functionality. The default translation object selected for
the Outbound Control Build relationship isthe ACKBUILD_CONTRL.

Procedure  Tousethe CntrlBld_DLL.tpl functionality to obtain the Sender ID and Receiver
ID, complete the following steps:

Sep Action

1 From the Tools menu, select Partner Editor.

System Response
The system displays the Partner Editor Dialog Box.

2 Select the Outbound Control Build relationship from the Select a
Partner list and click Outbound.

System response
The system displays the Outbound Relationship Dialog Box for that
partner.

3 On the Outbound Relationship dialog box, click Trandation.

System response
The system displays the Outbound Translation Object Dialog Box.

4 From the Import list, select ACKBUILD_CONTRL _DLL.

Note
The default translation object selected for the Outbound Control
Build relationship isthe ACKBUILD_CONTRL.

5 Click Save to save your selections and return to the Outbound
Relationship dialog box.
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Checking for Overdue Acknowledgements

Introduction  You can manually check for overdue acknowledgements by using the Overdue
Check feature.

Note

You can specify the frequency at which the system will check for overdue
acknowledgements (in whole minutes) in the System Configuration program. This
allows you to disable or reduce the frequency of overdue acknowledgement
checking.

Reference

See How to Change the Frequency of Overdue Acknowledgement Checking in
the IBM® Serling Gentran: Server® for Microsoft Windows Administration
Guide for more information.

Procedure  To check for overdue acknowledgements, complete the following steps:

Sep Action

1 From the Commands menu, select Over due Check.

System response

The system checks if any interchange, group, or document that
requires an acknowledgement is overdue (the system has not received
an acknowledgement for it and the specified time to do so has
expired). For any overdue interchange, group, or document, the
system sets the status to Overdue on the Interchanges Browser.

Reference
See Viewing Interchanges on page 7 - 10 for more information about
using the Interchanges browser.
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Overview

Inthischapter  This chapter describes how to use the Sterling Gentran: Server tracking systems.

Tracking feature  The system writes a Document Tracking record for every significant event that
occurs for adocument. For example, a Document Tracking record iswritten when
the document is created, when it is modified, and when it is exported.
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Tracking Inbound Information

Tracking Inbound Infor mation

Introduction

Processfile

User Guide

process

For inbound processing, the system may receive an inbound transmission file
(such as external data) through the Process File command within Sterling
Gentran:Server or through a Mailbox message (when the ContentTypeis
configured to Application/EDI). After the fileis received by the system, you may
either export the file or configure the system to export it automaticaly.

When data arrives directly into the system through a Process File command,
Commpost performs the following actions to save the information pertaining to
thisfile:

Sage Description

1 If System Configuration is configured to copy process file data,
Commpost copies the file to the External Data directory.

2 Commpost updates the ExtData_tb with a new record containing the
type of externa data being saved (such as ExtData), a new external
data key (after allocating anew one), and other relevant data
pertaining to this external datareference.

3 Commpost splitsthisfile into interchanges and creates INT files
(interchanges) and IPC files for the Trandator.

4 Commpost invokes the Transl ator, which continues with the inbound
process and creates arecord in ExtDataXref tb linking the external
data reference to the interchange just created. Thereisone IPC file
for each interchange, and the IPC file passes information to the
Trangdlator, including the starting and ending offset indicators in the
transmission file for the interchange to which it corresponds and the
external datatype and key.

This ensuresthat the system can reference thisfile (external data) in the event you
want to view tracking information or external data.

Note
If you do not configure Sterling Gentran: Server to copy external information, the
external dataviewer isunavailable.

References

See the following for more information:

» Processing Data Fileson page 5 - 14
» Exporting Documents on page 4 - 62

» System Configuration—External Data Tab and the Using Database Tables
appendix in the IBM® Serling Gentran: Server® for Microsoft Windows
Administration Guide
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Mailbox process  When data enters the system through a mailbox, all associated message identifiers
fileprocess  aretracked using the following process:

Sage Description

1 Your trading partner creates a datafile (in which ContentType is set
to Application/EDI. An associated message ID is created in the
Outbox.

2 Your partner sends it to your Sterling Gentran: Server Application
Inbox, which creates a new target message ID.

3 The CommMgr (the Sterling Gentran: Server Executive service)
recognizes the ContentType as Application/EDI. It receives the data
and stores the external datareference in the ExtData tb in the same
way as described in the previous section, except that since
CommMagr receives the data, it saves this database entry.

4 The CommMgr builds atemporary session file using the
GDW_Process MBFile command for unattended processing to
execute, and Process Control invokes Commpost.

5 Commpost builds the IPC file, which includes writing the external
data key and the start and end offset indicators in the transmission
file for the given interchange.

6 Commpost invokes the Tranglator for each interchange to finish
processing the data, and writes the entry in the ExtDataXref_tb to
link the external data reference to the Sterling Gentran: Server data.

References
See the following for more information:

» Using Process Control, chapter 11 in this guide
» Communications User Guide

» Using Database Tables appendix in the IBM® Serling Gentran: Server® for
Microsoft Windows Administration Guide
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Export process Datathat isexported is already in the system, so the external data that creates the
export fileis the Translator. Therefore, the Translator stores the tracking
information in the database.

Sage Description

1 The Trandator uses the document or documents as input to the
export translation object.

2 Depending on the specifications of the trandation abject, the system
generates an export file.

3 The Translator copies the newly generated export file to the External
Datafolder in the system data store, updates the ExtData_tb with the
appropriate information, and updates the ExtDataXref tb with the
external data and associated document information.

References
See the following for more information:

» Exporting Documents on page 4 - 62

» Using Database Tables appendix in the IBM® Serling Gentran: Server® for
Microsoft Windows Administration Guide
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Tracking Outbound Information

Introduction  For outbound processing, the system can import external data through the Import
command within Sterling Gentran:Server or through a Mailbox message (when
the ContentType is configured to Application/Import). After the file is imported
into the system, you can send the file or configure Process Control to send thefile
automatically. After a send command, a new mailbox message is created and any
subseguent send transmissions create a new mailbox message that is related to the
same external datafile that wasinitially imported.

Import process  Dataisimported using the following process:

Sage Description

1 The external dataisimported directly into Sterling Gentran:Server.
This datais either coming from an unattended process control
(GDW _Import) or a manual import.

2 Depending on how the dataisimported, either UNATTEND or
EDIMGR copies the external datafile to the External Datafolder in
the system data store.

3 UNATTEND or EDIMGR updates the ExtData _tb with an entry that
indicates the filename, the date and time from the timestamp on the
file, the date and time of the action, and the ExtDataK EY

4 UNATTEND or EDIMGR writes the ExtDataType and ExtDataK EY
parametersto the IPC file (they are called "Type" and "Key,"
respectively, in thisfile).

5 The Trandator executes the import tranglation object. It obtains the
ExtDataType and ExtDataKEY from the IPC file and writes the
ExtDataXref_tb entries that link the documents to the external data
reference created by EDIMGR or UNATTEND.

References
See the following for more information:

» Importing Documents on page 4 - 60
» Using Process Control on page 11 - 1

» Using Database Tables appendix in the IBM® Serling Gentran: Server® for
Microsoft Windows Administration Guide
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Tracking Outbound Information

When an external datafile isimported using a Collection Mailbox, all the

process  associated message identifiers are tracked by the system according to the
following process:

Stage

Description

1

When outbound data flows through the system, the Collection
Mailbox creates a data file and an associated message ID inits
Outbox (with ContentType set to Application/Import).

The Collection Mailbox sendsiit to your Application Inbox, creating
anew target message ID.

Note

For aMailbox Import, you must specify the UNC path and file name
on the System Configuration Imports tab. This specification must
exactly match the path you set for the TRANSIN directory on the
System Configuration Directories tab.

References
See the following for more information:

» How to Create a File System Mailbox in the Communications
IBM® Serling Gentran: Server® for Microsoft Windows User
Guide

» System Configuration—Directories Tab in the IBM® Serling
Gentran: Server® for Microsoft Windows Administration Guide

» System Configuration—Imports Tab in the IBM® Serling
Gentran: Server® for Microsoft Windows Administration Guide

The CommMagr recognizes the ContentType as Application/Import
and initiates the import of thisfile.

The CommMgr stores the external data reference in the ExtData_tb
and then builds the unattended processing session file (with the new
GDW_MBImport command) to import the datainto Sterling
Gentran:Server.

After the session fileis created, unattended processing creates the
IPC file and writes the external datainformation that the Translator
needs to perform an import.

The Tranglator runs the import map stores tracking informationin the
ExtDataXref_tb.

References
See the following for more information:

Using Process Control, chapter 11 in this guide
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» IBM® Serling Gentran: Server® for Microsoft Windows Communications
User Guide

» Using Database Tables in the IBM® Serling Gentran: Server® for Microsoft
Windows Administration Guide
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Send process  After afile has been imported, the Sterling Gentran: Server documents that are
created can be sent to a Mailbox according to the following process:

Stage

Description

1

The system creates an associated Mailbox message in the Sterling
Gentran:Server Application mailbox.

It sends the message to the partner’s mailbox. Like the processfile
and import actions, the send action has a source and target message
ID associated with the external data. However, unlike the other
actions, the external dataisamessage and it is related to an
interchange.

The links between the interchange that is sent and the Mailbox
message to which it is sent are preserved in the ExtDataXref _tb.
When you want to view thisinformation, it is available in the
External Data Summary Viewer.

Example

In this scenario, the user has selected to send multiple documentsin one
interchange. After the Trandator builds the interchange, the CommMgr sends the
interchange to the Mailbox. While the CommMagr is sending the interchange, it
receives amessage ID for the Mailbox to create a message in the Sterling
Gentran; Server Application mailbox. Then, it creates an external datareferencein
the ExtData _tb where the type is Message. Finally, CommMgr has enough
information to create arecord in the ExtDataXref_tb linking the interchange to the

message.

References
See the following for more information:

» Sending Document on page 5 - 6

» [IBM® Serling Gentran: Server® for Microsoft Windows Communications
User Guide

» Using Database Tablesin the IBM® Serling Gentran: Server® for Microsoft
Windows Administration Guide

User Guide
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Viewing and Printing Data Audit Information

Introduction  Typicaly, you view dataaudit (document tracking information that is avail able for
a single document) to get information to help resolve a problem with a document.
These records can be viewed from any of the document browsers.

Procedure  Toview or print data audit information, complete the following steps:

Sep Action

1 From the appropriate area of The Desk, select the desired browser.

System response

If you select the In Documents, ?ln Documents, Out Documents,
?20ut Documents, In Drawer, or Out Drawer browser, the appropriate
summary dialog for that browser is displayed.

2 To access the browser containing those documents, select the type of
document for the appropriate partner and click View.

3 Select a single document and select View from the Commands
menu.

System response
The system displays the View Choice Dialog Box.

4 Select Data Audit and click OK.

System response
The system displays a Document Audit window for that document.

Note

The Document Audit window containsthe audit messages specific to
the selected document. The information in this window includes the
severity of the message, event ID, event name, audit number, user
name, machine name, and message.

Reference

See Using the Audit Notification System in the IBM® Serling
Gentran: Server® for Microsoft VW ndows Administration Guide for
more information.

5 Do you want to print the displayed data audit information?
» If yes, from the File menu, select Print.
» If no, click Closeto exit the Tracking window.
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Viewing and Printing Tracking Infor mation

Introduction

Procedure

User Guide

This function displays information that tracks an external datafile. These records
can be viewed from any of the document browsers.

To view or print tracking information, complete the following steps:

Sep Action

1 From the appropriate area of The Desk, select the desired browser.

System response

If you select the In Documents, ?ln Documents, Out Documents,
?20ut Documents, In Drawer, or Out Drawer browser, the appropriate
summary dialog for that browser is displayed.

2 To access the browser containing those documents, select the type of
document for the appropriate partner and click View.

3 Select a single document and select View from the Commands
menu.

System response
The system displays the View Choice Dialog Box.

4 Select Tracking Information and click OK.

System response
The system displays a Tracking Information window for that
document.

Note

The Tracking Information window contains an entry for each set of
correlated files. If there are more events than can be displayed in the
window, a scroll bar enables you to view the remaining records.

5 Do you want to print the displayed tracking information?
» If yes, from the File menu, select Print.
» If no, click Closeto exit the Tracking window.
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| ntroduction

In thischapter  Thischapter explains how to use the interactive archive and restore feature of
Sterling Gentran: Server.

Archivefeature  The Archive feature provides arecord of past interchanges (inbound and
outbound), application data, and mailbox messages. This enables you to produce
an offline archive datafile of interchanges, external data, or mailbox messages
with stored parameters (archive definitions) that you define. This archive datafile
can be stored long-term.

You can also use Sterling Gentran: Server Process Control to purge and archive
data at predefined intervals.

Reference
See Using Process Control, chapter 11 in this guide, for more information about
scheduling unattended archive sessions.

Restorefeature  The Restore feature enables you to reprocess archived data through Sterling
Gentran:Server. This feature copies datafrom an archive data file back to the
active system. For restored interchanges, you can then view the datain the
Restored Interchange browser and reprocess it, if necessary.

Whentouse  Werecommend that you archive your system data on aweekly basis. Using this
archive featureiscritical inlarge volume operations.
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Overview

Archiving Data

Overview

Typesof data
that can be
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archived

Archive
definition

The Archive feature enables you to archive the following types of data:
» Inbound and outbound interchanges (Sterling Gentran:Server EDI)
» Mailbox messages (and any corresponding attachments)

» Externa data

Note

If adocument is waiting for acknowledgement processing (acknowledgement
generation or reconciliation), you will not be able to archive it until this
processing is complete.

You can completely configure the Archive feature by using stored archive
definitions. An archive definition is a set of archive parametersthat you set to
specify the exact data that you want the system to archive. The system saves the
archive definition file (*.ARD file) so you can execute the same archive process
repeatedly without having to define parameters again.

Reference
See Creating an Archive Definition on page 10 - 36 for more information.
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Thearchive  Thefollowing table describes the archive process:

process

Sage

Description

1

Define the archiving parameters (*.ARD file). The archive
parameters available depend on the type of data you are archiving.

IF you archive... THEN the available archive parametersare...
Sterling » partner profileID
Gentran:Server EDI, |, \yhether the interchange is inbound or
outbound
» age

» processed status
» network status
» acknowledgement status

Mailbox messages, » mailbox (aparticular mailbox or all
mailboxes)
» location (Inbox, Outbox, or both)
» age
» sStatus

» content type

external data, » action taken
» age

Execute the archive process, which creates the archive files (* .ARV)
in the Archive folder.

Note
This definition can be run interactively or on a scheduled basisvia
Process Control.

Reference
See Using Process Control, chapter 11 in this guide, for more
information about scheduling the archive process.

In the archive process, the system copies (or removes) data both from
the database tables and the system data store.

Sterling Gentran:Server — May 2011

User Guide



Using Archive and Restore

Archive Manager

Archive Manager

Introduction

Archive
information
availableto view

User Guide

The Archive Manager isthe facility through which you archive and restore data.
The Archive Manager enables you to view the following.

» archive definition files
» summary data about the control information that was archived
» thedetailed contents of the data stored in the archive datafile

Notes

» When viewing raw-EDI or external data, you can switch from Text to Hex
format by selecting the appropriate command from the View menu.

» You can sort the Archive tree by filename or by date/time.

The Archive Manager also provides you with a search facility that enables you to
quickly define search parameters that are used to find a specific piece of
information. The system displays the matching results in the How to Archive
Data. You can then select the desired information and the system highlightsit in
the Archive Manager tree view.

The Archive Manager retains extensive data for the information you archive and
enablesyou to easily view it.

Reference
See iewing Archived Data on page 10 - 39 for more information.

The Archive Manager user interface uses atree structure that displays the
hierarchical levels of the archived data. Thistable lists the information available
for each level of the Archive entry for Sterling Gentran: Server EDI, Mailbox, and
External Data.

Note
N/A indicates that theitem is agraphical placeholder used only to illustrate the
type of datathat was archived.

IF you select the... THEN you can view...

archivefile at the summary information, including the following:
Sterling Gentran:Server |, gate and time the archive started

EDI, Mailbox, or . .

Externa Datalevel » date and time the archive ended

» number of items archived
» number of items deleted (if any)
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IF you select the... THEN you can view...

interchange summary information, including the following:
» partner profile ID
» direction

» dateandtime
» interchange control number

data audit

tracking information

group summary information, including the following:
» group control number

» functional group ID

» group control key

document summary information, including the following:
» transaction ID

» transaction control number
» document name

data audit

tracking information

mailbox N/A

Inbox/Outbox N/A

message summary information, including the following:
» saiesID
» messagelD
» sourcelD

» content type

» sender ID/recipient ID

» sender name/recipient name

» sender mailbox E-mail/recipient mailbox E-mail
» subject

» sStatus

» time message created

data audits
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IF you select the...

THEN you can view...

attachment

summary information, including the following:
» attachment ID

» content type

» filename

data audits

file, which isviewed either in an external viewer (the
default viewer is Notepad) or on screen in the
Archive Manager.

Note

When viewing raw-EDI or external data, you can
switch from Text to Hex format by selecting the
appropriate command from the View menu.

external data

any one of the following:

» external datatype

» external datakey

» action

» date and time of action
» origina filename

data audits

Upper-right pane

any one of the following, depending on the level and
type of the selection:

» fileinformation (start, end, number of items
archived, and if any items were del eted)

» interchange information
» group information

» document information

» message information

» attachment information

» external datainformation
» dataaudit information

» tracking information

Lower-right pane

the content of the selected attachment.

Sterling Gentran: Server — May 2011



Archive Manager Using Archive and Restore

Diagram  Thefollowing illustrates the Archive Manager, shown with the Archive tree
expanded and a Mailbox message sel ected:
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Partsand  Thefollowing lists the parts of the Archive Manager and their functions:
functions

Part Function

File menu Exit Archive Manager.
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Part Function

Archives menu Contains the following options:

» Restore data.

» Mark datafor restoration (singleitem or al
items).

» Unmark data(singleitem or all items).

» Refresh (archive-level).

» View dataaudits at the interchange, document
message, or external datalevel.

» View dataaudits and data at the interchange,
document, attachment, or external datalevel.

» Deletearchivefiles.
» Search for specific archived data.
» Select how you want the Archive data sorted.

Definitions menu Contains the following options:

» Create new archive definition.

» Edit or delete archive definition.
» Archivedata

Help menu Access Archive Help and information about the
Archive Manager.

Create new archive definition.

[

Archive data.

Mark selected item to be restored to the system.

N | [

|;| Restore marked data to the system.
=

Left pane Archive, view, and restore data.
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Using Archive and Restore

Part

Function

Upper right pane

The display depends on the level and type of the
selection, but may contain any one of the following:

file information (start, end, number of items

archived, and if any items were del eted)
interchange information

group information

document information

message information

attachment information

external data information

data audit information

tracking information

Lower right pane

Displays the content of the selected interchange,

document, attachment, or external datafile.
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Serling Gentran: Server EDI Archive Definition Dialog Box

Diagram  Thefollowing illustrates the Sterling Gentran:Server EDI Archive Definition

dialog box:
I ame: I
[ Delete Data After Archive
~ Selection Criteria
Add Edi | Deite |
Partner | Direction | Days Old | Processed Status | Mebwork Status | Acknowledgement Status | Owerdue groups and Interchanges |
Save I Cancel Help

Partsand  Thefollowing lists the parts of the Sterling Gentran:Server EDI Archive
functions  Definition dialog box and their functions:

Part

Function

Name

Specify the name of the archive definition file.

Note
This name must be unique.

Delete Data After
Archive

Tell the system to remove the interchange data after
archiving it.

Add

Accesses the Mailbox Selection Criteria Dialog Box
and enables you to define new archive criteria.

Edit

Accesses the Mailbox Selection Criteria Dialog Box
for the selected criteria and enables you to modify the
archive criteria.

User Guide
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Part Function

Delete Deletes the selected Sterling Gentran: Server EDI
criteriafrom the system.
Warning
The system removes the criteria without prompting
you to confirm the deletion.

Partner Displays the partner profile ID.

Direction Displays the direction of the interchanges.

Days Old Displays the age of the interchanges.

Processed Status Displays the processed status of the interchanges.
The default is All.

Network Status Displays the network status of the interchanges. The

default selection is All.

Acknowledgement
Status

Displays the acknowledgement status of the
interchanges. The default is All.

Overdue groups and Displays whether overdue groups and interchanges

Interchanges are archived. The default is No.

Save Saves the archive definition and exits the Sterling
Gentran:Server EDI Archive Definition dialog box.

Cancdl Exits the Sterling Gentran:Server EDI Archive
Definition dialog box.

Help Accesses Online Help.
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I nterchange Selection Criteria Dialog Box

Diagram  Thefollowing illustrates the Interchange Selection Criteria dialog box:

x
Fartrer |A|| j
Direction: = Both ' Inbound " Outbound
[rays Old: ID [ Archive Dverdue Groups and Interchanges

Outbound Criteria
Frocessed Status:

Metwork Status:

Ack Status:

[ =]
[ =]
[ =]

Save I Cancel | Help |

Partsand  Thefollowing lists the parts of the Interchange Selection Criteria dialog box and

functions their functions:

Part

Function

Partner

Select a partner profile ID (default is All).

Direction

Choose Both (inbound and outbound), Inbound, or
Outbound.

Daysold

Specify the age (in days) of the interchangesto be
archived.

Archive Overdue
Groups and
Interchanges

Specify whether overdue groups and interchanges are
archived. The default is No. If selected, the system
behavior prior to the implementation of Deferred
Acknowledgements is implemented where overdue
groups and interchanges are archived if the user
selects “All” or “ReconcileOverdue’ for the
acknowledgement status and the direction is “Both”
or “Outbound.”

If this checkbox is not selected, outbound overdue
groups and interchanges are not archived.

User Guide
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Part Function

Processed Status Select the processed status of the interchanges that
areto be archived. Valid values:
» All (default)
» Received
» Sent
» ReadyToSend
» Queued
» Held
» SendFailed

Network Status Select the network status of the interchanges that are
to be archived. Valid values:
» All (default)
» NotSent
» ReceivedOK

» ReceivedWarning
» ReceivedError

» PickedUp

» ThirdParty

Ack Status Select the acknowledgement status of the
interchanges that are to be archived. Valid values:

» All (default)

» ReconcileNotRequired
» ReconcileWaiting

» ReconciledOK

» ReconciledErrors

» ReconciledPartial

» ReconciledReject

» ReconcileOverdue

Save Saves the selection criteria and exits the Interchange
Selection Criteriadialog box.

Cancdl Exits the Interchange Selection Criteria dialog box.

Help Accesses Online Help.
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| nter change Sear ch Dialog Box

Diagram  Thefollowing illustrates the Interchange Search dialog box:

Interchange Search [ x|
Partner I,e:'._ll j
Direction: ' Both ' Inbound " Outbound

Contral Mumber: I

— Inbound Criteria

[ Becsived Between: |2Dnnf02;14 132545 j and |2nnwuzz14 132545 j

— Outbound Criteria

Proceszed Status: IMI j
Metwork Status: I;_-,'" j
Aok Status: IA" j
| Sent Betiween: IEDDDHD%H 13245 j At |2EIEIDJDE.-"14 132545 j

Find I Cancel | Help |

Partsand  Thefollowing lists the parts of the Interchange Search dialog box and their
functions  functions:

Part Function

Partner Select apartner profile ID (default is All).

Direction Choose Both (inbound and outbound), Inbound, or
Outbound.

Control No. Specify acontrol number.

Received Between Define arange of dates and times to search (in
YYYY/MM/DD and HH:MM:SS format) for
received interchanges.
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Part

Function

Processed Status

Select the processed status of the interchangesto

search for. Valid values:

» All (default)

» Received

»  Sent

» ReadyToSend
» Queued

» Held

» SendFailed

Network Status

Select the network status of the interchangesto

search for. Valid values:

» All (default)
» NotSent
» ReceivedOK

» ReceivedWarning
» ReceivedError

» PickedUp
» ThirdParty
Ack Status Select the acknowledgement status of the
interchanges to search for. Valid values:
» All (default)
» ReconcileNotRequired
» ReconcileWaiting
» ReconciledOK
» ReconciledError
» ReconciledPartial
» ReconciledReject
» ReconcileOverdue
Sent Between Define arange of dates and timesto search (in

YYYY/MM/DD and HH:MM:SS format) for sent

interchanges.

Note

Click the arrow to access the calendar control.
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Interchange Search Dialog Box

Part Function
Find Finds the appropriate interchanges based on the
criteriayou selected and displays them in the Search
Results Dialog Box.
Cancel Exits the dialog box.
Help Accesses Online Help.
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Group Search Dialog Box

Diagram  Thefollowing illustrates the Group Search dialog box:

Group Search E
Partrer I.&II j
Direction: ' Bath " Inbound " Outbound

Cantral Humber: I

Group [d: I

Ak Status: IA" ﬂ

Partsand  Thefollowing lists the parts of the Group Search dialog box and their functions:

functions
Part Function

Partner Select apartner profile ID (default is All).

Direction Choose Both (inbound and outbound), Inbound, or
Outbound.

Control No. Specify control number.

Group ID Specify group identifier.

Ack Status Select the acknowledgement status of the groups to
search for. Valid values:
» All (default)

» ReconcileNotRequired
» ReconcileWaiting

» ReconciledOK

» ReconciledErrors

» ReconciledPartial

» ReconciledReject

» ReconcileOverdue

Find Finds the appropriate groups based on the criteria
you selected and displays them in the Search Results
Diaog Box.
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Group Search Dialog Box
Part Function
Cancel Exits the dialog box.
Help Accesses Online Help.
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Diagram  Thefollowing illustrates the Document Search dialog box:

Document Search El
Partner IE ﬂ
Direction: i+ Both " Inbaund (" Duthaund
Contral Mumber: |
Tranz Id: |
Ref Data: | [ Exact match
Drocument Mame: | [~ Exact Match
Ack Status: | Al j
Find | Cancel ‘ Help ‘

Partsand  Thefollowing lists the parts of the Document Search dialog box and their

functions  functions:

Part Function
Partner Select apartner profile ID (default is All).
Direction Choose both (inbound and outbound), Inbound, or

Outbound.

Control Number

Specify a control number.

Trans|D

Specify atransaction identifier.

Ref Data

Specify the reference data from the trandlation object.

Document Name

Specify the document name established for the
trandlation object.
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Document Search Dialog Box

Part

Function

Ack Status

Select the acknowledgement status of the documents
to search for. Valid values:

All (default)
Received
ReconcileWaiting
ReconciledOK
ReconciledErrors
ReconciledPartial
ReconciledReject
ReconcileOverdue

Exact Match

Searches for an exact match of the field, instead of a
partial match (the default).

Find Finds the appropriate documents based on the criteria
you selected and displays them in the Search Results
Dialog Box.

Cancel Exits the dialog box.

Help Accesses Online Help.
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Mailbox Archive Definition Dialog Box

Diagram  Thefollowing illustrates the Mailbox Archive Definition dialog box:

Mailbox Archive Definition

M arme: I
[T Delete Data After Archive
— Selection Criteria
add | Edr | D |
i ailbox | Lacation | Daps Old | Content Type |
TCave Cancel Help

Partsand  Thefollowing lists the parts of the Mailbox Archive Definition dialog box and

functions their functions:

Part

Function

Name

Specify the name of the archive definition file.

Note
This name must be unique.

Delete Data After
Archive

Tell the system to remove the message data after
archivingiit.

Add

Accesses the Mailbox Selection Criteria Dialog Box
and enables you to define new archive criteria.

Edit

Accesses the Mailbox Selection Criteria Dialog Box
for the selected mailbox criteria and enables you to
modify the archive criteria.
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Part Function

Delete Deletes the selected mailbox criteriafrom the system.

Warning
The system removes the criteria without prompting
you to confirm the deletion.

Mailbox Displays the mailbox name.

Location Displays the location of the messages.

Days Old Displaysthe age (in days) of the messagesto be
archived.

Status Displays the status of the messages that are to be

archived. The default is All.

Content type Displays the content type of the messages. The
default selection is Any.

Save Saves the archive definition and exits the Mailbox
Archive Definition dialog box.

Cancel Exits the Mailbox Archive Definition dialog box.

Help Accesses Online Help.
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Mailbox Selection Criteria Dialog Box

Diagram  Thefollowing illustrates the Mailbox Selection Criteria dialog box:

M ailbos |A|| ﬂ
Location: * Bath  Inbox " Dutbox
Days Old; ID—
Status: I Al j
Content Type: I,.f_m_.lJ ﬂ
Help |

Partsand  Thefollowing liststhe parts of the Mailbox Selection Criteriadialog box and their
functions  functions:

Part Function

Mailbox Select amailbox (default All).

Location Choose Both (Inbox and Outbox), Inbox, or Outbox.

Daysold Specify the age (in days) of the messages to be
archived.

Status Select the status of the messages that are to be
archived. Valid values:

» All (default)

» Delivered

» Picked Up

» Read

» Sent

» Sent Third Party
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Mailbox Selection Criteria Dialog Box

Part

Function

Content type

Select the content type of the messages. Valid values:

Note
This edit box allows you to enter any content type
you created.

Any (default)
Application/EDI
Application/Document-EDI
Application/Import

Application/rosettanet-agent (only if Sterling
Gentran; Server for RosettaNet is installed)

Save

Saves the selection criteria and exits the Mailbox
Selection Criteria dialog box.

Cancel

Exitsthe Mailbox Selection Criteria dialog box.

Help

Accesses Online Help.
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Mailbox Search Dialog Box

Diagram  Thefollowing illustrates the Mailbox Search dialog box:

Mailbox Search
b il [ =]
Locatior: " Both T Inbox " Quthox
Status: Ia‘-‘«ll j
Content Tupe: |An_l,l j

V| Crested Betwesr:  [2000/02/1¢ 130253 v| and [2000/02/14 130259 |

I¥| Sert Bebwest: |2DDDJ|32£14 13:02:59 j - |2|:|u|:|,4|:|2,'14 130253 j

| Received Betweer: |2000/02/14 130259 7| and | 2000/02/14 130289 7|

Cancel | Help |

Partsand  Thefollowing liststhe parts of the Mailbox Search dialog box and their functions:

functions
Part Function

Mailbox Select amailbox (default is All).

Location Choose Both (Inbox and Outbox), Inbox, or Outbox

Status Select the status of the messagesto be archived. Valid
values.
» All (default)
» Sent
» Read
» Delivered
» FPicked Up
» Sent Third Party

Content type Select the content type of the messages. The default
isAny, but you can typein any content type you have
created.
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Part Function
Created Between Define a created between range of dates and timesto
search (in YYYY/MM/DD and HH:MM:SS format).
Note
Click the arrow to access the calendar control.
Sent Between Define a sent between range of dates and times to

search (in YYYY/MM/DD and HH:MM:SS format).

Note
Click the arrow to access the calendar control.

Received Between

Define areceived between range of dates and times
tosearch (in YYYY/MM/DD and HH:MM:SS
format).

Note
Click the arrow to access the calendar control.

Find Finds the appropriate messages based on the criteria
you selected and displays them in the Search Results
Dialog Box.

Cancdl Exits the Mailbox Search dialog box.

Help Accesses Online Help.
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External Data Archive Definition Dialog Box

Diagram  Thefollowing illustrates the External Data Archive Definition dialog box:

External Data Archive Definition B |

Mame; Etcsl

[V Delete Data &fter Archive

Selection Crtena
add |

Action Taken | Days Old | Avchive Ex Data Fies |
&l a ez

Save Cancel Help
| l

Partsand  Thefollowing lists the parts of the External Data Archive Definition dialog box
functions  and their functions:

Part Function
Name Specify the name of the archive definition file.
Note
This name must be unique.
Delete Data After Tell the system to remove the message data after
Archive archiving it. Thisis selected by default.
Add Accesses the External Data Selection Criteria Dialog

Box and enables you to define new archive criteria.

Edit Accesses the External Data Selection Criteria Dialog
Box for the selected mailbox criteriaand enablesyou
to modify the archive criteria.

Delete Deletes the selected external data criteriafrom the
system.

Warning
The system removes the criteria without prompting
you to confirm the deletion.
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Part

Function

Action Taken

Displays the action taken on the external datafile.
Value values:

» All (default value)
» ProcessFile
» MBProcessFile

» Import

» MBImport
» Send

» Export

Daysold

Displaysthe age (in days) of the external datafilesto
be archived.

Archive Ext DataFiles

Displays the archived external datafiles.

Save Saves the archive definition and exits the External
Data Archive Definition dialog box.

Cancel Exits the External Data Archive Definition dialog
box.

Help Accesses Online Help.
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External Data Selection Criteria Dialog Box

Diagram  Thefollowing illustrates the External Data Selection Criteria dialog box:

E xternal D ata Selection Criteria E3
Action Taken: |A|| j
Draps Old: ||:|
[ Archive Files

Cancel | Help

Partsand  Thefollowing liststhe parts of the External Data Selection Criteriadialog box and
functions  their functions:

Part Function

Action Taken Select the action to be taken on the external datafile.
Value values;

» All (default value)
» ProcessFile
» MBProcessFile

» Import
» MBImport
» Send
» Export
Daysold Specify the age (in days) of the external datafilesto
be archived.
Archive Files Indicate that the external data fileswill be archived.
Save Saves the selection criteria and exits the External
Data Selection Criteriadialog box.
Cancel Exits the External Data Selection Criteria dialog box.
Help Accesses Online Help.

Sterling Gentran:Server — May 2011 User Guide



Using Archive and Restore

External Data Search Dialog Box

External Data Search Dialog Box

Diagram  Thefollowing illustrates the External Data Search dialog box:

External Data Search

peon ke, T~

: |

Original Filename: |

[~ ExactMatch

External ata ke |

Fird |

Cancel Help

Partsand  Thefollowing lists the parts of the External Data Search dialog box and their

functions  functions:

Part

Function

Action Taken

Select the action to be taken on the external datafile
for which to search. Value values:

» All (default)
» ProcessFile
» MBProcessFile

» Import

» MBImport
» Send

» Export

Action Performed
Between

Define arange of dates and times on which to search,
defining when the action was performed on the
externa datafile(inYYYY/MM/DD and
HH:MM:SS format).

Note
Click the arrow to access the calendar control.

Original Filename

Specify the original name of the external datafile for
which to search.

External DataKey

Specify the external data key for which to search.

User Guide
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Part Function

Exact Match Searches for an exact match of the field, instead of a
partia match (the default).

Find Finds the appropriate messages based on the criteria
you selected and displays them in the Search Results
Diaog Box.

Cancel Exits the External Data Search dialog box.

Help Accesses Online Help.
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Search Results Dialog Box

Diagram

Parts and

User Guide

functions

Search Results Dialog Box

The following illustrates the Search Results dialog box, illustrating the result of a
search performed on archived mailbox messages:

Search Results
Archive Hame | Mailbos | Meszage Id | Location | Time Created | -
SWHATETTEMH...  MyCollectl B2 Outhos 01/06/00 15:15:04
SWATETTEMH...  MyCollectl B3 Outhos 01/06/00 15:15:05
SWATETTEMH...  MyCollectl B4 Outhos 01/06/00 15:15:06
SWHATETTEMH...  MyCollectl BS Outhos 01/06/00 15:15:09
SWHATETTEMH...  MyCollectl! BB Outhos 01/06/00 15:15:14
SWATETTEMH...  MyCollectl B7 Outhos 01/06/00 15:15:16
SWATETTEMH...  MyCollectl B8 Outhos 01/06/00 15:15:17 |
SWHATETTEMH...  MyCollectl B39 Outhos 01/06/00 15:15:18
SWHATETTEMH...  MyCollectt 71 Outhos 01/0B/00 15:15:25
SWATETTEMH...  MyCollectl 72 Outhos 01/0B/00 15:15:26
SWATETTEMH..  MyCollectl 73 Outhos 01/08/00 15:15:27
SWATETTEMH...  MyCollectl 74 Outhos 01/06/00 15:15:28
SWATETTEMH...  MyCollectl 75 Outhos 01/08/00 15:15:33
SWHATETTEMH...  MyCollectl 76 Outhos 01/06/00 15:15:34
SWHATETTEMH...  MyCollectl 77 Outhos 01/06/00 15:15:35
SWATETTEMH...  MyCollectl 78 Outhos 01/06/00 15:15:36
SWATETTEMH...  MyCollectl 79 Outhos 01/06/00 15:15:45
SWHATETTEMH...  MyCollectl 80 Outhos 01/06/00 15:15:47
SWHATETTEMH...  MyCollectl B2 Outhos 01/06/00 15:15:04
SWATETTEMH...  MyCollectl B3 Outhos 01/06/00 15:15:05
SWATETTEMH...  MyCollectl B4 Outhos 01/06/00 15:15:06
SWHATETTEMH...  MyCollectl BS Outhos 01/06/00 15:15:09
SWHATETTEMH...  MyCollectl! BB Outhos 01/06/00 15:15:14
SWATETTEMH...  MyCollectl B7 Outhos 01/06/00 15:15:16
SWATETTEMH...  MyCollectl B8 Outhos 01/06/00 15:15:17
SWHATETTEMH...  MyCollectl B39 Outhos 01/06/00 15:15:18
SWATETTEMH...  MyEstractl 70 Inbox 01/06/00 15:15:04
SWHATETTEMH...  MyCollectt 71 Outhos 01/0B/00 15:15:25
SWATETTEMH...  MyCollectl 72 Outhos 01/0B/00 15:15:26
SWHATETTEMH...  MyCollectl 73 Outhos 01/06/00 15:15:27 LI

b ark All | Eresinms | [d[Ewk |
Mt Enmark: | Help | Cloze |

The following lists the parts of the Search Results dialog box and their functions:

Part Function
(list) Displays context-specific information, depending on
whether you searched for interchanges, groups,
documents, messages, or external data.
Mark All Marks all itemsin the Search Results dialog box to

be restored.
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Part Function

Previous Selects the previous item in the list.

Note
This button is only enabled if you select an archive
file.

Next Selects the next item in the list.

Note
This button is only enabled if you select an archive
file.

Mark/Unmark Flags the selected item to be restored (or deselect a
previously selected item).

Note
Thistoggle button isonly enabled if you select an
archivefile.

Help Accesses Online Help.

Close Exits Search Results dialog box.
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Sort Preferences Dialog Box

Diagram  Thefollowing illustrates the Sort Preferences dialog box, which enables you to

select how you want the archive data sorted in the Archive tree view:

Select how you want your archives sorted

in the dizplay:

6- L
" By Filename

How toaccess  Select Preferences from the Archive menu.

Partsand  Thefollowing lists the parts of the Sort Preferences dialog box and their
functions  functions:
Part Function

Select how you want Select one of the following methods of sort order:

your archivessorted in |} Date/Time

the displ

R » Filename
OK Implements the selected sort order and exits the
dialog box.
Cancels Exits the dialog box without changing the sort order.
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Creating an Archive Definition

Procedure  To create an archive definition file, complete the following steps:

Sep

Action

1

From the appropriate area of The Desk, select Archive.

System response
The system displays the Archive Manager.

Expand the Archive tree.

Note
Thisis necessary to create a new archive definition.

Right-click Definitions under EDI, Mailbox, or External Data, and
select New from the shortcut menu to define archive parameters.

System response

The system displays the EDI Archive Definition Dialog Box, the
Mailbox Archive Definition Dialog Box, or the External Data
Archive Definition Dialog Box.

In the Name box, type the name of the archive definition.

Do you want the system to remove the data from the Sterling
Gentran:Server system after archiving it?

» If yes, select the Delete Data After Archive check box and
continue with the next step.

» If no, continue with the next step.

Click Add.

System response
The system displays the appropriate Selection Criteria dialog box.
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Creating an Archive Definition

Sep Action

7 Complete the appropriate parameters.
References
See the following for more information:
» Interchange Selection Criteria Dialog Box on page 10 - 13
» Mailbox Selection Criteria Dialog Box on page 10 - 24
» External Data Selection Criteria Dialog Box on page 10 - 30
Note
All elements on the Selection Criteria dialog boxes are
automatically set to the defaults, which resultsin the archival of all
data.

8 Click Save.
System response
The system exits the Selection Criteria dialog box.

9 Do you want to create additional archive criteria?
» If yes, repeat Steps 6 through 8.
» If no, continue with the next step.

10 Click Save on the appropriate Archive Definition dialog box.
System response
The system creates an archive definition file that contains the
archive parameters. The definition file is stored with an . ARD
extension.

11 Use this table to determine your next step.

I F you want to... THEN...

edit the archive criteria, select the appropriate item on the
appropriate Archive Definition
dialog box and click Edit.

delete archive criteria, select the appropriate item on the
appropriate Archive Definition
dialog box and click Delete.

Sterling Gentran: Server — May 2011



Archiving Data Using Archive and Restore

Archiving Data

Beforeyou begin  Beforearchiving data, you must create an archive definition file that contains your
selection criteria

Reference
See Creating an Archive Definition on page 10 - 36 for more information.

Procedure  To archive data, complete the following steps:

Sep Action

1 Use your company’s computer backup process to back up the
Sterling Gentran: Server system before executing the archive process.

2 From the appropriate area of The Desk, select Archive.

System response
The system displays the Archive Manager.

3 Expand the archive tree and open the appropriate Definitions folder.

4 Right-click the appropriate archive definition and select Archive Data
from the shortcut menu.

System response

» Thesystem executesthe archive process. An interactive progress
dialog box displays the current state of the archive process and
enables you to cancel the archive, if necessary.

» The system archives the data by the parameters you specified
and creating anew file in the Archivesfolder.

Naming convention

The system naming convention for creating the archive files uses the
same name of the archive definition file, plus the unique date and
time of archival, with an .ARV file extension.

5 When the archive process is complete, right-click the appropriate
Archive folder in the Archive Manager tree view and select Refresh.

System response
The system displays the archive file along with the date and time on
which the archive data file was created.
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Viewing Archived Data

Procedure

User Guide

To view archived information, complete the following steps:

Step

Action

1

From the appropriate area of The Desk, select Archive.

System response
The system displays the Archive Manager.

Expand the archive tree and open the appropriate Archives folder.

In the Archive folder, locate the archive datafile for which you want
to view the contents (summary or detailed) or search for a specific
piece of data, and click the “+” to the left of that file.

System response
The system displays the archived files. When you select an archive
file, the system displays summary information for each item.

Reference
See Archive Manager on page 10 - 5 for details about the
information available at each level.

Select Preferences from the Archive menu, choose how you want
your archive data sorted in the Archive tree view, and click OK.

To view additional information, select the appropriate level of the
tree and use the following table to determine your next action.

Note
N/A indicates that the information that the system displays when
you selected the specified item.

IF you want to view the... THEN perform thisaction...

archive file information select the archivefile.
(displayed in the Archive
Manager, upper-right pane)

interchange information select the inter change.
(displayed in the Archive
Manager, upper-right pane)
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Sep

Action

5

(contd)

interchange data audit
(displayed in the Archive
Manager, upper-right pane)

» right-click theinterchange and

» select View\Data Auditsfrom
the shortcut menu.

interchange tracking
information (displayed in the
Archive Manager, upper-right
pane)

» right-click theinterchange and

» select View\Tracking Info
from the shortcut menu.

interchange file (displayed in
an external viewer)

» right-click the interchange and

» sdlect View\Data\External
Viewer from the shortcut
menu.

interchange file (displayed in
the Archive Manager, lower-
right pane)

» right-click the interchange and

» sdlect View\Data\Screen from
the shortcut menu.

group information (displayed | select the group.

in the Archive Manager,

upper-right pane)

document information select the document.

(displayed in the Archive
Manager, upper-right pane)

document data audit
(displayed in the Archive
Manager, upper-right pane)

» right-click the document and

» select View\Data Auditsfrom
the shortcut menu.

document tracking
information (displayed in the
Archive Manager, upper-right
pane)

» right-click the document and

» select Viem\Tracking Info
from the shortcut menu.

document file (displayed in an
external viewer)

» right-click the document and

» select View\Data\Exter nal
Viewer from the shortcut
menu.

document file (displayed in
the Archive Manager, lower-
right pane)

» right-click the document and

» select View\Data\Screen from
the shortcut menu.
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Viewing Archived Data

Sep Action
5 message information select the message.
(contd) | (displayed in the Archive
Manager, upper-right pane)
message data audit (displayed right-click the message and

in the Archive Manager,
upper-right pane)

select View\Data Audits from
the shortcut menu.

attachment information
(displayed in the Archive
Manager, upper-right pane)

select the attachment.

attachment data audit
(displayed in the Archive
Manager, upper-right pane)

right-click the attachment and

select View\Data Audits from
the shortcut menu.

attachment file (displayed in
an external viewer)

right-click the attachment and

select View\Data\Exter nal
Viewer from the shortcut
menul.

attachment file (displayed in
the Archive Manager, lower-
right pane)

right-click the attachment and

select View\Data\Screen from
the shortcut menu.

external datainformation
(displayed in the Archive
Manager, upper-right pane)

select the exter nal datafile.

external data audit (displayed
in the Archive Manager,
upper-right pane)

right-click the external data
fileand

select View\Data Audits from
the shortcut menu.

external datafile (displayedin
an external viewer)

right-click the external data
fileand

select View\Data\Exter nal
Viewer from the shortcut
menul.
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Sep

Action

5
(contd)

external datafile (displayedin
the Archive Manager, lower-
right pane)

» right-click the external data
fileand

» select View\Data\Screen from
the shortcut menu.

System response

The system displays the information you requested.
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Searching Archived Data

Introduction  The Archive Manager Search facility enables you to quickly define parameters
that are used to search all archive files or one archive file and find a specific piece
of information. You can then select the desired information, and the system
highlightsit in the Archive Manager tree view.

Procedure  To search for a specific piece of archived data, complete the following steps:

Sep Action

1 From the appropriate area of The Desk, select Archive.

System response
The system displays the Archive Manager.

2 From the Archive Subsystem tree, select the appropriate (Gentran
EDI, Mailbox, or External Data) Archivesfolder.

3 From the Archives menu, select Search and then select one of the
following:

M essage
Interchange
Group
Document
External Data

System response
The system displays the appropriate Search Dialog Box.

4 Select the appropriate parameters.

Note
If you do not change any parameters on a search dialog box, the
system finds the default (all items).

5 Click Find to execute the search.

System response
The system displays the Search Results Dialog Box.

Reference
See Archiving Data on page 10 - 38 for more information about the
actions you can perform on the Search dialog box.

6 Click Close to exit the Search Results dialog box.
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Restoring Archived Data

Overview

Restorefeature  The Restore feature enables you to view and reprocess data via the Restored
Interchanges browser. When data is restored, the archive datafile (*.ARV file) is
not atered.You can restore data from the same archive file again, if you wish.

Restorecaveats To restore datato your system, the following must be true:
» Theitem must have been deleted after it was archived.
» For message data, the original mailbox must still exist on your system.

Note
If the original mailbox does not exist, Archive Manager attempts to recreate it.
This facsimile mailbox does not contain al the properties of the original one.

Reference
See Creating an Archive Definition on page 10 - 36 for more information about
the post-archive delete function.

Moving archive  Asthe number of archive data files created by the Archive function increases and
filestotape corresponding disk spaceis used, you may determine that you want to move
archive datafiles to tape.

Note

Copying archive filesto tape is not part of the Sterling Gentran: Server
functionality. If you move an archivefile to tape, the Archive Search facility isno
longer aware of the existence of thefile. Filesthat are moved to tape cannot be
viewed while on tape. However, if you reload an archive file from tape to the
Archivesfolder, you can once again view the data via the Archive Manager.

Recommendation
Use some type of tape management system to track the archive files saved to tape.
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Procedure

User Guide

Overview

To restore archived data, compl ete the following steps:

Step

Action

1

From the appropriate area of The Desk, select Archive.

System response
The system displays the Archive Manager.

Expand the archive tree and locate the item that you want to restore.

Right-click the item and select Mark\Unmark from the shortcut
menu.

System response
The system flags that item for restoration.

Click Restore Data.

System response
The marked datais restored to your system.

Note
If the system is unable to restore data, you are prompted to view the
Audit Log for detailed information about why the failure occurred.

Use the following table to determine how to view the restored data.

|Ftherestored data

wasan... THEN you can view thedatain the...

interchange, Restored Interchanges browser.
Reference
See How to View Restored Interchanges for
more information.

message, Mailbox subsystem.

Reference

See the IBM® Serling Gentran: Server® for
Mi crosoft Wi ndows Communi cations Guide for
more information.

external datafile, | Externa Data Summary viewer.

Reference
See Viewing External Data Fileson page 6 - 8
for more information.
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Restored | nterchanges Browser

Introduction  The Restored Interchanges browser enables you to view alist of all interchanges,
groups, and documents that were restored from an archive file. This browser
contains status information about the interchanges, such as whether a functional
acknowledgement was received and the status of that acknowledgement.

Information  Theinformation about the Restored Interchanges browser is organized in a
organization hierarchical manner. The following table describes the hierarchica organization
of the information on the Restored Interchanges browser.

Information displayed (in middle pane)

Level How to access (all information may not appear)
Interchange | Open Restored » direction of the interchange
I nterchanges browser

» date and time the interchange
was created

» partner name

» control number

» interchange process status
» network status

» interchange acknowledgement
status

» message status

Note

If any of these components are
missing or not appropriate for a
particular interchange, they are not

displayed.

Group Double-click an » group control number
interchange »  group type
» group acknowledgement status

Note

If any of these components are
missing or not appropriate for a
particular group, they are not

displayed.
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Browser
functions

Restored I nterchanges Browser

Information displayed (in middle pane)
Leve How to access (all information may not appear)

Document Double-click agroup » document compliant status

» document control number

» document type

» document name

» reference data

» document compliant status

» transaction acknowledgement
status

Note

If any of these components are
missing or not appropriate for a
particular document, they are not

displayed.
document Double-click adocument | document data
data
Note
A screen entry
tranglation object for that

document must available
on your system.

You can perform the following functions on the Restored | nterchanges browser:

» Filter the display of interchanges by date, partner, and direction (inbound and
outbound) from the Interchanges Filter dialog box.

» Display the external data, raw-EDI data, and trandator report data for the
selected interchange or document in the appropriate browser panes.

Note
When viewing raw-EDI or external data, you can switch from Text to Hex
format by selecting the appropriate command from the View menu.

» Toggle the status of interchanges between Ready to Send and Hold.
» Print or delete a selected item.
Note

You might want to use the toggle function if you do not want to send an
interchange right away.
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Diagram  Thefollowing illustrates the Restored Interchanges browser:

& Restored Interchanges Summary - 2 [ [O]*]
== I.-’-'«II Farthers IDate.-"Time Checking iz Off.
N Root Cantrol Humber | Type | Doz, Mame | Referenc FIDEPETTEST  XO00307 4
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M HE0001-FETZONE ] _’lJ
I-fE=105412/2002 12:46 PM-PET TGP 0505107555558
EH:‘ 4-PETZONE REF*BH*ESSSSSSESE._
.| D004-PETZOME 1 *VH*VENDOR AN~
4] _I_I
Docunent Sunmary |
Trading Partner:
4 ] {1 | e _|J

Partsand  Thefollowing lists the parts of the Restored Interchanges browser and their
functions  functions:

Part Function

Status bar Reflectsthefiler specifications from the Interchange Filter
Dialog Box on page 7 - 8.

Note
The Electronic Commerce Manager status bar is updated
when you select asingle item from the middle pane.

left pane— Displaysalist of al the restored interchanges, groups, and
Interchangestree | documents. Also displays the time created and partner
name.
Note

To refresh the display of the Restored Interchanges
browser, press F5.

Reference
See the following for more information:

» Archiveinformation available to view on page 10 - 5
» Document level statusicons on page 10 - 50
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Part Function

middle pane— Displays detailed information about the document, group,
detailed list or interchange selected. The information displayed
depends on the level.

Note
» Toselect multipleitems, pressand hold the CTRL key
while selecting the items.

» Torefreshthedisplay of the Interchanges browser,
right-click the middle pane and select Refresh from the
shortcut menu (or press F5).

upper right pane— | Displays the datafile used in trandation (if this option is
External Data selected from the View\Restored | nterchanges menu).

Notes

» Thisoption only availableif asingleitem is selected
from the detailed list.

» Thisoptionisnot availableif the external datafile
used in tranglation does not exist.

» When viewing raw-EDI or External Data, you can
switch from Text to Hex format by selecting the
appropriate command from the View menu.

middle right Displaysthe datain EDI format (if this option is selected
pane—Gentran from the View\Restored | nterchanges menu).
Data

Notes

» Thisoption only availableif asingleitemis selected
from the detailed list.

» When viewing raw-EDI or External Data, you can
switch from Text to Hex format by selecting the
appropriate command from the View menu.

lower right pane— | Displays areport of the actions the translator took on this
Translator Report | document and lists any EDI- or translation object-based
compliance errors (if this option is selected from the
View\Restored Interchanges menu).

Note
This option only available if asingle item is selected from
the detailed list.

Reference

See Error Messagesin the IBM® Serling

Gentran: Server® for Microsoft Windows Administration
Guide, for a detailed explanation of translator reports.
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Document level  Thefollowing lists the status icons that the system may use at the document level
statusicons  on the Restored Interchanges browser:

Satus

Icon

Description

OK

(&3

(green) — Indicates that the documents are fully compliant
with the EDI standard and are eligible for further
processing.

NotOK

(red) — Indicates one of the following:

The document failed to comply with the EDI standard.
If thisisthe cause of the error, the errors will be
indicated on atrandator report associated with the
document. Although the document is not fully
compliant, it is eligible for further processing.

The received document could not be associated with a
specific trading partner. If thisis the case, the partner
listed for the document will be Unknown. To associate
this document and the other documents received in the
interchange with a partner, attach the documents from
the Interchange browser.

A suitable trading relationship or trandation object
could not be associated with the document. Detailed
information concerning what information was used to
locate the rel ationship and/or the transl ation object will
be listed in the audit log. To correct this problem, a
valid relationship must be established using the Partner
Editor, and avalid export, print, or turn-around
trandlation object must be defined for that relationship.

A magjor error occurred while processing the
interchange, functional group, or transaction level
enveloping structures. This error may include header
and trailer control numbers that do not match, an
invalid trailer control count, or a control number
seguence checking error. If any of these errors occur,
they will be listed on the tranglator report for the
interchange containing the document

Duplicate

(yellow) — Indicates the document has the same name as
another document on the system.
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Viewing Restored I nterchanges

Procedure

User Guide

To view restored interchanges, complete the following steps:

Step

Action

1

From the appropriate area of The Desk, select Restored
I nterchanges.

System response
The system displays the Restored I nterchanges Browser.

Note
To refresh the display of the Interchanges browser, right-click the
middle pane and select Refresh from the shortcut menu (or press F5).

Do you want to filter the display of interchanges by status?

» If yes, seeFiltering the Display of Restored I nterchanges on page
10- 53.

» If no, continue with step 3.
Note

The Filter function enables you to filter the display of restored
interchanges by date, partner, and direction (inbound and outbound).

Select an interchange.

Use the following table to determine your next step.

| F you want to... THEN select...
view the content of a » Restored Interchanges from the
single selected View menu, and then
interchange in raw EDI » select Gentran Data from the
data format, submenu.

Note

When viewing raw-EDI or external data,
you can switch from Text to Hex format
by selecting the appropriate command
from the View menu.
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Step

Action

4
(contd.)

view the corresponding
external datafile,

» Restored Interchanges from the
View menu, and then

» select External Data from the
submenu.

Note

When viewing raw-EDI or external data,
you can switch from Text to Hex format
by selecting the appropriate command
from the View menu.

view the trandator report
for asingle selected

» Restored Interchanges from the
View menu, and then

interchange, » select Translator Report from the
submenu.
print a selected Print from the File menu.

interchange or a summary
of interchanges,

delete a selected
interchange and all
associated documents,

» If you delete an interchange with a

Delete from the Document menu.

Notes

» If you delete an interchange with a
status of Queued, you receive a
warning that you must remove
specified messages from Out
Documents and from your trading
partner’s Inbox. If you proceed, you
are warned that if your partner bases
processing results on control number
seguencing, you should modify the
transaction, group, and interchange
control numbers.

status of Ready to send, you are
warned that if your partner bases
processing results on control number
sequencing, you should modify the
transaction, group, and interchange
control numbers.
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Filtering the Display of Restored I nterchanges

Procedure

User Guide

To filter restored interchanges by partner and/or date, complete the following

steps:

Step

Action

1

From the appropriate area of The Desk, select Restored
I nterchanges.

System response
The system displays the Restored I nterchanges Browser.

From the Commands menu, select Filter.

System response
The system displays the Interchange Filter Dialog Box.

Do you want the system to filter the display of interchanges by date
and time?

» If no, select the No Date/Time Checking check box and proceed
with step 6.

» If yes, clear the No Date/Time Checking check box and proceed
with step 4.

Use the Date From slide bar to select the beginning of the date range
from which the system should filter the display of interchanges.

Do you want the end date for the date range to always be the current
system date and time?

» If no, deselect the Always Current check box and move the Date
To dlide bar to the end of the date range.

» If yes, select the Always Current check box.

Do you want to filter the display of restored interchanges by partner?
» If no, continue with step 7.

» If yes, select the partners that you want displayed from the
Partner list (which containsalist of all the partner profiles on
your system).

Note

The default display is all partners, but you can click partner profiles
to unselect them and change the display. Alternately, you can click
Unselect All Partnersto clear al the partner profiles. You can then
click one or more profilesto select them. At least one partner must be
selected.
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Sep Action

7 Which direction do you want to filter the interchange?

Default
The default display is both inbound and outbound interchanges.
Click the Inbound or Outbound check box to clear the direction.

Note
At least one of the Direction check boxes must be selected.

8 Click OK.

System response
The system filters the restored interchange display based on the
criteriayou selected.
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Viewing Restored Documents

Introduction  You can view theindividual documentsin an interchange as long as a screen entry
translation object for each document is available on your system.

Procedure  To view the documents within arestored interchange, complete the following
steps:

Sep Action

1 From the appropriate area of The Desk, select Restored
Interchanges.

System response
The system displays the Restored | nterchanges Browser.

Note

To refresh the display of the Interchanges browser, right-click the
middle pane and select Refresh from the shortcut menu (or press
F5).

2 Select a document and proceed with the next step or double-click a
document to view it.

Note
You must have a screen entry translation object for this document
available on your system.
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Sep Action

3 With adocument selected, use this table to determine your next step.

| F you want to... THEN select...

view atrandator report of the | »  Interchangesfrom the View
actions the transl ator took on menu, and then

this document, » select Trandator Report.

view the content of asingle |» Interchangesfrom the View
selected interchange in raw menu, and then

EDI dataformat, » select Gentran Data from the

submenu.

Note

When viewing raw-EDI or external
data, you can switch from Text to
Hex format by selecting the
appropriate command from the View
menu.

view therelated external data | »  Interchanges from the View

of asingle selected menu, and then
interchange, » select Related External Data
from the submenu.
Note

When viewing raw-EDI or external
data, you can switch from Text to
Hex format by selecting the
appropriate command from the View
menu.

print a selected document or | Print from the File menu.
tranglation report,

delete a selected document, Delete from the Document menu.

copy the document to the » Copy from the Document menu.

appropriate browser, »  select the appropriate browser
(?In Documents Browser or In
Documents Browser for
compliant Inbound documents;
Workspace Browser for
outbound documents) from the
submenu.
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Reprocessing Restored Documents

Introduction  To reprocess data from the Restored | nterchanges browser, you must use the Copy
command to move the selected outbound documents to the Workspace and the
compliant inbound documents to the In Documents or 2ln Documents browsers.

Procedure  To reprocess data, complete the following steps:

Sep Action

1 From the appropriate area of The Desk, select Restored
I nterchanges.

System response
The system displays the Restored | nterchanges Browser.

Note

To refresh the display of the Interchanges browser, right-click the
middle pane and select Refresh from the shortcut menu (or press
F5).

2 Select the documents that you wish to copy to the Workspace
Browser, In Documents Browser, or 2ln Documents Browser so you
can reprocess and/or resend them.

3 From the Document menu, select Copy.

4 Select the appropriate browser from the cascading menu to copy the
restored interchanges to that browser.
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Resending Restored | nterchanges

Introduction  To resend outbound interchanges from the Restored Interchanges browser, you
must use the Resend command.

Note

You can only resend interchanges that were previously sent or that have a status of
Ready to send.

Resend process  The following table describes the process that occurs when you resend a selected
interchange.

Stage

Description

1

The restored interchange is listed in the Restored Interchanges
Browser.

Reference
See Filtering the Display of Restored Interchanges on page 10 - 53
for instructions.

When the resend command is executed, the system first determinesif
itisaTRADACOMS interchange. If theinterchangeis
TRADACOMS, the system increments the current version number in
the FIL segment by one. After this update, theinterchangeisresentin
the same manner as all other interchanges.

Communication is established with the remote end. The status of the
message is updated based on the success or failure of the
communications session.

» If the communication fails because there is no mailbox set up or
because the Mailbox serviceis not started, the interchange and
documents are left in a Ready to send status.

» If communication fails because there is no modem, the
interchange and documents are left in a Queued status.

Note
No user action is required at this point. Interchanges that failed to
send are automatically sent as part of the next transmission session.

After communication is successful, the documents are moved to the
Out Drawer Browser and the interchange status is set to Sent.
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Procedure  To resend restored outbound interchanges, complete the following steps:

Sep Action

1 From the appropriate area of The Desk, select Restored
I nterchanges.

System response
The system displays the Restored I nterchanges Browser.

2 Select the outbound interchange that needs to be resent.

3 From the Document menu, select Resend.

System response
The system displays the Sterling Gentran: Server for Microsoft
Windows dialog box.

4 Click Yes to start the transmission session.
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| ntroduction

Inthischapter  This chapter explains how to use the Sterling Gentran: Server process control.

Processcontrol  Process control feature enables you to automate your message processing.
feature  Essentially, you need to tell the system what you want done and when, and
process control takes care of it for you automatically.

With process control, you can build customized events to initiate the processing
functions of Sterling Gentran:Server. These processing functions include the
following.

» importing datafrom your application files
» exporting datato your application files

» sending

» receiving

In addition, file and process management functions can be executed that provide
additional flexibility in integrating your application with Sterling Gentran:Server.

Event creation  Process control is regulated by events, which are a combination of what you want
process done (asession) and when to process a session (calendar, days, adate, or based on
whether or not afile exists). The following describes the event creation process:

Sage Description

1 Create a process control session.

Reference
See Creating Sessions on page 11 - 9 for more information.

2 Create a process control calendar (if necessary).

Reference
See Creating and Editing Calendars on page 11 - 41 for more
information.

3 Create the process control event.

Reference
See Creating New Events on page 11 - 23 for more information.

4 Activate the event.

Reference
See Activating and Suspending Events on page 11 - 36 for more
information.
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Sessons
Overview

Introduction

What is a session
script?

Process Control
dialog box
(Sessionstab)

Overview

A session definition is an integral part of a process control event. The session
setup process enables you to configure and edit process control session scripts.
Sessions are defined independently from the event, so the same session definition
can be scheduled multiple times.

A session script consists of alist of commands (Sterling Gentran: Server
functions) that the system executes in the sequence listed. You can set parameters
for each allowable command. You can aso place conditions on the command you
choose. These conditions determine whether or not the command is executed
within the session.

You can specify two types of conditions: The system can query for the presence or
absence of a specific file; the system can determine whether or not documents
exist in aspecific location. If the evaluated condition is true, the command is
executed. If the condition is false, the command is skipped and processing
continues with the next defined command.

Thefollowing illustrates the Sessions tab of the Process Control dialog box:

% Gentran:Server Process Control M= B3

Active Eventsl Eventsl Calendars  Sessions |

Sustem-duditPurge LS |System-AuditF'urge Hew
test
Command | Parm1 | Farmz | Parm3 | Farmd Sae |

GDW _Audit_Purge 3 YWRTETTE...

#E hid S onipt®® Save Az |
IEfere |

4| | B

Inz | Edit Delete e | [T |

[Earee| | Help
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Sessionstab  Thefollowing lists the parts of the Process Control dialog box Session tab and
partsand their functions:

functions .
Part Function
(list) Displays all currently defined session scripts.
Session Displays the script of the currently-selected session.
Ins Accesses the Action Setup dialog box so you can

insert a script command above the current line.

Edit Accesses the Action Setup dialog box so you can
modify the selected script command.

Delete Deletes the selected script command.

Up Moves the selected command up onelinein the
script.

Down Moves the selected command down onelinein the
script.

New Accesses the New Session dialog box so you can

create a new session.

Save Saves the current session script.
Save As Saves the current session script under another name.
Delete Deletes the selected session.
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dialog box parts
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Action Setup

Thefollowing illustrates the Action Setup dialog box:

— Command Specification

(]9

Command I

™ wiite bo Audit Log if execution time exceeds I minLkes

Cancel

Browse

dildll]

Help

— Condition

Condition

=

Thefollowing lists the parts of the Action Setup dialog box and their functions:

Part Function
Command Select which command you want to add to the script.
Specification

Note

Selecting a command allows you to access the
parameters for that command, which the system
displays in the Command Setup section.

Writeto Audit Log if
execution time exceeds

Specify that the system write an audit message if the
command execution time exceeds the specified
number of minutes (next field).

Note

If acommand exceeds the allotted time, the system
writes a warning message to the Audit Log and the
command continues to run until it completes.

minutes Specify the number of minutes after which the
system writes a message to the Audit Log if the
command has not finished processing.

Condition Select conditions for the command. These conditions

determine whether or not the command is executed
within the session.
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Commands Thefollowing lists the script commands and their actions:

Note

See the Sterling Gentran:; Server online Help for detailed information about these

commands.

Command

Action

Exec_Program

Indicates a program for the system to run.

Note

When this command is executed, the system writes
an informational messageto the Audit Log indicating
which program (command line in working directory)
was run.

Exec_Program_Ex

Indicates a program for the system to run and for
which the system will pass the Event ID and
controller name.

Note
Thisfunction is used by the Sterling Gentran: Server
for RosettaNet install program.

File_Copy

Copies afile.

Note

When this command is executed, the system writes
an informational message to the Audit Log indicating
that the file copy was successful.

File Rename

Changes the name of afile.

File Delete

Removes afile from the system.

Note

When this command is executed, the system writes
aninformational message to the Audit Log indicating
that the deletion of the file was successful.

GDW_Archive

Performs the archive command according to the
specifications of a selected archive definition file.

GDW_Audit_Rpt

Copies the audit records to a specified file.
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Command

Action

GDW_Audit_Purge

Deletes all audit recordsin the system.

Note

The purged Audit Log entries are removed from the
database and appended to atext file. To ensure that
the text file does not grow unchecked, you may want
to useaFile_Delete command prior to this command.

GDW_Audit_Write

Writes a processing user audit message to the Audit
Log, based on the specified parameters.

GDW_Document__
Purge

Removes document records from the Sterling
Gentran:Server database according to the specified
age/date, location, partner name, transaction, and/or
status.

GDW_Document_Rpt

Creates a specified file that contains document data
(aswell as group and interchange data, if applicable)
for documentsin the Sterling Gentran: Server
database according to the specified status, location,
and/or age/date.

GDW_Export

Performs the Export function and can perform the
send mailbox function to enable the output of an
inbound tranglation to be delivered back to the
Mailbox Server Manager.

Note
You must have an export trandlation object registered
with the system.

GDW_ExtData Delete

Deletes externa data references based on the action
taken on the external data and/or age.

GDW _Import

Performs the Import function on a specified file.

Note
You must have an import trand ation object registered
with the system.

GDW_Natify_Purge

Deletes dl notification records in the system or
deletes them by age, if specified.

Note

The purged notification log entries are removed from
the database and appended to atext file. To ensure
that the text file does not grow unchecked, you may
want to use a File_Delete command prior to this
command.

User Guide
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Command

Action

GDW _Partner_Delete

Executes the partner delete command.

GDW_Partner_Import

Executes the partner import command.

GDW_Partner_Export

Executes the partner export command.

GDW._Print

Performs the Print function.

Note
You must have a print trandation object registered
with the system.

GDW _Process File

Invokes the post-communications process with any
EDI file asif thefile was received viaa
communication session.

Note
You must have an export trandlation object registered
with the system.

GDW_Receive

Performs the Receive Only function.

GDW_Send

Performs an automated send for all partners and
mailboxes that have documents posted to be sent
(unlessyou specify a particular partner, mailbox, and
transaction combination).

GDW_Send_Receive

Performs the Send/Receive function. This function
does not wait for previously executed Send/Receive
sessions to finish; it executes the Send/Receive when

you specify.

Terminate_Script

Terminates the script.

The following lists the script conditions and their actions:

| F the condition is...

THEN it indicates that...

If File Below Exists

the system must ook for the file you specify and then
execute the command based on whether thefileis
found or not found.

If Docs Are Inthe
Location Below

the system must look for the documentsin the
location you specify and then execute the command
based on whether or not the documents are found in
that location.
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Creating Sessions

Procedure  To create a process control session, complete the following steps

Sep Action

Creating a session

1 Click Process Control on The Desk.

System response
The system displays the Sterling Gentran: Server Process Control
dialog box.

2 Click the Sessions tab to access the sessions options.

System response
The system displays the Process Control dialog box (Sessions tab).

3 Click New.

System response
The system displays the New Session dialog box.

4 In the Session Name box, type in the new session hame, using
a phanumeric characters.

Note
The dash (-) character is also allowed.

5 Click OK to add the new session.

Building the session script

1 With the new session currently selected, click Instoinsert a
command above the current line.

System response
The system displays the Action Setup dialog box. This dialog box
allows you to create script commands.

2 From the Command list, select a command.

Note

The Commandslist allows you to select which command you want to
add to the script, which enables you to access the parameters for that
command (displayed below this box in the Action Setup section.

After you choose a command, additional boxes may be displayed in
the Command Specification section of the dialog box.
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Sep

Action

Complete the boxes in the Command Specification section of the
dialog box with the appropriate values.

Reference
See Commands on page 11 - 6 for more information.

Do you want to specify alimit (in minutes) on how long this
command should process before the system writes a message to the
Audit Log?

» If yes, select the check box and type the number of minutesin the
box.

» If no, continue with the next step.

Do you want to apply a condition to the command?

» If yes, select acondition from the Condition list.

» If no, continue with Step 8.

Note

Each script command can have an associated condition. These

conditions are evaluated just prior to execution of the command and
can be used to control the processing flow of your session.

After you choose a condition, the system displays two additional
boxes in the Condition section of the dialog box.

Complete the boxes in the Condition section of the dialog box with
the appropriate values.

Note

If you selected the If file Below Exists condition, you can use a
wildcard (*) to specify the name of the file for which you want the
system to check.

Did you specify conditional execution?
» If yes, you must also select True or False from the Result list.
» If no, continue with the next step.

Notes

» If yousdlect True, you are indicating that the command should
only be executed if there are documents in the specific location
or if thefileis present.

» If you select False, you are indicating that the command should
be executed only if there are no documents in the specific
location or if the specified file does not exist.
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Sep

Action

Click OK.

System response
The command is saved and you return to the Sterling Gentran: Server
Process Control dialog box.

Repeat Steps 1 through 8 until you finish adding commands to the
Session script.

Notes
» If you need to resequence the commandsin the script, use Up and
Down.

» If you need to edit acommand in the script, select that command
and click Edit.

» If you need to delete acommand from a script, select that
command and click Delete.

Saving the session

Click Save to save the new session script.

Click OK to exit the Sterling Gentran:Server Process Control dialog
box.
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Introduction  If anevent callsasession that is currently processing or is activated, you are
unable to edit and save the session until the event has either finished processing or
you suspend the event. However, you can edit the session and use the Save As
function to save it under another name.

Reference
See Procedure: suspending an event on page 11 - 37 for more information.

Procedure  To edit an existing session, complete the following steps:

Sep

Action

1

Click Process Control on The Desk.

System response
The system displays the Sterling Gentran: Server Process Control
dialog box.

Click the Sessions tab to access the sessions options.

System response
The system displays the Process Control dialog box (Sessions tab).

Select a session to display the session script.

With the session selected, click Insto insert a command above the
current line.

System response
The system displays the Action Setup dialog box.

From the Command list, select a command.

Note

The Commandslist allows you to select which command you want to
add to the script, which enables you to access the parameters for that
command (displayed below this box in the Action Setup section.

Reference
See Commands on page 11 - 6 for more information.
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Sep Action
6 Do you want to specify alimit (in minutes) on how long this
command should process before the system writes a message to the
Audit Log?
» If yes, select the check box and type the number of minutesin the
box.

» If no, continue with the next step.

7 After you choose a command, additional boxes may be displayed in
the Command Specification section of the dialog box. Complete
these boxes with the appropriate val ues.

8 If you want to apply a condition to the command, select a condition
from the Condition list.

9 After you choose a condition, the system displays two additional
boxes in the Condition section of the dialog box. Compl ete these
boxes with the appropriate values.

Note

If you selected the If file Below Exists condition, you can use a
wildcard (*) to specify the name of the file for which you want the
system to check.

10 When you specify conditional execution, you must also select True
or False from the Result list.

Notes

» If you select True, you are indicating that the command should
only be executed if there are documentsin the specific location
or if thefileis present.

» If you select False, you are indicating that the command should
be executed only if there are no documents in the specific
location or if the specified file does not exist.

11 Click OK.

System response
The command is saved and you return to the Sterling Gentran: Server
Process Control dialog box.
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Sep Action

12 Repeat Steps 4 through 11 until you finish adding commands to the
session script. Use Up and Down if you need to resequence the
commands in the script.

Note
» If you need to edit acommand in a script, select that command
and click Edit.

» If you need to delete acommand from a script, select that
command and click Delete.

13 Click Save to save the new session script.

Note
If you want to save the session under another name, click SaveAs,
type the new session name, and click OK.

14 Click OK to exit the Sterling Gentran: Server Process Control dialog
box.
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Deleting Sessions

Introduction  If anevent callsasession that is currently processing or is activated, you are
unable to delete the session until the event has either finished processing or you
suspend the event.

Reference
See Procedure: suspending an event on page 11 - 37 for more information.

Procedure  To delete asession, complete the following steps:

Sep Action

1 Click Process Control on The Desk.

System response
The system displays the Sterling Gentran:Server Process Control
dialog box.

2 Click the Sessions tab to access the sessions options.

System response
The system displays the Process Control dialog box (Sessions tab).

3 Select a session and click Delete.

System response
The Sterling Gentran: Server Process Control dialog box asks you to
confirm the delete operation.

4 Click Yes to delete the current selection.

5 Click OK to exit the Sterling Gentran:Server Process Control dialog
box.
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Events

Overview

Introduction  Eventsare acombination of the following:
» A timeor day to execute or afile name for which the system checks
» Thecontroller on which the event is processed
» A session definition

The Process Control runs events based on whether they are timed or polled. You
define the events in a session definition.

The Process Control enables you to process an event at a specified time, every
day. Additional options enable you to restrict processing to certain days of the
week or a specific date. In addition, you can define calendars to exclude specific
holidays or days of the week from the processing schedule.

You manage events by using the following dialog boxes:
» Process Control dialog box (Events tab)

» Event Setup dialog box

» Process Control dialog box (Active Events tab)

Beforeyou begin  You must have already defined the session definition to be executed prior to
creating an event.

Reference
See Creating Sessions on page 11 - 9 for more information.

Timed events  When atimed event is activated, the Sterling Gentran:Server Scheduler initiates
that event at the correct time on the appropriate day or date.

Polled events  When apolled event is activated, the Sterling Gentran: Server Poller polls the
controller for the presence or absence of a defined file (depending on what is
indicated in the event definition), and initiates the event when the specified file
either exists or does not exist (based on the event definition).
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Thefollowing illustrates the Events tab of the Process Control dialog box:

f.& Gentran:5erver Process Control

Active Events  Events | Calendarsl Sessionsl

Description

| Time | Parameter

| Contraller

| Time Started | Time Ende Hew

4]

Syztem-tuditP... 0000

SMTWTFS

Cantroller: |<.ﬂ.l| Controllers:> 'l Sart: IDescription *l |2D Seconds M Auto Refresh

RTETTEM... 2/10/0012:00:41 AM

2/10/001
it

[E(Ete

Suzpend

Execute

0|

Refresh

E B

= Cancel | Help |

Thefollowing liststhe parts of the Process Control dialog box Eventstab and their

functions:
Part Function
(list) Displays all scheduled events.
Controller Select the controller whose events you want filtered.
Sort Select how you want the list of events sorted.

IF you sort by...

THEN theeventsarelisted...

description (the
default)

in alphabetic order of the event
descriptions.

controller in alphabetic order by controller.
Note
For each controller, the events are listed
in alphabetic order by event description.
status by currently processing eventsfirst (red

indicator), activated events second
(green indicator), and suspended events
third (yellow indicator).

Note
Within each status, the events are listed
in alphabetic order by event description.
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Part

Function

Seconds

Specify the interval (in seconds) at which you want the
system to refresh the dialog box (default is 20 seconds).

Auto Refresh

Indicate whether you want the Process Control dialog box to
automatically refresh (so you do not have to click Refresh).

New

Accessesthe Event Setup dialog box so you can create anew
event entry.

Edit

Accesses the Event Setup dialog box so you can modify the
selected event entry.

Delete

Deletes the selected event entry.

Activate/
Suspend

» If aselected event is suspended (yellow indicator), the
Activate/Suspend toggle button reads Activate.

» If aselected event is activated (green indicator), the
Activate/Suspend toggle button reads Suspend.

Execute

Executes the selected event immediately, which allows you
to manually invoke an unattended session. This also enables
you to test a new event or an event that failed.

Notes

» Executing an event immediately using this button does
not replace the next scheduled run of the event.

» When you click this button, an informational message
box is displayed.

— If the selected event is scheduled to execute within the
next 30 minutes, you are notified when the event is
scheduled to run and prompted to specify whether you
want to run it now (click OK) or cancel the request (click
Cancdl).

— If the selected event is not schedul ed to execute within the
next 30 minutes, you are prompted to either confirm the
request to execute it immediately (click OK) or cancel the
request (click Cancel).

Refresh

Refreshes the display of the Events tab.
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Thefollowing illustrates the Event Setup dialog box:

Event Setup

]|

Description | L
Seszsion I j Cahcel |
Contraller |GENTH.&NMAEHINE1 Browsze

[ Maotification Type Event

Timed | Poled |

[ s |
Help |

Tirne: Start I Lkl I

EYEY I mitiLkes

Calendar I

v Sun v Mon W Tue W wed W Thu ¥ Fi v Sat

=~

Diate I

Thefollowing lists the parts of the Event Setup dialog box and their functions:

Part Function
Description Enter a description of the event.
Session Select one of the sessions you defined on the
Sessions tab.
Controller Specify the name of the controller on which the event

isrun.

Notification Type Event

Designate this event as a“ notify type,” which means
that the system executesit based on parameters setin
the Notification Log.

Note
Selecting this check box deactivates the Timed and
Polled tabs.

Timed tab

Start

Indicate the beginning run time of a session.

Note

You must enter the time in 24-hour HH:MM format.
If you do not enter the timein this format, the system
attempts to determine the correct 24 hour time from

what you entered.
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Part

Function

Until

Specify a stop time for the event.

Note

You can either use 24-hour HH:MM format or
12-hour HH:MM or H:MM format with the
designator "a" (am) or "p" (pm).

Note

An event will always execute on its end time
regardiess of theinterval that is set. To have an event
execute once, do not enter an end time or interval.

Minutes

Specify an interval of time after which the eventisto
be executed.

Example
If you specify "15" minutes, the event is executed
every 15 minutes.

Calendar

Select one of the calendars you defined on the
Caendarstab that you want the system to check
against when scheduling this session.

Notes

» A cdendar alowsyou to specify daysin each
month that you do not want the selected session
to be run.

» If you use the Date box, you cannot use the
Calendar box.

Sun/Mon/Tue/Wed/
Thu/Fri/Sat

Indicate which days of the week the event isto be
executed.

Date

Specify adate on which the event is to be executed.

Notes

» You can enter this date in any format, but the
sequence of the date you enter must correspond
to the international Windows date formats (for
example, in the United State, dates must be
entered in month/day/year format).

» If you select acalendar from the Calendar box or
days of the week, you cannot use the Date box.
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tab)

Overview
Part Function
Polled tab
File name Specify the name of the file for which the system

checks.

Note
You can use awildcard (*) to specify the name of the
file.

Browse Accesses the Choose Network Server dialog box so
you can browse for the file for which you want the
system to check.

Result Indicate whether the event should be executed if the

result is True or False.

Note

» If youselect True, you are indicating that the
event should be executed only when the specified
fileis present.

» If you select False, you are indicating that the
event should be executed only when the specified
file does not exist.

The following illustrates the Active Events tab of the Process Control dialog box:

L& Gentran:5erver Process Control M= 3
Active Events |Events| Ealendarsl Sessionsl
Ewent | EventID | Controlle  Session: |
Command | Parmi | Parmé | Parm3
1 | I3 [ K1 | ol
Refrezh Ewvents: IW seconds Refrezh Actions: |2_ zeconds ¥ uto Refresh
Ok | Cancel | Help |
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Active Eventstab  Thefollowing lists the parts of the Process Control dialog box Active Eventstab

partsand  and their functions:

functions
Part

Function

(Event list)

Displays the events that are currently processing.

(Session list)

Lists each command and the associated parameters
for the session script for the event that is currently
processing.

Note
A green arrow indicates which command the system
is currently processing.

Refresh Events seconds

Specify the default interval (10 seconds) for
refreshing the Active Eventslist. Valid values are 2 —
300 seconds.

Notes
» Thisvaueissaved when you change focus on
the dialog box (click another box).

» The Auto Refresh check box must be selected
(checked) for the Seconds boxes to be available.

Refresh Actions
seconds

Specify the default interval (2 seconds) for refreshing
the Sessions list. Valid values are 2 seconds — 300
seconds.

Notes
» Thisvalueissaved when you change focus on
the dialog box (click another box).

» The Auto Refresh check box must be selected
(checked) for the Seconds boxes to be available.

Auto Refresh

Indicate whether you want automatic refresh enabled.
The default is Enabled, which means that you do not
haveto click Refresh.

Refresh

Manually refreshes the Active Events display.

Note

If the Active Eventstab has not been refreshed after
an event has expired (is no longer active), the system
continues to display the event on the Active Events
tab (even though it isinactive), until the Active
Eventstab is refreshed.
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Creating New Events

Introduction

Procedure

User Guide

You can specify that the event runs astimed or as polled. If the event isrunning as
“timed,” you must specify atime, a pre-defined calendar and/or days of the week
to run, or adate to run one time only. When it istime for the event to be run, the
Sterling Gentran: Server Scheduler service initiates the processing of the event.

If the event isrunning as “polled,” you can specify afile name and whether the
event should run if the file exists or not. The Sterling Gentran:Server Poller
service polls the process controller.

» If you specified that the file must exist, the Sterling Gentran:Server Poller
initiates the processing of the event when the file appears.

» If you specified that the file must not exist, the Sterling Gentran:Server Poller
initiates the processing of the event when the file no longer exists on the
controller.

To create a new event, complete the following steps:

Sep Action
Creating a new event
1 Click Process Control on The Desk.
System response
The system displays the Sterling Gentran: Server Process Control
dialog box.
2 Click the Eventstab to display the event options.
System response
The system displays the Process Control dialog box (Eventstab).
3 Click New.
System response
The system displays the Event Setup dialog box so you can create a
new event entry.
4 In the Description box, type a description of the event.
5 From the Session list, select the session that you want to be executed.
6 In the Controller box, type or select the machine name of the

controller on which you want this event to be run.
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Sep

Action

Do you want to designate this event as a notification type?

» If yes, select the check box and continue with Step 2 in Saving
the event on page 11 - 26.

» If no, continue with the next step.

Complete this section if the event istimed

In the Time Start box (on the Timed tab), you must fill in atime.

Note
You must use 24-hour HH:MM format.

If you want to specify astop time for the event, type that timein the
Until box (on the Timed tab).

Note
You can either use 24-hour HH:MM format or 12-hour HH:MM or
H:MM format with the designator “a’ (am) or “p” (pm).

Do you want to specify an interval of time after which the event is
run?

» If yes, inthe Minutes box (on the Timed tab), type the number of
minutes after which you want the event to be executed and
continue with Step 4.

Example
If you specify 15 minutes, the event is executed every 15
minutes from the start time.

» If no, continue with Step 4.

Do you want to use a predefined calendar?

» If yes, select that calendar from the Calendar list and continue
with Step 5.

» If no, continue with Step 5.

Note

A calendar enables you to specify the daysin each month that you do
not want the selected session to be run. If you select a calendar, you
can also select specific days of the week on which you want this
session to run on. However, if you select a calendar, you cannot
specify aday in the Date box.

Reference
If you need to define a calendar, see Creating and Editing Calendars
on page 11 - 41.

Sterling Gentran:Server — May 2011

User Guide



Using Process Control

User Guide

Creating New Events

Sep

Action

Do you want to select aday or days of the week on which you want
this session to be scheduled?

» If yes, click the check box next to the days on which the event
should be run and continue with Step 6.

» If no, continue with Step 6.

Note

By default, every day of the week is selected. If any days are selected
in this section, then the schedule is executed only on those days. If
you select days from this section, you cannot use the Date box.

Do you want to specify a day in which you want this session to run
one time only?

» If yes, typethat datein the Date box and continue with Saving the
event on page 11 - 26.

» If no, continue with Saving the event on page 11 - 26.

Note

This box enables you to specify a date on which this session should
run one time only. The system then removes the session from the
database. If you type adate in this box, you cannot select from the
days of the week check boxes.

For mat

You can enter this date in any format, but the sequence of the date
you enter must correspond to the international Windows date formats
(for example, in the United States, dates must be entered in
MM/DD/YY format, and in the United Kingdom, dates must be
entered in DD/MM/YY).

Complete this section if the event is polled

Click the Polled tab on the Event Setup dialog box.

System response
The system displays the polled options.

In the File name box, complete only one of the following:

» Typethe path and name of thefile for which you want the system
to check.

» Click Browse to select the file from the appropriate drive and
directory.

Note
You can use awildcard (*) to specify the name of thefile.
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Sep Action

3 From the Result list, select True or False.

Note
» If you select True, you are indicating that the event should only
be executed when the specified file is present.

» If you select False, you are indicating that the event should be
executed only when the specified file does not exist.

Saving the event

1 Click OK.

System response
The event is saved and you exit the Event Setup dialog box.

2 Click OK.

System response
The system exits the Sterling Gentran: Server Process Control dialog
box.
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Editing Events

Introduction  You are not able to edit an event unless the event is suspended.

Reference
See Procedure: suspending an event on page 11 - 37 for more information.

Procedure  To edit an existing event, complete the following steps:

Sep Action

Editing an event

1 Click Process Control on The Desk.

System response
The system displays the Sterling Gentran: Server Process Control
dialog box.

2 Click the Eventstab to display the event options.

System response
The system displays the Process Control dialog box (Eventstab).

3 Select the event that you want to modify and click Edit.

System response
The system displays the Event Setup dialog box.

4 If you want to modify the description of the event, type the new
description in the Description box.

5 If you want to select another session to be executed, do so from the
Session list.
6 If you want to change the controller on which you want this event to

be run, type the machine name in the Controller box.

7 Do you want to designate this event as a notification type?

» If yes, select the check box and continue with Step 2 in Saving
the event on page 11 - 30.

» If no, continue with the next step.
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Sep

Action

Complete this section if the event istimed

In the Time Start box (on the Timed tab), type atime.

Note
You can either use 24-hour HH:MM format or 12-hour HH:MM
format with the designator “a’ (am) or “p” (pm).

If you want to specify a stop time for the event, type that timein the
Until box (on the Timed tab).

Note
You can either use 24-hour HH:MM format or 12-hour HH:MM or
H:MM format with the designator “a” (am) or “p” (pm).

Do you want to specify an interval of time after which the event is
run?

» If yes, inthe Minutes box (on the Timed tab), type the number of
minutes after which you want the event to be executed and
continue with Step 4.

Example
If you specify 15 minutes, the event is executed every 15
minutes.

» If no, continue with Step 4.

Do you want to use a predefined calendar?

» If yes, select that calendar from the Calendar list and continue
with Step 5.

» If no, continue with Step 5.

Note

A calendar enables you to specify daysin each month that you do not
want the selected session to be run. If you select a calendar, you can
also select specific days of the week on which you want this session
to run on. However, if you select a calendar, you cannot specify aday
in the Date box.

Reference
If you need to define a calendar, please see Creating and Editing
Calendarson page 11 - 41.
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Sep

Action

Do you want to select aday or days of the week on which you want
this session to be scheduled?

» If yes, click the check box next to those days and continue with
Step 6.
» If no, continue with Step 6.

Note

By default, every day of the week is selected. If any days are selected
in this section, then the schedule is executed only on those days. If
you select days from this section, you cannot use the Date box.

Do you want to specify a day in which you want this session to run
one time only?

» If yes, typethat date in the Date box and continue with saving the
event.

» If no, continue with saving the event.

Note

This box enables you to specify a date on which this session should
run one time only and then be removed from the database by the
system. If you type adatein thisbox, you cannot select from the days
of the week check boxes.

For mat

You can enter this date in any format, but the sequence of the date
you enter must correspond to the international Windows date formats
(for example, in the United States, dates must be entered in
MM/DD/YY format, and in the United Kingdom, dates must be
entered in DD/MM/YY).

Complete this section if the event is polled

Click the Polled tab on the Event Setup dialog box.

System response
The system displays the polled options.

In the File name box, complete only one of the following:

» Typethe path and name of thefile for which you want the system
to check.

» Click Browse to select the file from the appropriate drive and
directory.

Note
You can use awildcard (*) to specify the name.
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Sep Action

3 From the Result list, select True or False.

Note
» If you select True, you are indicating that the event should only
be executed when the specified file is present.

» If you select False, you are indicating that the event should be
executed only when the specified file does not exist.

Saving the event

1 Click OK.

System response
The event is saved and you exit the Event Setup dialog box.

2 Click OK.

System response
The system exits the Sterling Gentran: Server Process Control dialog
box.
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Deleting Events

Introduction  You are not able to delete an event unless the event is suspended.

Reference
See Procedure: suspending an event on page 11 - 37 for more information.

Procedure  To delete an event, complete the following steps:

Sep Action

1 Click Process Control on The Desk.

System response
The system displays the Sterling Gentran: Server Process Control
dialog box.

2 Click the Events tab to display the event options.

System response
The system displays the Process Control dialog box (Eventstab).

3 Select an event and click Delete to delete the current selection.

System response
The Sterling Gentran: Server Process Control dialog box asks you to
confirm the del ete operation.

4 Click OK.

System response
The event is deleted.

5 Click OK.

System response
The system exits the Sterling Gentran:Server Process Control dialog
box.
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Viewing Events

Eventstab

Active Eventstab

The Sterling Gentran: Server Process Control dialog enables you to view al the
events defined in your system.

On the Events tab, the following specifications are listed for each event:
» Event description

» Time

» Parameters (day of week if timed or result if polled)

» Controller on which the event runs

» Timestarted

» Timeended

» Session name

» Calendar name (timed events only)

» Filename (polled events only)

Filtering event display

You can filter the display of events on the Events tab by the controller on which

the events are scheduled to run. You can also sort the events by description,
controller, and status.

The Active Events tab enables you to view only the eventsthat are currently
processing. This feature also allows you to view currently processing system
events (such as temporary communication sessions).

Event list

On the Active Events tab, al currently processing events and the controller on
which each event are being processed are listed in the Event list (on the | eft side of
the dialog).

Session list

The Session list (on the right side of the Active Events tab) displays the session
script for the event that is currently selected in the Eventslist. The Session list
also contains al of the parameters for each command. This detailed view enables
you to see which programs are currently being executed by the Sterling
Gentran:Server Executive. The session command that is currently being processed
isindicated with a green arrow.
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Viewing Events

To view all events, complete the following steps:

Sep Action

1 Click Process Control on The Desk.
System response
The system displays the Sterling Gentran: Server Process Control
dialog box.

2 Click the Events tab to display the event options.
System response
The system displays the Process Control dialog box (Events tab).

3 If you want to filter events by the controller on which the eventsare
run, select that controller from the Controller list.

4 Use the following table to select the appropriate sort key from the

Sort list.

THEN select thisfrom the
I F you want to sort by... Sort list...

the eventslisted in alphabetic order of | Description.

the event descriptions
Note

Thisisthe default.

the eventslisted in alphabetic order of | Controller.
the controller

the eventslisted by: Status.
1. currently processing events (red
indicator)

2. blocked events (green indicator with
red “x")

activated events (green indicator)

4. suspended events (yellow indicator)
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Sep Action

5 If necessary, change the Refresh options:

» If you want to change the interval in which the dialog box is
automatically refreshed, type theinterval (in seconds) at which
you want the system to refresh the dialog box (the default is 20
seconds) in the Seconds box. Valid values are 2 — 300 seconds.

Note

Thisvalue is saved when you change focus on the dialog box
(click another box). The Auto Refresh check box must be
selected (checked) for the Seconds box to be available.

» If you do not want the Events tab on the Sterling
Gentran: Server Process Control dialog box to automatically
refresh (so you have to manually click Refresh), click the Auto
Refresh check box to deselect it.

Note
The default for automatic refresh (so you do not have to click
Refresh) is enabled (checked).

6 Click OK.

System response
The system exits the Sterling Gentran: Server Process Control
dialog box.

Procedure  To view active events, complete the following steps:
viewing active
events &ep Action

1 Click Process Control on The Desk.

System response
The system displays the Process Control dialog box (Active Events
tab).

2 From the Event list, select the event for which you want to view
further detail.

Note

The system displays each command and its associated parametersin
the session script for that event in the Session list. The session
command currently being processed is indicated with a green arrow.
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Sep

Action

If necessary, change the Refresh options:

» If youwant to change the interval in which the dialog box is
automatically refreshed, type the interval (in seconds) at which
you want the system to refresh the dialog box (the default is 20
seconds) in the Seconds box. Valid values are 2 — 300 seconds.

Note

Thisvalue is saved when you change focus on the dialog box
(click another box). The Auto Refresh check box must be
selected for the Seconds box to be available.

» If you do not want the Active Events tab on the Sterling
Gentran: Server Process Control dialog box to automatically
refresh (so you have to manually click Refresh), click the Auto
Refresh check box to deselect it.

Notes

» Thedefault for automatic refresh (so you do not have to click
Refresh) is enabled (checked).

» Thedefault interval for refreshing the Event list is 10 seconds.

» Thedefault for refreshing the display of the Session listis 2
seconds.

» If the Active Eventstab has not been refreshed after an event has
expired (isno longer active), the system displaysthe event on the
Active Eventstab (even though it isinactive), until the Active
Eventstab is refreshed.

Click OK.

System response
The system exits the Sterling Gentran:Server Process Control dialog
box.

Sterling Gentran: Server — May 2011



Activating and Suspending Events Using Process Control

Activating and Suspending Events

Introduction  The Eventstab of the Sterling Gentran: Server Process Control dialog enables you
to change the status of an event by activating or suspending the event. The
indicator in the far left column of the list on the Events tab registers the status of
the event. The indicator can be one of the following colors:

» Red—theevent iscurrently executing and you are not able to edit the event
until processing completes.

» Yellow—the event is suspended (and is not processed until activated).

» Green—the event isactivated for processing.

» Green with red “x”—the event is activated for processing but is currently
blocked because the number of currently processing eventsis equal to the
limit of events that may concurrently execute.

Reference

See How to Change Controller Settingsin the IBM® Serling Gentran: Server®
for Microsoft Windows Administration Guide for moreinformation about setting a
limit for the number of process control events that can execute concurrently.

Procedure:  To activate an event, complete the following steps:

activating an

event Sep

Action

1

Click Process Control on The Desk.

System response
The system displays the Process Control dialog box (Active Events
tab).

Click the Eventstab to display the event options.

System response
The system displays the Process Control dialog box (Eventstab).

Select the suspended event that you want to activate and click
Activate.

Click OK.

System response
The system exits the Sterling Gentran: Server Process Control dialog
box.
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Activating and Suspending Events

To suspend an event, complete the following steps:

Step

Action

1

Click Process Control on The Desk.

System response
The system displays the Process Control dialog box (Active Events
tab).

Click the Events tab to display the event options.

System response
The system displays the Pracess Control dialog box (Events tab).

Select the activated event that you want to suspend and click
Suspend.

Note
If an event is currently processing, you are not able to suspend it until
processing has terminated.

Click OK.

System response
The system exits the Sterling Gentran: Server Process Control dialog
box.
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Executing an Event Immediately

I ntroduction

The Eventstab of the Sterling Gentran: Server Process Control dialog enables you

to execute the selected event immediately. This function allows you to manually
invoke an unattended session and also enables you to test anew event or an event

that failed.
Procedure  To execute an event immediately, complete the following steps:
Sep Action

1 Click Process Control on The Desk.
System response
The system displays the Process Control dialog box (Active Events
tab).

2 Click the Eventstab to display the event options.
System response
The system displays the Process Control dialog box (Eventstab).

3 Select the suspended event that you want to execute immediately
and click Execute.
System response
Use this table to determine the system response.
| F the system displays this
message... THEN you should...
Thisevent is scheduled to » Click OK torunthe event
execute next at <scheduled immediately.
time>. Do you want to run it OR
now anyway? » Click Cancel to cancel the

regquest (the event will execute

Run <event name> ; .
immediately? at its scheduled time).

4 Click OK.
System response
The system exits the Sterling Gentran:Server Process Control
dialog box.
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Overview

Introduction  The process control Calendar feature enables you to configure system calendars
that excludes specific dates (such as holidays) or days of the week from
processing.

Like session definitions, these calendars are defined independently from the
event, so that they can be “attached” to multiple event entries. The calendar begins
with the current month and year.

ProcessControl  Thefollowing illustrates the Calendars tab of the Process Control dialog box:

dialog box - =
##® Gentran:Server Process Control
(Calendarstab)
Active Events | Events Calendars | Sessions |
Calendar: |Invoice Tew |
Orders —February LDDD  Exclude
Sum Mon Tue  Wed Thur  Fii Sat ™ Sunday il
1 2 ;( 3 4 5 I Monday Savehs |
[ 7 b k] m N 12
Delete
13014 15 e 17 18 14 ™ Tuesday —I
20 21 22 23 w24 5 26 [ wednesday
A& B 2 ¥ Thursday
[ Friday
LLPTesonE Memts > [ Saturday

T Eloze Carize] Help

Calendarstab  Thefollowing lists the parts of the Process Control dialog box Calendars tab and
partsand their functions:

functions .
Part Function
(Cdendarslist) Displaysalist of all defined calendars.
(Cdendar) Displays the current month of the selected calendar.
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Part Function

Previous Displays the previous month in the calendar.

Note
This button is only activated if a calendar is selected
and a previous month exists for the calendar.

Next Displays the next month in the calendar.

Note
This button is only activated if a calendar is selected.

Exclude Select which days of the week to exclude from
processing. These are displayed with red Xs through
them.

New Accesses the New Calendar dialog box so you can
create anew calendar.

Save Saves the current calendar.

Note
The Save command is only activeif acalendar is
displayed in the middle of the dialog box.

Save As Saves the current calendar under another name.

Note
The Save As command isonly active if acalendar is
displayed in the middle of the dialog box.

Delete Deletes the selected calendar.
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Creating and Editing Calendars

Procedure

User Guide

To create or edit a calendar, complete the following steps:

Step

Action

1

Click Process Control on The Desk.

System response
The system displays the Sterling Gentran: Server Process Control
dialog box.

Click the Calendars tab.

System response
The system displays the Process Control dialog box (Calendars tab).

Do you want to create a new calendar?
» If yes, click New.

System response
The system displays the New Calendar dialog box.

» If no, select the calendar that you want to edit and continue with
Step 6.

System response
The system displays the calendar in the center of the Calendars

tab.

In the Calendar Name box, type the new calendar name using up to 8
a phanumeric characters.

Click OK to add the new calendar.

System response
The system displays the new calendar in the middle of the Calendars
tab.

Do you want to exclude a specific date from processing?

» If yes, click that date on the calendar and continue with Step 7.
» If no, continue with Step 7.

Note

The system displays a mark for that date on the calendar to signify

that it is excluded from processing. Click Previous or Next to access
the preceding or succeeding calendar months in the calendar.
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Sep Action

7 Do you want to exclude a specific day or days of the week?

» If yes, select the check box in the Exclude section for each day of
the week that you want to exclude from processing and continue
with Step 8.

» If no, continue with Step 8.

Notes

» You can select one or more days of the week on which you never
want processing to occur.

» The system allows you to exclude all seven days of the week, if
that is your intention. In this situation, processing never occurs.

» Todeselect aday, clear the check box.

8 Click Save to save the new calendar.

9 Click OK.

System response
The system exits the Sterling Gentran: Server Process Control dialog
box.
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Deleting Calendars

Procedure  To delete acalendar, complete the following steps:

Sep Action

1 Click Process Control on The Desk.

System response
The system displays the Sterling Gentran: Server Process Control
dialog box.

2 Click the Calendars tab.

System response
The system displays the Process Control dialog box (Calendars tab).

3 Select a calendar and click Delete to delete the current selection.

System response
The Sterling Gentran:Server Process Control dialog box asks you to
confirm the delete operation.

4 Click Yesto delete the current selection.

5 Click OK.

System response
The system exits the Sterling Gentran: Server Process Control dialog
box.
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Notices

Thisinformation was devel oped for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other
countries. Consult your local IBM representative for information on the products and
services currently available in your area. Any reference to an IBM product, program, or
service is not intended to state or imply that only that IBM product, program, or service
may be used. Any functionally equivalent product, program, or service that does not
infringe any IBM intellectual property right may be used instead. However, it isthe user's
responsibility to evaluate and verify the operation of any non-IBM product, program, or
service.

IBM may have patents or pending patent applications covering subject matter described in
this document. The furnishing of this document does not grant you any license to these
patents. You can send license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive

Armonk, NY 10504-1785

U.SA.

For license inquiries regarding double-byte character set (DBCS) information, contact the
IBM Intellectual

Property Department in your country or send inquiries, in writing, to:
Intellectual Property Licensing
Legal and Intellectual Property Law

IBM Japan Ltd.
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1623-14, Shimotsuruma, Yamato-shi
Kanagawa 242-8502 Japan

Thefollowing paragraph doesnot apply to the United Kingdom or any other country
wheresuch provisionsareinconsistent with local law: INTERNATIONAL BUSINESS
MACHINES CORPORATION PROVIDES THIS PUBLICATION "ASIS' WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT,
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do
not allow disclaimer of express or implied warranties in certain transactions, therefore,
this statement may not apply to you.

Thisinformation could include technical inaccuracies or typographical errors. Changes
are periodically made to theinformation herein; these changes will be incorporated in new
editions of the publication. IBM may make improvements and/or changes in the
product(s) and/or the program(s) described in this publication at any time without notice.

Any references in thisinformation to non-IBM Web sites are provided for convenience
only and do not in any manner serve as an endorsement of those Web sites. The materials
at those Web sites are not part of the materials for thisIBM product and use of those Web
sitesisat your own risk.

IBM may use or distribute any of the information you supply in any way it believes
appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of
enabling: (i) the exchange of information between independently created programs and
other programs (including this one) and (ii) the mutual use of the information which has
been exchanged, should contact:

IBM Corporation

JBAIGA

555 Bailey Avenue

San Jose, CA__95141-1003

U.SA.

Such information may be available, subject to appropriate terms and conditions, including
in some cases, payment of afee.

The licensed program described in this document and al licensed material available for it
are provided by IBM under terms of the IBM Customer Agreement, IBM International
Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment.
Therefore, the results obtained in other operating environments may vary significantly.
Some measurements may have been made on devel opment-level systems and thereis no
guarantee that these measurements will be the same on generally available systems.
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Furthermore, some measurements may have been estimated through extrapolation. Actual
results may vary. Users of this document should verify the applicable data for their
specific environment.

Information concerning non-IBM products was obtained from the suppliers of those
products, their published announcements or other publicly available sources. IBM has not
tested those products and cannot confirm the accuracy of performance, compatibility or
any other claimsrelated to non-IBM products. Questions on the capabilities of non-IBM
products should be addressed to the suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

Thisinformation is for planning purposes only. The information herein is subject to
change before the products described become available. This information contains
examples of data and reports used in daily business operations. To illustrate them as
completely as possible, the examplesinclude the names of individuals, companies, brands,
and products. All of these names are ficticious and any similarity to the names and
addresses used by an actual business enterpriseis entirely coincidental.

COPYRIGHT LICENSE:

Thisinformation contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy, modify,
and distribute these sample programs in any form without payment to IBM, for the
purposes of developing, using, marketing or distributing application programs conforming
to the application programming interface for the operating platform for which the sample
programs are written. These examples have not been thoroughly tested under all
conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or
function of these programs. The sample programs are provided "ASIS", without warranty
of any kind. IBM shall not be liable for any damages arising out of your use of the sample
programs.

Each copy or any portion of these sample programs or any derivative work, must include a
copyright notice as follows:

© IBM 2011. Portions of this code are derived from IBM Corp. Sample Programs.
© Copyright IBM Corp. 2011.

If you are viewing this information softcopy, the photographs and color illustrations may
not appear.

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of International
Business Machines Corp., registered in many jurisdictions worldwide. Other product and
service names might be trademarks of IBM or other companies. A current list of IBM
trademarks is available on the Web at “ Copyright and trademark information” at
www.ibm.com/legal/copytrade.shtml.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States, and/or
other countries.

Sterling Gentran: Server — May 2011


www.ibm.com/legal/copytrade.shtml

Trademarks Notices

IT Infrastructure Library is aregistered trademark of the Central Computer and
Telecommunications Agency which is now part of the Office of Government Commerce.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo,
Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or registered
trademarks of Intel Corporation or its subsidiariesin the United States and other countries.

Linux is aregistered trademark of Linus Torvaldsin the United States, other countries, or
both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft
Corporation in the United States, other countries, or both.

ITIL isaregistered trademark, and a registered community trademark of the Office of
Government Commerce, and isregistered in the U.S. Patent and Trademark Office.

UNIX isaregistered trademark of The Open Group in the United States and other
countries.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of
Oracle and/or its affiliates.

Cell Broadband Engine is atrademark of Sony Computer Entertainment, Inc. in the
United States, other countries, or both and is used under license therefrom.

Linear Tape-Open, LTO, the LTO Logo, Ultrium and the Ultrium Logo are trademarks of
HP, IBM Corp. and Quantum in the U.S. and other countries.

Connect Control Center®, Connect:Direct®, Connect:Enterprise, Gentran®,
Gentran:Basic®, Gentran:Control®, Gentran:Director®, Gentran:Plus®,
Gentran:Rea time®, Gentran: Server®, Gentran:Viewpoint®, Sterling Commerce™,
Sterling Information Broker®, and Sterling Integrator® are trademarks or registered
trademarks of Sterling Commerce, Inc., an IBM Company.

Other company, product, and service names may be trademarks or service marks of others.
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GLOSSARY

Glossary

This browser contains alist of documents that were received by the system but
failed compliance checking or that do not have an identifiable partner or
transaction set.

This browser contains alist of documents that were imported into the system but
areinvalid.

Indicates the ANSI 997 functional acknowledgement, the EDIA 999 acceptance/
rejection advice, and the EDIFACT CNTRL.

This function enables you to manually change the status of documents in the Out
Drawer to “Ack’d” (acknowledged).

The Automotive Industry Action Group (AIAG) isthe standards-setting group for
the automotive industry. The standards form a subset of the ANSI X 12 standard.

Article Numbering Association.

American National Standards Institute. ANSI sets standards for many products
and services. The ANSI X12 committee is the main EDI standards-setting
organization for the United States.

Computer systems designed to fulfill specific business functions. These include
accounting, purchasing, materials control, human resources, shipping, and other
systems.

Communication among distributed processes in which data can be transmitted
intermittently rather than in a steady stream.

This function enables you to view system audit log information.
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authorization  Permission to access a protected resource, service, or sensitive information.

browser A window that displays alist of items, such as documents (transaction sets),
interchanges, or tranglation objects. A document browser displays only
documents.

click  Indicates that you should position your cursor on top of the designated item and
press and release your primary mouse button. The primary mouse button is the
button you access with your index finger, regardless of whether you are using
right-handed or left-handed mouse operation.

cluster A set of computers that work together to provide a service. The use of a cluster
enhances both the availability and scalability of the service. The Windows
operating systems provide a software solution for clustering multiple computers
running networked client/server applications.

communications  Everything sent and received to/from one telephone number in one continuous
session  period of connection. This could include sending two or three interchange
envelopesto a network, each for a different trading partner.

Communicator  The Sterling Gentran:Server communications software. The Communicator
enables you to send, receive, resend, establish communication port definitions,
establish communication profiles, establish communication scripts, and view and
delete communication sessions.

compliance  Animplementation is compliant if and only if it fully meets each and every
requirement of the standards specification. Specifically, each transaction, action,
or data element produced by the implementation must be valid as defined by the
standard. Compliance testing is the act of comparing the operation of an
implementation against the specified requirements to determine compliance or
noncompliance.

compliant  This means that the document conforms to the EDI standards as defined by the
tranglation object.

component data A simple data element that belongs to a composite data element. Component data
element  elementsare also called sub-elements.
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A data element that is made up of multiple component elements.

Cryptographic keys are central to cryptographic operations and must be kept
secret because whoever possesses a particular key has access to any data with
which the key is associated. For example, if akey isused to encrypt afile, anyone
with a copy of that key can decrypt the file. Furthermore, anyone possessing a key
used to sign messages can forge that message signature.

This function enables you to copy one or more documents from the Out Drawer to
the Workspace.

Thefollowing are data-view windows in the Sterling Gentran: Server:
» AuditLog

» Document Tracking

» Interchange Tracking

» Raw data-view of an interchange

» Raw data-view of adocument

A predefined value. Programs use these built-in values unless you specifically
override them.

Thisis agraphic representation of Sterling Gentran:Server that provides an easy
way to access some of the most commonly used browsers, functions, and
subsystems of Sterling Gentran:Server. You can click the appropriate part of The
Desk any time you need to access a browser, function, or subsystem represented
there. The following are the browsers you can access:

» In Documents

» ?n Documents

» Workspace

» Out Documents

» ?0ut Documents

» Interchanges

» InDrawer

» Out Drawer

Each browser icon displays a graphic representation of paper if the document

location contains documents. The Desk also allows you to access the Partner
Editor subsystem, the Help system, the Process Control function (clock icon), and
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the Send/Receive functions (phone icon), and allows you to quit Sterling
Gentran; Server (EXIT/door icon).

You can turn the display of The Desk off by clicking The Desk on the View menu.
Thistoggles the display of The Desk “on” and “off.” A checkmark next to that
item meansitis“on.”

dialog box A dialog box (or dialog) contains additional information or options that you need
to act on. If you specify any options, you can select a button to execute the
command. Some dialog boxes display warnings or messages indicating why a
requested task cannot be accomplished. If the dialog box has atitle bar, you can
move it to another location on your desktop. To close a dialog box, double-click
the Control menu box or select Close Active Window from the File menu.

digital certificate A digital certificate isacommon credential that provides a means to verify
identity. A certificate is a set of data that identifies an entity. A trusted
organization assigns a certificate to an individual or an entity that associates a
public key with the individual. The individual or entity to which acertificateis
issued is known as the subject of that certificate. The trusted organization that
issues the certificate is a Certification Authority (CA) and is known as the
certificate’sissuer. A trustworthy CA will only issue a certificate after verifying
the identity of the certificate's subject. The datain a certificate includes the public
cryptographic key from the certificate subject’s public/private key pair.

digital signature  The essence of public key encryption isthat your datais encoded with a complex
mathematical formulathat returns two keys. Data encrypted with thefirst key can
only be decrypted with the second key and data encrypted with the second key can
only be decrypted with the first. You distribute your first key as a public key that
anyone can have and keep your second key as a private key that no one but you
has access to. The reciprocal relationship between the keys allows anyone to
encrypt data with your public key, and then you can decrypt it with your private
key. No one else has access to the data once it is encrypted, including the person
who encrypted it. Similarly, you can encrypt data with your private key, and then
anyone can decrypt that data with your public key. Although this makes the data
freely available, but it ensures that only you could have created it.
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element

One transaction set containing data and treated as a single entity. The amount of
data does not affect whether something is adocument or not, only thefact that it is
treated as a single entity. For example, regardless of whether a purchase order
contains one item or ten thousand items, if it is one purchase order, it is one
document.

If atrading partner sends you a communication containing 10 purchase orders,
you have received 10 documents. If the communication contains 15 invoices, you
have received 15 documents.

Indicates that you should position your cursor on top of the designated item and
quickly press and release your primary mouse button twice. The primary mouse
button is the button you access with your index finger, regardless of whether you
are using right-handed or left-handed mouse operation.

A DTD (document type definition) is atype of schema used to specify the
structure and semantics of an XML document or message.

International Article Numbering Association, based in Brussels, Belgium.

Electronic Data Interchange (EDI) is the process by which companies can
exchange business documents directly from application to application by
computer without paper documents being produced.

The rules for trandating a business document into an EDI document.

The Electronic Data Interchange Association, formerly known as the
Transportation Data Coordinating Committee (TDCC).

Electronic Data I nterchange for Administration, Commerce, and Transport.

The smallest piece of usable information defined by the standards. Examples
might include a quantity, unit price, or description.

Anindividua element can have somewhat different meanings depending on
context. Therefore, elements are normally not considered to have useful meaning
until they are combined into segments.
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There are three types of data elements, asillustrated in the table below:

Data Element Definition

Simple data element A single piece of information defined by the
standards.

Composite data element A data element that is made up of multiple
component elements.

Component data element A simple data element that belongsto a
composite data element. Component data
elements are a so called sub-elements.

envelope A way of separating information in transmissions for ease of processing. Each
envel ope contains a header segment and a trailer segment, which separate the
envelope from other envelopes and provide information about the contents of the
envelope. There are three levels of envelopes:

Transaction Set
Each transaction set (business document) is contained within atransaction set
envelope.

Functional Group
An envelope containing related business documents. The standards define which
transaction sets should be placed together into a functional group envelope.

Interchange Envelope

All material being sent to one trading partner in one communication. The term
Interchange Envelopeisthe term used by ANSI. EDIA usestheterm
Transmission Envelope to refer to thislevel of envelope. Since we use the term
transmission for other uses, we refer to Interchange Envelope only.

Note

A communications session could easily include a number of interchange
envelopes. For this reason, the standards-setting bodies are considering a fourth
level of envelope to cover an entire communications session.

export  Thisfunction enablesyou to write adocument or documents to an external file for
processing by another application. There must be a system or a partner-specific
export tranglation object for the document.
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A failover system is a backup operation that automatically switches to a standby
database, server, or network if the primary system fails or istemporarily shut
down for servicing. Fail over isan important fault tolerance function of mission-
critical systemsthat rely on constant accessibility. Fail over automatically (and, to
the user, transparently) redirects requests from the failed or down system to the
backup system that mimics the operations of the primary system.

This function enables you to find specified text in the active data-view window.

A group of transaction sets that the standards-setting body (such as ANSI) has
defined asfitting together with other related transaction sets. For example, a
Functional Group may be defined as containing all purchasing transaction sets.

Control information prepended to data content, normally used to describe the data
or the relationship of the data with the applications.

This command enables you to import data from an external application file.
Depending on the content of the file, the system may prompt you for partner,
transaction, or trandation object information.

This browser contains alist of documents that the system received but that have
not yet been processed by the user. Once the documents are processed (printed or
exported), they are transferred to the In Drawer.

This browser contains a list of documents that were received and processed.

Contains all functional groups of documents (transaction sets) sent from one
sender to one receiver in the same transmission.

This browser enables you to view a hierarchical list of all the interchanges that
were sent or received. It contains status information about the interchanges (such
as whether or not a functional acknowledgement was received and the status of
that acknowledgement). This browser also enables you to access the documents
within the interchanges. The Interchanges browser can always be accessed.

Descriptions of information that can be almost anything on a trang ation object
that is not an element, a keyword title, or an information indicator. They can also
be used as information dividers, such as aline of dashes.
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menu A list of actions from which you can choose. Unavailable items on amenu are
dimmed to inform you they are disabled.

menu bar  Displaysthelist of menus for the application.

move  Thisfunctions enables you to move a document or group of documents either
from In Documents or ?In Documents to the In Drawer or from ?0ut Documents
to the Workspace.

network  Also known asa Third Party Network or Value-Added Network (VAN). A
service, such as Sterling Information Broker, that accepts and holds transmissions
from companies until it is convenient for atrading partner to accept them.

non-repudiation  Non-repudiation isthe ability of amessage transfer system to provide unforgeable

evidence that a specific action occurred. The following are the three most

common types of non-repudiation services.

» Non-repudiation of origin—Protects against any attempt by a message
originator to deny sending a message.

» Non-repudiation of submission—~Protects against any attempt by a message
transfer agent to deny that a message was submitted for delivery.

» Non-repudiation of delivery—Protects against any attempt by a message
recipient to deny receiving a message.

ODETTE  The Organization for Data Exchange by Tele-Transmission, based in Europe.

Out Documents  Thisbrowser contains alist of documents that are ready to be sent. After the
documents are successfully sent, they are automatically transferred to the Out
Drawer.

Out Drawer  Thisbrowser contains alist of documents that were successfully sent by the
system.

partner  Another firm with which your company trades documents. Also referred to asa
trading partner.

Partner Editor  Thisfunction enables you to define, edit, and delete partner information for your
company and your trading partners.
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This function enables you to move compliant documents from the Workspace to
Out Documents.

On adataentry tranglation object, adefault value for a particular element. You can
change the value as necessary.

This command enables you to print a formatted or unformatted version of the
selected documents using the print translation object set up in the partner
relationship for those documents. This command also enables you to print a
summary list of the documents.

Produced when data received from atrading partner passes through a print
translation object. You do not haveto print the data; it can be “printed” to afileon
your hard disk.

This function enables you to manually initiate a communications session to
receive datafrom your trading partner.

This function enables you to create a turnaround document (using the Turn
Around translation object in the partner relationship) in response to one or more
selected documents in the In Drawer.

An organization that develops and updates standards for EDI communications.
These organizationsinclude ANSI, EDIA, AIAG, UCS, and VICS.

A number of elements combined to communicate useful data. For example, a
catalog price segment might consist of elements for item description, volume,
price, and lead time. By themselves, none of these elements would communicate
useful information. Together, they provide useful information. Segments are
defined by the EDI standards. A number of segments together form atransaction
Set.

Thisfunction enables you to manually start acommunications session to send data
to your trading partner. Only selected documents are envel oped and sent. If no
documents are selected, all documents are sent. Successfully sent documents are
moved to the Out Drawer.
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Send Queue  Thisfunction enables you to display alist of documents currently queued to be
sent.

Set See Transaction Set.

sort  Thisfunction enablesyou to sort thelist of documentsin a document browser into
one of the following sequences:

» partner/type/name
» partner/nameltype
» type/partner/name

status  The processing stage of a document or interchange, indicated in the “ Status” box.

?In Documents

NotOK All documentsin the 2ln Documents have this status. This code
indicates one of the following:

» Thedocument failed to comply with the EDI standard. If thisis
the cause of the error, the errors are indicated on a translator
report associated with the document. Despite the fact that the
document is not fully compliant, it is eligible for further
processing.

» Thereceived document could not be associated with a specific
trading partner. If thisisthe case, the partner listed for the
document in question is“Unknown.” To associate this document
and the other documents received in the interchange with a
partner, attach the documents from the Interchanges browser.

» A suitabletrading relationship or translation object could not be
associated with the document. Detailed information concerning
what information was used to locate the relationship and/or the
trangdlation object islisted in the audit log. To correct this
problem, avalid relationship must be established using the
Partner Editor and avalid export, print, or turn-around transl ation
object must be defined for that relationship.

» A major error occurred while processing the interchange,
functional group, or transaction level enveloping structures. This
error may include header and trailer control numbers that do not
match, an invalid trailer control count, or a control number
sequence checking error. If any of these errors occur, they are
listed on the tranglator report for the interchange containing the
documents.

?0ut Documents

NotOK This code indicates that the document does not comply with the
EDI standard definition. The errors that are causing the
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compliance failure can be determined by viewing the trandator
report for the document.

In Documents

OK

In Drawer
OK

NotOK

Interchanges

The Interchanges browser contains graphics that represent the interchange process
status, interchange network status, interchange, group, document
acknowledgement status, and document compliance status. When you highlight
an entry in the Interchanges browser, an explanation of the status codes for that
lineisdisplayed in the Sterling Gentran: Server status bar.

Sent

All documentsin the In Documents have a status of “OK.” These
documents are fully compliant and are eligible for further
processing.

This code indicates that the documents are fully compliant with
the EDI standard and are digible for further processing.

All documents in the 2ln Documents have this status. This code
indicates one of the following:

The document failed to comply with the EDI standard. If thisis
the cause of the error, the errors are indicated on a transl ator
report associated with the document. Despite the fact that the
document is not fully compliant it is eligible for further
processing.

The received document could not be associated with a specific
trading partner. If thisisthe case, the partner listed for the
document in question is“Unknown.” To associate this document
and the other documents received in the interchange with a
partner, attach the documents from the Interchanges browser.

A suitable trading relationship or transation object could not be
associated with the document. Detailed information concerning
what information was used to locate the relationship and/or the
trandation object islisted in the audit log. To correct this
problem, a valid relationship must be established using the
Partner Editor and avalid export, print, or turn-around translation
object must be defined for that relationship.

A magjor error occurred while processing the interchange,
functional group, or transaction level enveloping structures. This
error may include header and trailer control numbers that do not
match, an invalid trailer control count, or a control number
sequence checking error. If any of these errors occur, they are
listed on the tranglator report for the interchange containing the
documents.

Interchange Process Status
Received

(green) Indicates that the interchange was received by the system.

(green) Indicates that the interchange was successfully
transmitted to the appropriate partner.
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Ready to Send
(blue) Indicates that an attempt was made to send this
interchange, but the communication session was not successful.
This interchange will be sent during the next appropriate
communication session.

Queued Indicates that the document is queued to be sent.
Hold Indicates that the document is on hold (not sent).

Overdue Indicates that the interchange is waiting to be reconciled with an
inbound functional acknowledgement but has exceeded the
number of hours by which that acknowledgement is deemed late.

Send Failed (red) Indicates that the send attempt failed due to an error during
the communications process.

Interchange Network Status

On Network
Indicates that the interchange was successfully delivered to a
value-added network (VAN). (To obtain this status using Sterling
Information Broker, you must have your mailbox configured to
receive the 20 report in data format).

Networ k Warning

Indicates that the interchange was delivered to a VAN, which detected non-critical
errorsin the data. The datais available to be picked up by the designated trading
partner. (To obtain this status using Sterling Information Broker, you must have
your mailbox configured to receive the 20 report in data format).

Network Error

Indicates that the interchange was delivered to a VAN, which detected critical
errorsin the data. The datais not available to be picked up by the designated
trading partner. (To obtain this status using Sterling Information Broker, you must
have your mailbox configured to receive the 20 report in data format).

Picked Up

Indicates that the interchange was successfully delivered to atrading partner
through a VAN. (To obtain this status using Sterling Information Broker, you must
have your mailbox configured to receive the 70 report in data format).

Transmitted to third-party network
Indicates that the interchange was transmitted to a third-party network.

Interchange, Group, and Document Acknowledgement Status

Waiting  Indicates that the interchange is waiting to be reconciled with an
inbound functional acknowledgement.

Overdue Indicates that the interchange is waiting to be reconciled with an
inbound functional acknowledgement but has exceeded the
number of hours by which that acknowledgement is deemed late.

Sterling Gentran:Server — May 2011 User Guide



User Guide

[
El

E

Rejected  Indicates that the interchange was acknowledged by your partner
and there were errors. The interchange was rejected by your
partner.

Acknowledged
Indicates that the interchange was acknowledged by your partner
and there were no errors.

Acknowledged with Errors
Indicates that the interchange was acknowledged by your partner
and there were errors. It was accepted by your partner in spite of
the errors.

Partially Acknowledged
Indicates that the interchange was successfully received by the
trading partner and some of the documents within theinterchange
were accepted or accepted with errors and other documents
within the interchange were rejected.

Document Compliance Status

OK This code indicates that the documents are fully compliant with
the EDI standard and are digible for further processing.

NotOK This code indicates one of the following:

» Thedocument failed to comply with the EDI standard. If thisis
the cause of the error, the errors are indicated on a translator
report associated with the document. Despite the fact that the
document is not fully compliant it is eligible for further
processing.

» Thereceived document could not be associated with a specific
trading partner. If thisisthe case, the partner listed for the
document in question is“Unknown.” To associate this document
and the other documents received in the interchange with a
partner, attach the documents from the Interchange browser.

» A suitabletrading relationship or translation object could not be
associated with the document. Detailed information concerning
what information was used to locate the relationship and/or the
tranglation object islisted in the audit log. To correct this
problem, avalid relationship must be established using the
Partner Editor and avalid export, print, or turn-around translation
object must be defined for that relationship.

» A major error occurred while processing the interchange,
functional group, or transaction level enveloping structures. This
error may include header and trailer control numbers that do not
match, an invalid trailer control count, or a control number
sequence checking error. If any of these errors occur, they are
listed on the tranglator report for the interchange containing the
document.

Duplicate The document has the same name as another document on the
system.
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This code indicates that the document is fully compliant with the
EDI standard. Documents with this status can be sent.

This code indicates that the document was successfully
transmitted to the appropriate partner.

This code indicates that the document is waiting to be reconciled
with an inbound functional acknowledgement.

This code indicates that the document is waiting to be reconciled
with an inbound functional acknowledgement, but has exceeded
the number of hours by which that acknowledgement is deemed
late.

This codeindicates that the document was acknowledged by your
partner and there were no errors.

This codeindicates that the document was acknowledged by your
partner and there were errors, but it was accepted by your partner
in spite of the errors.

This codeindicates that the document was acknowledged by your
partner and there were errors. The document was rejected by your
partner.

This statusis only displayed if there were no acknowledgements
expected for this document and either the group or the
interchange was partially acknowledged. If your partner is going
to issue partial acknowledgements at the interchange or group
level, he/she should also indicate acceptance or rejection at the
transaction level.

This code indicates that the document was successfully delivered
to aVAN. (To obtain this status using Sterling Information
Broker, you must have your mailbox configured to receive the 20
report in dataformat).

This code indicates that the document was successfully delivered
to atrading partner through a VAN. (To obtain this status using
Sterling Information Broker, you must have your mailbox
configured to receive the 70 report in data format).

This code indicates that the document was delivered to a VAN,
which detected non-critical errorsin the data. The datais
available to be picked up by the designated trading partner. (To
obtain this status using Sterling Information Broker, you must
have your mailbox configured to receive the 20 report in data
format).

This code indicates that the document was delivered to a VAN,
which detected critical errorsin the data. The dataisnot available
to be picked up by the designated trading partner. (To obtain this
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status using Sterling Information Broker, you must have your
mailbox configured to receive the 20 report in data format).

Send Queue

Queued  This code indicates that the document was successfully
interchanged in preparation for sending, but the interchange was
not transferred correctly to your partner. The interchange will be
automatically sent in the next communication session with this
partner.

Ready to Send
Indicates that a document is ready to send but amailbox message
has not yet been created for the data.

Send Failed
Indicates that the send attempt failed due to an error during the
communications process.

Wor kspace

OK This code indicates that the document is fully compliant with the
EDI standard. Documents with this status can be posted to Out
Documents and sent.

NotOK This code indicates that the document does not comply with the
EDI standard definition. You can determine the errors that are
causing the compliance failure by viewing the translator report
for the document.

The status bar of an application window defines information about a selection,
command, or process, defines Menu Bar items as the user highlights each item,
and indicates any current keyboard-initiated modes for typing (such as CAP for
the “Caps Lock” key or NUM for the “*Num Lock” key).

A mode of coordination of communication among distributed processes that
requires request-reply pairsto occur within the bounds of a specified timeinterval
in which the communication session is“live.”

See EDIA.

A predesigned layout set up to ensure that input or output for a particular
transaction set exists and is presented in a usable fashion. You must specify which
tranglation objects are used by each partner relationship.

Inbound Translation Objects

Turn Around: Thistranslation object is used when adocument is received to
create the natural response document that contains as many elements from the
received document as possible.
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Export File: Thistrang ation object indicates that when adocument isreceived, it
is exported to a specified file format.

Print: Thistranslation object is used to print documents.

Outbound Translation Objects
Import: Thistrangation object is used to import data from an application file.

Print: Thistranslation object is used to print documents.

Data Entry: Thistrangation object is used to enter datainto the Document Editor
facility.

See Network.

Thetitle bar of an application window contains the name of the application and
enables you to move the window to another position on your desktop.

Contains buttons that graphically represent commands available in the Menu Bar.
This function displays tracking information for a single selected document.

This function displays tracking information for a single sel ected document.

The U. K. standards for EDI that are published by the Article Numbering
Association (UK), LTD.

Another company with which your company trades documents. Also referred to
as apartner.

A business form as defined by the standards. Examples include an ANSI 850
purchase order or an UCS 880 invoice. The standards define each transaction set
in terms of the segments and elements that make up the form, the order in which
they appear, and the relationships among them. Thisis aso known as a“ message”
in Europe.

A document into which data elements from the source document have been
automatically transferred using a turnaround map.

A series of instructions that the system uses to create a turnaround document (a
logical response document to the source) from an inbound (source) document, by
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transferring data from the source document to elementsin the target document
(trandlation object).

UCS  The Uniform Communications Standard is the standard used by the grocery
industry.

UnPost  Thisfunction enables you to move a document previously posted to the Out
Documents back to the Workspace for further processing.

version A formal update of an EDI standard. Each standards-setting body updates its
standards on aregular basis.

view  For documents, this function enables you to display the raw EDI data, aformatted
document using atrandation object, or atranslator report, depending on the
format selected. For interchanges, this function enables you to display the raw
EDI data or atrandator report, depending on the format selected.

VICS  The Voluntary Inter-industry Communication Standards is the standards-setting
body for the retail industry, a subset of ANSI X12.

Workspace  The Workspace contains alist of outbound “Work in Progress’ documents. It also
contains recently imported or data entry documents.

X12  The ANSI committee that sets and publishes standards for EDI.
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